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INTRODUCTION 
 

Moon2.0 is an open source toolkit to design low cost space missions. This 
program covers all the phases of a typical space mission: spacecraft and 
propellant design, satellite and attitude control, trajectory simulation, ground 
station coverage, etc. 
 

This reference manual of the Moon2.0 simulator concerns to the aerospace 
knowledgement, simulation, rocketry and implementation of mini-launchers. 
Moon2.0 has BSD license of open source; it is allowed to copy, modify and 
use if the following conditions are kept: 
 

Moon2.0 

©Joshua Tristancho 
This program is protected by the open source BSD license. 
0. You can run the program for any purpose. 
1. You can study and / or modify the program. 
2. You can copy the program so you can help someone. 
3. You can improve the program and publish the changes to help the 
community. 
 

NOTE: This simulator is intended for educational or experimental use only 
and may have some bugs and imprecise data. The simulated trajectory may 
vary from the real mission. If you plan to build and launch a real rocket use a 
commercial simulator. This source code is provided “as is” and without any 
warranties. Use at your own risk. 
 

 GRAPHICAL INTERFACE In-flight references 

In this section the Graphical User Interface is presented. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The main window is an OpenGL 3D viewer that shows the progress of the 
spacecraft trajectory during the mission simulation. Additional panels are 
available to define the spacecraft and trajectory parameters. A set of 
predefined missions is provided including: sub-orbital flights, LEO and GEO 
orbits, Moon landing and deep space missions. Use the Toolbar at the top of 
the main window to control the simulation, show or hide auxiliary panels, load 
predefined presets or configure the program. 
 
 
 
 

Use the Panels       button in the Toolbar to show or hide the auxiliary panels. 
The 3D viewer and the simulation can be configured with the Options panel. 
Press the                       Render, Simulation, Events, Screen or Viewer 
buttons in the Toolbar to access the program configuration. The simulator 
runs by default in full screen mode. Press F11 to exit this mode or press 
Escape to exit the application. To access the program documentation, press 
F1 or press the Help     button in the Toolbar. Also, a tooltip with a short 
description is available in all the text boxes and buttons of the panels. 
 

By default, the camera of the 3D viewer will follow the spacecraft. This can 
be changed with the Follow        button in the Toolbar. Click and drag with 
the right mouse button on the main window to rotate the camera and view the 
scene from a better point of view. Also, use the mouse wheel to zoom in and 
out the camera. Click with the left button on any object to show an overlay 
with information about the object. A context menu is available in the 3D 
viewer by clicking with the right button. This menu is useful to access the 
main commands when all the auxiliary panels are hidden. 
 
 

Atmosphere 
 

Ionosphere 
 

Speed vector 
 

Spacecraft 
 

Engine status 
 

Ground projection 
 

Speed and altitude 
 

Snapshot 
 

Orbit reference 
 

Path behind 
 
 

Additionally there are 10 panels: Setup, Stages, Help, Data, Log, Graph, 
Propellant editor, View, Link, Options and 13 auxiliary panels: Web browser, 
Video and 360º players, Trajectory editor, Burn editor, Payload camera, 
Remote control, Notepad, 3D Graph, Input graph, Color selector, Preset 
editor, Search and Information overlay. See the “Panels” section for more 
information about all these panels. 

 MISSION DESIGN Quick start 

Basically, a mission is defined in the Setup and Stages panels. Enter the 
launch date and time, the launch coordinates and the parameters of the 
trajectory in the Setup panel. Select the number and parameters of the 
stages and the payload in the Stages panel. All the parameters of the 
mission can be saved in presets for later use. Press the Presets        button 
in the Toolbar to access the Presets menu and save the current mission or 
load the predefined missions that come with the simulator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once all the mission parameters are defined, press the Play             button in 
the Toolbar to start the simulation. Press this button again to pause it or the 
Reset         button to restart it. The simulation speed can be adjusted with the 
Slow down and Speed up       buttons. The simulator automatically 
generates snapshots when an important event occurs like Stage engines off, 
Satellite deployed, etc. Use the Next or Previous             snapshot buttons to 
navigate through the spacecraft trajectory. The current simulation data will be 
shown in the Data panel and a log with important events will be registered in 
the Log panel. See the "Tutorials" section for more information about the 
design of LEO, GEO and Moon landing missions. 
 
Mission design procedures 
 

Procedure to design mini-launchers: 
 

• Define the Payload mass 
• Define the number of stages and its performances: Mass, Dry 

mass, Thrust, Stage delay, Area, Length and Type 
 

Procedure to put a satellite in orbit: 
 

• Adjust the total Mass until the required orbital speed is reached 
(see the table of key speeds below) 

• Adjust angles and altitudes for the minimum energy trajectory until 
the desired orbital altitude is reached 

• Adjust the Delay time between the two last stages until perform a 
null vertical speed at the burn out 

 

Procedure to put a lunar rover on the Moon: 
 

• Adjust the total Mass until the required escape velocity is reached 
(see the table of key speeds below) 

• Adjust the launch Date and Time in such a way that the Moon’s 
orbital plane is in the same plane as the launcher heading plane 
and the launcher trajectory touches the Moon 

 

Key speeds at burn out: 
 

• LEO orbital speed at 250 km: 7.756 km/s 
• GEO orbital speed at 35.786 Mm: 3.075 km/s 
• Escape velocity at 130 km: 11.069 km/s 

 

 MOUSE COMMANDS OpenGL Viewer 

 LEFT BUTTON   SELECT OBJECT / FREE CAMERA MODE 

   Select an object 

   Move the camera (forward and backward) 

   Move the camera (left and right) 
 

 RIGHT BUTTON   CONTEXT MENU / ROTATE CAMERA 

   Show context menu 

   Rotate the camera (pitch) 

   Rotate the camera (yaw) 
 

 MOUSE WHEEL   CAMERA ZOOM 

   Zoom in and out 
 

 DIRECT KEYS Global configuration 

  F1 Show Help panel  F7 Show Propellant editor  

  F2 Show Data panel  F8 Show View panel  

  F3 Show Log panel  F9 Show Link panel  

  F4 Show Graph panel  F10 Show Options panel  

  F5 Show Setup panel  F11 Full screen mode  

  F6 Show Stages panel  F12 Show Toolbar 

  Esc Exit program   
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 AUXILIARY TOOLS Toolbar and context menu 
 

 Reset simulation             Follow mode 
      Previous snapshot             Look at mode 
       Play or Pause simulation          Relative to mode 
           Next snapshot              Paths menu 
            Slow down simulation           Presets menu 
              Speed up simulation             Panels menu 
 
 
 
 
 
    Record video            Render tools 
     Save snapshot            Simulation options 
          Delete path             Events control 
           Save path                   Screen options 
         Previous path                       Viewer options 
            Next path                      Show help 
                          Exit application 
 
Press F12 to show or hide the Toolbar. Right click on it to access the context 
menu or left click on the right side and drag the mouse to move the Toolbar. 
If the Toolbar is hidden, a context menu can also be accessed when the right 
mouse button is pressed in the 3D viewer. 
 

 Play or Pause: Play or pause the 
simulation. 
 

 Reset: Reset the simulation. 
 

 Previous or next snapshot: Pause 
the simulation and jump to the previous or the 
next snapshot. The simulator automatically 
generates time and event snapshots so you 
can navigate backward and forward through 
the trajectory with these buttons. 
 

 Increase or decrease time speed: 
Speed up or slow down the simulation. Use 
these buttons to increase the time speed 
when no important events occur or decrease 
it in critical phases of the trajectory like take 
off, landing or satellite deployed. 
 

 Record video: Start or stop the video 
recording. A video of the simulation will be 
recorded in AVI format and saved in the 
Videos folder. Configure the video size and 
quality in the Screen tab of the Options panel. 
 

 Save snapshot: Save the current state of the simulation in a snapshot 
so it can be restored to this point when navigating through the trajectory. 
 

 Panels: Use this menu to show or hide all the auxiliary panels. Select 
Google Earth to link the simulator to the Google Earth

1
 main window. Use 

Onboard sensor to show the View panel in Onboard follow mode. Also, use 
the Links sub-menu to access a list with useful web links and the Switch to 
menu to select a panel from the list of all the panels currently active. 
 

 Follow: Select the target for the camera 
Follow mode. Free sets the camera in “free” mode. 
Simul follows the spacecraft and its orientation. 
Tactic keeps the camera aligned with the Earth or 
the Moon ground level. Object follows the selected 
object. Onboard emulates the sensor device 
selected in the Options→Sensor option. 
 

 Look at: Select the target for the camera Look 

at mode and the target for the Onboard sensor 
mode when there is no ground stations available. 
Free sets the camera in “free look” mode. Object 
looks at the selected object. Note that the target 
selected for the Onboard sensor mode has no 
effect if a target list is defined in the Setup panel. 
 

 Relative to: Select the target for the Relative 

to mode. All the path points, snapshot points, 
vectors and distances presented in the 3D viewer 
and the Data panel will be relative to the selected 
planet. Auto selects Air when the spacecraft is inside the atmosphere, Earth 
when it is outside, Moon when it is near the Moon and Sun when it is far from 
Earth. When the spacecraft is near a planet, it will also be used as target. 
Use the Target sub-menu to select the desired target planet for the mission 
or select Auto to use the nearest planet as target. The trajectory path will be 
presented relative to this planet. Also, the planet position at the end of the 
mission time and the Pause options of the planet events will be limited to the 
selected planet. 
 

 Path: Trajectories can be stored in memory and then selected as needed 
using this menu, the                    buttons in the Toolbar or the Ctrl+1 to 
Ctrl+9 keys. Use this menu to load or save all the stored trajectories in a 
binary file or a KML format file. If there are no stored paths in memory then 
the current path is saved. Use the Clear options to delete the specified paths. 
 

You can export the trajectories to a KML file so you can view the path in 
Google Earth. Select KML files in the drop down list of the Save dialog to 
generate a KML file. The current orbit can also be saved as NORAD two-line 

                                                      
1 Google Earth http://earth.google.com 
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element
2
 format by selecting the TLE files format when saving the path. To 

specify a NORAD catalog number add the string “SN-NNNNN” to the end of 
the preset name. For example: “LEO 3 Stages SN-00345”. 
 

You can import trajectories from KML, CSV 
or NMEA files by selecting KML files, CSV 
files or NMEA files in the drop down list of 
the Load dialog. These trajectories will be 
shown in the 3D viewer with a different color 
from normal paths. The Convert to KML 
option will convert the NMEA or CSV output 
from a GPS to a KML file so the trajectory 
can be easily displayed. 
 

Also, when loading a Preset, if a KML or 
CSV file with the same name exists, it will be 
loaded and the launching site will be set to 
the highest point in this path. This can be 
used to emulate a launch from a balloon or 
an airplane. 
 

The Copy to Google Earth option copies all 
the stored paths to the Google Earth viewer 
when the link is active. 
 

The Convert images to video option is useful to convert a sequence of image 
files to a video file in AVI format. Select the image files to convert in the Open 
dialog. The video will be stored in the same folder as the images using the 
name of the first image. The settings for the video file can be configured in 
the Screen tab of the Options panel. 
 

Use the Download balloon trajectory option to calculate and download the 
trajectory of a balloon

3
 using the current launching date, time and coordinates 

and the altitude for the balloon burst altitude. This trajectory will be saved as 
a KML file with the same name of the current preset. 
 

Use the Update atmosphere option to download and update the NOAA-NWS 
GFS Atmospheric Model

4
 used in the Atmosphere render tool. This model is 

updated four times each day because the atmosphere parameters change 
constantly. Also, the model can calculate the weather forecast up to 8 days in 
the future with a 3 hours step. Select the desired date and time of the model 
in the Date and Time text boxes located at the Setup panel before updating 
the model. The downloaded files will be saved to the Atmosphere folder. 
 

Use the Update airspaces option to rebuild the database used in the 
Airspaces render tool. This option will process all the KML files in the Airways 
folder to update the “Airspace.bin” file. For every file found, an airspace zone 
with the same name will be created. These files are updated frequently and 
can be downloaded from the Lloyd Bailey 3D Airspace

5
 web page. See the 

“Airspace files” section for more information about downloading these files. 
 

Use the Update asteroids option to download and update the orbital data of 
all the available asteroids and comets from the Lowell Observatory

6
 and 

NASA servers. The size of the full database is about 150 MB and contains 
about 600,000 asteroids and 4,000 comets. New asteroids and comets are 
discovered almost every day so it is recommended to update the files as 
frequently as possible. The links to these files are stored in the “Info.ini” file 
located at the Data folder. 
 

Use the Update satellites option to download and update the trajectories of 
the satellites in orbit around Earth. These trajectories change constantly due 
to the atmospheric drag, the gravity of the Moon and the Sun and the 
corrections done by the satellite engines. Because of this, it is recommended 
to update them as frequently as possible. The location of the files to 
download is defined in the “Satellites.csv” file inside the Satellites folder. The 
files will be also downloaded in this folder and contain a list of the trajectories 
in TLE format. To show a group of satellites, use the Satellites option in the 
Options panel. Also, use the Satellite distance option and the Satellite 
proximity event to detect the proximity of a satellite to the spacecraft. 

 

 Preset: It has information about the launch configuration, the orbit, the 
launcher and other parameters. With this menu the 
preset can be saved in a text file and loaded when 
needed. These files are located at the Presets 
folder. Default.ini is the preset where the current 
mission is saved automatically on exit. 
 

Use the Demos menu to play some demonstration 
presets. These demos use the Sync mode and 
Follow→Object features as can be seen in the 
“Sync mode” section below. Select Default settings 
to restore the 3D viewer configuration to the default 
settings at any time or after a demo has been 
played. Note that the demos can not be started 
when a simulation is in progress. Also, use the 
Reset all settings option to reset all the simulator 
settings to defaults. Be aware that the current 
configuration will be lost. The Reload files menu  
is useful to reload the simulation data files if they 
were modified from an external editor. 
 
 
 

                                                      
2 NORAD two-line element format 
 http://celestrak.com/columns/v04n03 
3 Balloon trajectory forecasts 
http://weather.uwyo.edu/polar/balloon_traj.html 
4 GFS Atmospheric Model 
http:// www.emc.ncep.noaa.gov/index.php?branch=GFS 
5 Lloyd Bailey 3D Airspace 
http://www.lloydbailey.net/airspace.html 
6 Lowell Observatory 
http://www.lowell.edu 

Window: With these commands you can resize 
the main window to a specific size or the size of 
a multiple monitor desktop. Use the Asymmetric 
option to move the 3D render to the left and 
avoid the display border when an even number 
of displays are used. You can also take a screen 
snapshot in PNG format or record a video of the 
simulation in AVI format. These files will be 
stored in the Videos folder. 
 

FOV: Set the field of view of the camera in the 3D viewer. Use Default in 
Onboard sensor mode to restore the default FOV of the sensor lens. 
 

Flat view: Toggle between Flat and Spherical view. 
 

Orthogonal: Toggle between Orthogonal and Conic view. 
 

Auto zoom: In this mode, the simulation will automatically change the time 
speed and zoom in and out the camera respect to the spacecraft altitude. 
 

Sync mode: Activate or deactivate the synchronization mode. When this 
mode is active, the simulation will be always synchronized with the real date 
and time. Note that the Sync mode can not be activated when a normal 
simulation is in progress. See the “Sync mode” section below for more 
information about this mode. 
 

Full screen: Toggle Full screen window mode. 
 

Minimize: Use this command to minimize the main window. 
 

System info: Show information about the 3D graphics and the computer. 
 

 Options: Show or hide the Options panel. 
 

 Help: Show or hide the Help panel. 
 
Customize the Toolbar and show extra buttons 
 

The Toolbar can be configured to show more buttons or hide the buttons that 
are not needed. Also, it can be resized to adjust its size to the main window 
size. Right click on it to access the context menu and specify the desired size 
or select the Customize option to configure the Toolbar buttons. In this mode, 
activate or deactivate the buttons that must be shown and finally, select 
Customize again to return to the normal mode. You can use the small 
buttons             on the right to minimize, maximize or close the application. 
 

 Apply changes: Use this command to apply the changes to some 
parameters and return to a predefined point when a simulation is in progress. 
Some of the parameters that will be updated are related to the spacecraft 
trajectory like Earth and Moon parking orbit delays, Thrust and lift limits, 
Braking distance, Stage delay and other parameters are related to the 
spacecraft design like Parachute, Electrical power, Emissivity or the 
attitude control like Control and PID. Also, the first time this button is 
pressed, the current point of the trajectory will be saved. The next time the 
button is pressed, the simulation will return to this point. Press the button 
twice to clear this point so a new point can be defined. 
 

 Next step: Advance only one simulation step. Use this command to 
calculate the simulation step by step when an important event is in progress. 
 

 Increase or decrease time step: Use these buttons to adjust the 
time step of the simulation when more precision for the calculation of the 
trajectory is needed. 
 
Switch to panel menu 
 

In case there are many panels on the screen and 
some of them are hidden, you can switch to any 
panel with the Switch to menu. Press Ctrl+Tab at 
any time to show this menu and select a panel from 
the list to bring it to the front. Also, select the Close 
all panels, Basic panels or Default panels options to 
show a predefined set of panels. 
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 PANELS Options panel 

Press F10 to show or hide the Options panel. Use this panel to change the 
program configuration. The options are divided in 5 pages: Tools, Simulation, 
Events, Screen and Options. Press the buttons on the top of the panel to 
access the desired page. 
 

 Tools: Show or hide some elements in the 3D viewer: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Airways Ctrl+W Airways, airspaces, airports and seaports 
Altimeter Ctrl+E Auto-scaled altimeter 
  • Distances Alt+E Distance as circles in the reference plane 
Asteroids Ctrl+X Asteroids orbiting around the Sun 
Atmosphere Ctrl+D Earth atmosphere layers 
  • Atmosphere glow Alt+D Earth and Mars atmosphere glow 
Axes Ctrl+A Simulator and object 3D axes 
Boundaries Ctrl+N Land and water boundaries 
Comets Ctrl+Z Comets orbiting around the Sun 
Compass Ctrl+I Compass aligned to the reference plane 
  • Compass grid Alt+G Grid aligned to the reference plane 
Gravity field Ctrl+G Gravity field of the planets 
Grid Ctrl+O Parallels and meridians in planets 
Launch site Ctrl+U Launch site and North and South Poles 
Locations Ctrl+L Predefined locations and cities 
Magnetic field Ctrl+M Magnetic field of the Earth 
Moons Ctrl+Q Natural satellites of the planets 
Path Ctrl+P Spacecraft current trajectory 
  • Snap points Alt+N Saved snapshot points 
Planets Ctrl+Y All the planets in the solar system 
Report Ctrl+J Presentation tool 
Satellites Ctrl+H Artificial satellites around the Earth 
Stage info Ctrl+S Current stage number 
Stars Ctrl+F Starfield background 
  • Star tracker Alt+S Nearest stars used in the star tracker 
Stations Ctrl+K Ground radio-station network 
Terrain Ctrl+T Planets terrain 
Trajectory Ctrl+C Spacecraft trajectory prediction 
  • Planets position Alt+C Planets position at mission time 
 
• Ranges C Ctrl+R 
 

   Altitude  Distance to the nearest planet center 
   Atmosphere and ionosphere Earth atmosphere and ionosphere planes 
   Apoapsis and periapsis Planets apoapsis and periapsis 
   Braking distance  Braking distance for the hover stage 
   Orbital plane  Spacecraft orbital plane 
   Objects orbits  Orbits of asteroids, moons and satellites 
   Planets orbits  Orbits of all the planets 
 
• Vectors C Ctrl+V 
 

   Air drag and lift  Atmosphere drag and lift forces 
   Altitude to reference plane Altitude relative to the reference plane 
   Ground projection  Altitude relative to the nearest planet 
   Ground speed  Speed relative to the planet surface 
   Magnetic field vector  Vector aligned with Earth magnetic field 
   Net gravity force  Gravity minus centripetal acceleration 
   Speed  Speed relative to the planet center 
   Vertical speed  Vertical speed relative to the planet 
 
• Sensor C Ctrl+B 
 

   Crosshair  Crosshair at the center of the image 
   Deviation  Deviation angles respect to the target 
   FOV projection  Field of view projection on ground 
     • Area  Visible area and pixel size 
   Labels  Locations labels and information 
     • Time stamp  Time of the mission 
   Trace  Target projection over X and Y axes 
 

 Simulation: Activate or deactivate some elements in the simulation. Use 
these options to see how every simulation element affects the spacecraft 
trajectory. Turning off Statistics, Sun gravity or planets gravity will improve 
the simulation speed if they are not needed. The Matrix terrain model uses 
ground elevation data from USGS GTOPO30

7
, geoid elevation data from 

NGA
8
 and NASA elevation data

9
 to detect the ground over sea level. Note 

that 750 MB of RAM memory is needed to load the full world terrain. See the 
“Terrain files” section for more information about terrain and geoid files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Gravity model C 
 

  No gravity Do not apply gravity force 
  Earth gravity Apply only Earth gravity force 
  Earth-Moon gravity Apply Earth and Moon gravity force 
  Earth-Moon-Sun gravity Apply Earth, Moon and Sun gravity force 
  All planets gravity Apply all planets gravity force 
 

• Terrain model C 
 

  Spherical terrain Use a spherical planet model 
  Ellipsoidal terrain Use an ellipsoidal planet model 
  Matrix terrain Use elevation data if available 
 

• Atmospheric model C 
 

  Atmospheric model: off Do not use the atmospheric model 
  Atmospheric model: low Use the model with no interpolation 
  Atmospheric model: med Use the model with Z axis interpolation 
  Atmospheric model: high Use the model with X, Y, Z axes interpolation 
 

Adaptive time step Increase time step in deep space zones 
Airspace detection Detect the presence inside any airspace 
Area detection Detect the presence inside country boundaries 
Asteroid proximity Detect the proximity of asteroids and moons 
Atmosphere drag Apply atmosphere drag force 
Atmosphere lift Apply lift force using the lift to drag ratio 
Balloon trajectory Simulate the trajectory of the balloon 
Empty stages Simulate the trajectory of the empty stages 
Ground station visibility Detect the visibility of the ground radio-stations 
High definition detection Calculate detection every simulation time step 
Isp at sea level Reduce thrust due to atmospheric pressure 
Planet collision Detect collision with planets ground 
Planet shadow Do not apply solar heat if obscured by a planet 
Real time speed Run the simulation at real time speed 
Satellite proximity Detect the proximity of the satellites 
Solar wind pressure Apply solar wind pressure 
Statistics Calculate statistics for Data panel 
Wind speed Apply the atmospheric model wind speed 
 

Launch trajectory Apply attitude control in the launch trajectory 
Landing maneuver Apply attitude control in the landing maneuver 
Satellite control Apply attitude control in satellite deployed 
 
Log to file: Use this option to activate the recording of the selected 
simulation parameters to a CSV format file. Every time that the simulation is 
started, a new file will be created at the Logs folder using the current time 
stamp as the file name. The data generated for every simulation loop will be 
recorded in the file until the simulation is paused. 
 

Date and time Current date and time in UTC format 
Mission time Elapsed time from the start of the mission [s] 
Coordinates Polar coordinates: latitude and longitude [degrees] 
 • 3D • Cartesian coordinates: X, Y, Z [m] 
Altitude Altitude relative to the sea level [m] 
 • Gnd • Altitude relative to the ground level [m] 
Distance Distance to the nearest planet center [m] 
 • 3D • X, Y, Z components of the Distance vector [m] 

                                                      
7 USGS GTOPO30 
https://lta.cr.usgs.gov/GTOPO30 
8 NGA EGM2008 Earth Gravitational Model 
http://earth-info.nga.mil/GandG/wgs84/gravitymod/egm2008 
9 NASA elevation data 
http://pds-geosciences.wustl.edu/dataserv/holdings.html 
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Speed Speed relative to the nearest planet center [m/s] 
 • 3D • X, Y, Z components of the Speed vector [m/s] 
Air speed Speed relative to the atmosphere [m/s] 
 • 3D • X, Y, Z components of the Air speed vector [m/s] 
Thrust Thrust of the spacecraft engine [N] 
Acceleration Acceleration including the gravity [m/s²] 
 • 3D • X, Y, Z components of the Acceleration vector [m/s²] 
Inertial Acceleration without the gravity [m/s²] 
 • 3D • X, Y, Z components of the Inertial vector [m/s²] 
Air drag Atmosphere drag deceleration [m/s²] 
 • 3D • X, Y, Z components of the Air drag vector [m/s²] 
Gravity Gravity of the nearest planet [m/s²] 
 • 3D • X, Y, Z components of the Gravity vector [m/s²] 
Mass Total mass [kg] 
Temperature Static temperature [K] 
Ground stations Number of ground stations available 
Airspaces Number of airspaces detected 
 

Note that only the metric system is used and the 3D Cartesian vectors use 
the ecliptic coordinate system, except for the Cartesian coordinates that use 
an ECEF (Earth Centered, Earth Fixed) coordinate system. 
 

 Events: Pause the simulation, save a snapshot or add a log entry to the 
Log panel when an event is triggered. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All events Activate or deactivate all events 
 

Lift off The spacecraft has lifted off the ground 
Stage engines on  A stage has started the engines 
Stage engines off A stage has stopped the engines 
Hover engines on The hover stage has started the engines 
Hover engines off The hover stage has stopped the engines 
Last stage engines off The last stage has stopped the engines 
Satellite deployed The satellite is deployed after burn out 
Moon transfer The hover stage is deployed after burn out 
Stage abort The sequence is aborted after a stage burn out 
 

Apogee The maximum altitude from Earth is reached 
Perigee The minimum altitude from Earth is reached 
Aposelene The maximum altitude from Moon is reached 
Periselene The minimum altitude from Moon is reached 
Planet apoapsis The maximum altitude from a planet is reached 
Planet periapsis The minimum altitude from a planet is reached 
 

Exit atmosphere The spacecraft has exited the atmosphere 
Enter atmosphere The spacecraft has entered the atmosphere 
Exit ionosphere The spacecraft has exited the ionosphere  
Enter ionosphere The spacecraft has entered the ionosphere  
 

Earth sound speed The Earth sound speed is reached 
Earth orbital speed The Earth orbital speed is reached 
Earth escape speed The Earth escape speed is reached 
Moon orbital speed The Moon orbital speed is reached 
Moon escape speed The Moon escape speed is reached 
Mars orbital speed The Mars orbital speed is reached 
Mars escape speed The Mars escape speed is reached 
 

Equidistant point The equidistant point Earth-Moon is reached 
L-1 Lagrange point The L-1 Lagrange point Earth-Moon is reached 
Moon distance The Moon orbital distance from Earth is reached 
Planet distance The planet orbital distance from Sun is reached 
Planet approach The spacecraft entered the planet gravity influence 
Planet proximity The spacecraft is near than the planet radius 
Planet faraway The spacecraft exited the planet gravity influence 
Braking altitude The spacecraft has reached the braking altitude 
 

Station available A ground radio-station has become available 
Station unavailable A ground radio-station has become unavailable 
Enter airspace The spacecraft has entered an airspace or area 
Exit airspace The spacecraft has exited an airspace or area 
Satellite proximity A satellite has entered the proximity zone 
Satellite faraway A satellite has exited the proximity zone 
Asteroid proximity An asteroid, comet or moon is near the spacecraft 
Asteroid faraway An asteroid, comet or moon is moving away 
Link error A link error with the external device has occurred 

 Screen: Change the configuration of the 3D viewer, the panels and the 
video recording. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Color theme: Change the color theme for all the panels and the 3D viewer. 
System is the current desktop color theme. Press the       button to show the 
Color selector and change the color of a specified element of the 3D viewer 
or the text font used in all the panels, the 3D viewer and the Report tool. 
 

Background: Change the color of the 3D viewer background. 
 

Panels style: Select Basic 2D or Advanced 3D style for all the panels. 
 

Snap panels to border: Activate this option to snap all the panels to the 
main window border. 
 

Main window border: Show or hide the 3D viewer window border. 
 

Use OpenGL: Toggle between OpenGL / 3D and GDI / 2D render. 
 

Vertical sync: Toggle the screen vertical synchronization. Deactivate this 
option to increase the frame rate when the View panel is used. 
 

Antialiasing: Activate this option to smooth pixel edges in the 3D viewer. 
 

Video frames: Select the frames per second for the video recording. Higher 
frame rates needs also higher CPU / GPU power. Press the     button to 
configure some advanced options for the video recording like compression 
codec, video quality and keyframe interval. 
 

Capture mode: Use the entire screen, the main window or the View panel 
for the image and video recording. Select the Onboard mode to enable the 
automatic video recording of the Onboard sensor view when specific events 
are triggered. Use the Pause options in the Events tab to activate these 
events. Select        to start the video recording and       to stop it. Also, press 
the Record         button in the Toolbar to deactivate this mode. 
 

Capture mouse: Include the mouse icon in the video recording. 
 

Tile planet textures: Use texture tile if your graphic card can not handle 
large textures. See the “High definition textures” section for more information 
about using optional texture files. 
 

Earth texture: Select the texture used in the Earth 3D model. 
 

Use planet textures (Alt+X): Use textures for the 3D models of the planets. 
 

Use font textures (Alt+F): Use textures for the labels in the 3D viewer. 
 

Smooth lines (Alt+Q): Antialiased lines in the 3D viewer. 
 

Hidden points (Alt+W): Show the points hidden behind the planets. 
 

Hidden lines (Alt+Z): Show the lines hidden behind the planets. 
 

Saved paths points (Alt+H): Snapshots of the paths saved in memory. 
 

Time points (Alt+M): Auto-generated time snapshots. 
 

Extra information (Alt+I): Extra information in some labels of the 3D viewer. 
 

Simulation errors: Show a popup message with information about invalid 
parameters in Setup and Stages panels. 
 

Hide selection cursor: Activate this option to hide the cursor of the selected 
object after a short time. 
 

Viewer: Use this option to select a predefined configuration for the 3D viewer 
according to a specific type of mission. 
 

Main plane: Select the reference plane for the 3D viewer. Ecliptic is the 
Earth orbital plane, Equatorial is the Earth equatorial plane and Orbital is the 
Moon orbital plane. 
 

System of units: You can choose metric or English units for the Data, Log 
and Graph panels and the 3D viewer. 
 

Coordinates: Use degrees only, degrees and minutes or degrees, minutes 
and seconds in latitude and longitude coordinates. 
 

Absolute temperature: Show temperatures in absolute scale using K and R 
degrees or relative scale using C or F degrees. 
 

Relative speed: Show the speed relative to the atmosphere instead of 
relative to the planet center. 
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Relative time: Show time stamps in the Trajectory render tool relative to the 
current time instead of the mission start time. 
 

Geoid altitude: You can choose between Geoid or Ellipsoid altitudes. 
 

Magnetic moment: Show the attitude control force as a magnetic moment. 
 

Use semicolon separator: The comma is used in some countries as a 
decimal point. To avoid this, some applications for these countries that work 
with CSV files like Microsoft Excel, use the semicolon instead of the comma. 
Activate this option to generate CSV files compatible with this software. 
 

Reverse movement: Use this option to reverse the movement of the camera 
in any of the X, Y and Z axes when using the mouse in the 3D viewer. 
 

Reverse rotation: Use this option to reverse the rotation of the camera 
around any of the X, Y and Z axes when using the mouse in the 3D viewer. 
 

Reverse zoom: Use this option to reverse the zoom of the camera when 
using the mouse in the 3D viewer. 
 

Tooltip delay: Time to wait before the tooltips are shown. Select Disable to 
disable the tooltips. 
 

Sun shadow: The shadow of the sunlight can be modified with this option. 
 

Spacecraft scale: Select the icon size of the spacecraft, the ground station 
and the tracking object in the 3D viewer. 
 

Show 3D icons: Show or hide the icons of the spacecraft, the ground station 
and the tracking object in the 3D viewer. 
 

 Options: Use this panel to access the program configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Snapshots interval: This option sets the time elapsed between two auto-
generated snapshots. 
 

Path points interval: Set the time step for the points in the trajectory line. 
 

Graph total time: Change the graph recording time. 
 

Terrain quality: Specify the level of detail of the terrain. 
 

Terrain vertical scale: Use this option to increase the terrain vertical scale. 
 

Planet grid step: Set the step of parallels and meridians in degrees. 
 

Atmosphere layer: Use this option to select the layers that will be shown for 
the Earth Atmosphere render tool. Select a specific layer to show only the 
desired layer, Current to show the layer at the spacecraft altitude or All layers 
to show all the available layers. The Default option will automatically adjust 
the number of layers that will be shown. Also, use the Field density and Field 
scale options to adjust the layers parameters. 
 

Temperature layer: This layer shows the temperature of the air 
using the color table shown in the 3D viewer overlay. 
 

Humidity layer: This layer shows the relative humidity of the air 
where opaque zones of the layer represent 100 % humidity and 
transparent zones represent 0 % humidity. 
 

Cloud water layer: This layer shows the mixing ratio of the cloud 
water in the air using the transparency of the layer. When this 
layer is combined with the humidity layer, magenta color is used 
for the layer instead of white. 
 

Wind speed layer: This layer shows the wind speed using the 
color table shown in the 3D viewer overlay. 
 

Wind speed vectors: This layer shows the wind speed as 
vectors pointing to the wind direction and using the same color 
table as the wind speed layer. 
 

Airspace: Select the airspace zone used in the Airways render tool. 
 

Group: Use this option to select a group of the selected airspace zone. 
 

Airspaces: Show the airspaces inside the selected airspace zone. 
 

Airports: Show the airports inside the selected airspace zone. 
 

Lower airways: Show the lower airways inside the Spanish airspace. 
 

RNAV routes: Show the RNAV routes inside the Spanish airspace. 
 

Seaports: Show the seaports of the world. 
 

Land boundaries: Show the land boundaries of all the countries in the world. 
The land and water boundaries, the populated areas, the seaports and the 
cities tools use data from the NACIS Natural Earth

10
 map data. 

 

Water boundaries: Show the water boundaries of all the countries in the 
world at 200 nautical miles. This area is called exclusive economic zone and 
every country has control over the economic resources. 
 

Populated areas: Show highly populated areas in the world. 
 

Cities: Show the cities of the world. 
 

Locations: Show the predefined locations. 
 

Station network: Select the active ground radio-station network. The radio-
stations are stored in the “Stations.csv” file at the Stations folder. Note that 
this setting has no effect when a target list is defined in the Setup panel and 
only the radio-stations that are defined in the list are shown. 
 

Station visibility angle: Specify the minimum angle above the horizon from 
which the radio-station can detect the spacecraft. 
 

Sensor: Specify the sensor device emulated by the Onboard follow mode in 
the View panel. These sensors are defined in the “Sensors.lst” file located at 
the Sensors folder. 
 

Lens: Use this option to change the default lens for the selected sensor. 
 

Satellites: Select the group of satellites that will be displayed in the 3D 
viewer. Use the Update satellites option in the Path sub-menu to download 
and update the trajectories of the satellites. 
 

Satellite distance: Specify the distance used in the satellite proximity 
detection. 
 

Asteroids: Select the group of asteroids and minor planets that will be 
displayed in the 3D viewer. 
 

Asteroid distance: This is the distance used in the detection of asteroids, 
minor planets, comets and moons. 
 

Asteroid density: Select the density of the asteroids, minor planets, comets 
and moons shown in the 3D viewer. By default, only the most important 
objects are loaded. If a computer with a good CPU and graphic card is used, 
the density of the objects can be increased. It is recommended to disable the 
labels of the objects and the Ranges→Altitude option in the Tools tab of the 
Options panel when more than 100 objects are shown. 
 

The orbital data of the comets is stored inside the “Comets.ini” file located at 
the Planets folder. The data for the moons of the planets is located in the 
same folder, inside the files with the name of the parent planet and the 
“.Moons.ini” string added to the file name. This data has been extracted from 
the NASA Solar System Dynamics

11
 web page. 

 

Object visibility: Use this option to hide the labels of asteroids, minor 
planets, comets, moons and satellites that are far from the camera position. 
Objects that are beyond this distance will be shown only as small points. 
 

Starfield density: You can choose the starfield density for the background. 
The list of the stars is stored in the “Stars.ini” and “StarTracker.ini” files 
located at the Planets folder. 
 

Gravity field: Select the style of the Gravity field render tool. 
 

  • Disk Circles around the planets as a function of their gravity. 
  • Zone Semi-transparent plane with the gravity applied to every point. 
  • Grid 2D grid with the vertical scale as a function of the gravity. 
  • Vector Vector grid oriented to the gravity force direction. 
 

Magnetic field: Select the style of the Earth Magnetic field render tool. This 
tool uses the NOAA World Magnetic Model

12
. 

 

  • Lines Polylines connecting the North and the South poles. 
  • Planes Semi-transparent planes with the magnetic field polylines. 
  • Vectors Vector lines located at the spacecraft altitude where the green  
 part of the line points to the Earth magnetic North Pole. 
 

Field distance: Drawing distance of the Gravity and Magnetic fields tool. 
 

Field density: Level of detail of the Gravity and Magnetic fields tool and the 
Atmosphere layers. 
 

Field scale: Adjust the scale of the Gravity field tool when the spacecraft is 
near the Sun or far from it. Also, the scale of the vectors used in the 
Atmosphere layers can be adjusted with this option. 
 

Labels density: Select the labels density of the airports, seaports and cities. 
 

Lines definition: Select the definition of the lines used in the land and water 
boundaries and the populated areas. 
 

Use airways altitude: Use the airways altitude or show them at sea level. 
 

                                                      
10 NACIS Natural Earth map data 
http://www.naturalearthdata.com 
11 NASA Solar System Dynamics 
http://ssd.jpl.nasa.gov 
12 NOAA World Magnetic Model 
http://www.ngdc.noaa.gov/geomag/WMM 
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 PANELS Setup panel 

Press F5 to show or hide the Setup panel. This panel allows all the functions 
related to the mission design. 
 
 
 
 
 
 
 
 
 
 
 
 
Simulation preset 
Press the arrow       button to load a predefined preset: 
LEO: Put a WikiSat satellite of 20 grams in LEO orbit. 
GEO: Put a WikiSat satellite of 20 grams in GEO orbit. 
Moon: Put a PicoRover lunar rover of 500 grams on the Moon. 
 
Launch date and time 
This simulator uses an algorithm

13
 to calculate 

the position of the planets depending on the 
launch Date and Time. Here you can select the 
desired launch date in UTC time format. Use the      buttons to easily adjust 
the starting simulation time and the position of the Earth, the Moon and the 
planets. Double click on the buttons to select the real time. 
 
Launch site 
Select the desired launch site by pressing the        button. 
Use Selected to copy the selected object coordinates. 
 
Launch site coordinates 

Latitude and longitude in degrees and altitude in meters 
of the launch site. 
 
Launch initial heading 

Desired orbit plane in degrees. Compass standard rule is 
used for a plant view where 0 degrees is North. You can 
use less propellant if the initial heading is East. 
 
Launch initial angle 
This is the launch initial pitch angle where 0 degrees is 
horizontal and 90 degrees is vertical. 
 
Launch trajectory arc 
Used to follow a launch trajectory of minimum 
energy from Start angle in degrees at a given 
altitude in meters to the End angle in degrees at 
a given altitude in meters. 
 
Launch initial speed 
The Launch initial speed is used to emulate a launch 
from an airplane or a moving vehicle. 
 
Simulation time step 
Time step of the simulation main loop. Lower values give 
better result accuracy but require more CPU power. 
 
Earth, Moon and Mars parking orbit delay 
This will emulate an Earth, Moon or Mars parking orbit. 
When the orbital speed is reached, the engine will stop 
for a specified time. After the delay, it will restart again to 
continue the sequence or the satellite will be deployed. 
 
Thrust and lift limits 
Engine thrust and lift force limits in G factor units. Use 
this to keep G force felt by the spacecraft under the 
structure or payload limits. 
 
Braking distance 
Lunar lander or parachute braking distance. This 
parameter is optional. 
 
Show stages, trajectory editor and extended parameters 

Press the       button to show or hide the Stages panel with parameters for 
the stages and the payload or the      button to show or hide the Trajectory 
editor. Press the       button to show or hide the extended mission parameters 
and the    button to switch 
between the targets list and the 
mission overview. 
 
Targets list 

This list defines the ground radio-stations 
as targets, sorted by priority, for the 
attitude control of the satellite. You can 
select items in the Search panel or the 3D 
viewer and use the            buttons to add 
or remove them and the          buttons to 
move them up or down in the list. See the 
“Onboard sensor” section below. 
 
Mission overview 
This is the description of the mission. You 
can put here all the information related to 
the trajectory or the spacecraft design. 

                                                      
13 Source http://www.stargazing.net/Kepler/mean.html  

 PANELS Stages panel 

Press F6 to show or hide the Stages panel. Here you specify the stages, 
hover and payload performances: 
 
 
 
 
 
 
 
 
 
 
 
Mass Total mass (propellant + structure + payload). Use a percent 

ratio in every stage to specify a fixed mass distribution. 
 

Dry Dry mass without propellant. You can use a Mass percent ratio. 
 

Thrust Thrust at sea level, burn rate or burn time. Use a percent ratio 
to scale Thrust to Mass. 

 

Delay This is the time elapsed before the stage is triggered. 
 

Type Select a stage propellant or a real engine from the list. Add a 
“xN” string to specify a N multi-stage. For example: “APCPx5”. 

 

Area Stage front area, diameter or percent ratio of the total length. 
 

Length Stage length. Use a percent ratio to specify the dry volume. 
 

Control Attitude control thrust limit. Use a percent ratio to scale the 
control thrust to the main thrust. The default is unlimited thrust. 

 

PID Proportional, integral and derivative
14

 parameters of the attitude 
control algorithm. Use these parameters to adjust the reaction 
time and the stability of the attitude control. See the “Attitude 
control” section for more details. 

 

Lift to drag Lift to drag ratio. 
 

CD Drag coefficient. You can specify a fixed drag coefficient or 
press the       button to select a predefined drag curve. 

 

MoI Moment of inertia of the stage around X, Y and Z axes as 
described in the “Attitude control” section. Default is the 
moment of inertia of a cylinder aligned with the Z axis. 

 

CM Center of mass relative to X, Y and Z axes.  
 

Battery Electrical charge of the main battery. 
 

I max Maximum allowable current of the electronic components. 
 

V max Maximum allowable voltage of the electronic components. 
 

Power Electrical power consumption of the electronic components. 
 

T min / max Minimum and maximum operating temperatures of the stage. 
 

Emissivity Emissivity factor of the stage materials.  
 

Isp Specific impulse of the propellant at sea level and in vacuum. 
This is optional and it will override the propellant default values. 

 

ModeI 3D model for the selected stage and the upper stages in the 3D 
viewer. The Emissivity and CM parameters are calculated from 
the 3D model. See the “OpenGL icons” section below. 

 

Payload Payload mass. 
 

Parachute Parachute diameter or front area. Use a 
percent ratio to scale the parachute 
diameter to the spacecraft diameter. 

 

Abort Last usable stage number. After the 
specified stage burn out, the launching 
sequence will be aborted. 

 

Jettison Activate this option to jettison the upper 
stages from the selected abort stage. 
This can be used to calculate an empty 
stage trajectory. 

 
Add or remove stages 
Use the      button to add or duplicate the selected stage 
and the       button to remove it from the panel. 
 
Show extended stage parameters 
Press the      button to show or hide the parameters 
of the selected stage and the 3D model panel. 
 
Calculate stages 
This button calculates the optimum stage mass distribution. 
 
Tool tip text 

There is a help tool tip in every text box or check box of the Setup, Stages, 
Propellant editor, Link, Options, Search, Trajectory editor and Preset editor 
panels and in the parameters of the Data and Graph panels. Stop the mouse 
pointer over the text box or the panel a few seconds to show the tool tip. 
 
Text boxes 

Text boxes in panels accept numbers and units and there is a default unit 
shown by the Tool tip text. SI prefixes of IUPAC

15
 can be used. You can use 

multipliers like: Tm, Gm, Mm and km, and dividers like: dm, cm, mm, um, nm 
and pm. You can also use English units like: ft, in, lb, lbf, kn or mph. Scientific 
notation is also allowed like: 1.23e-3lb or 5.03E12m. 

                                                      
14 PID controller design http://www.controlguru.com/pages/table.html 
15 IUPAC http://old.iupac.org/reports/1993/homann/index.html 
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 PANELS Help panel 

Press F1 to show or hide the Help panel. The reference manual can be 
accessed from this panel using Adobe Reader

16
. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 PANELS Data panel 

Press F2 to show or hide the Data panel. Use the 
context menu to change the panel style, select the 
visible data items or copy the data to the clipboard. 
 

• First row is the current stage on command and the 
label for this stage. 

 

• Second row is the simulation time step, scale of 
time and the elapsed time (day, hours, etc.) for the 
capture showed by the OpenGL viewer) 

 

• Third row is the simulation date and 
time in UTC time format and the 
render frames per second. 

 

• Speed E is the spacecraft speed 
relative to the Earth and to its 
atmosphere. 

 

• Speed T is the spacecraft speed 
relative to the nearest planet and to its 
surface.  

 

• Speed V is the spacecraft vertical 
speed relative to the nearest planet 
and the gravity minus the centripetal 
acceleration in percent ratio. 

 

• Orbit is the orbital speed for the 
current altitude and percent reached. 

 

• Escape is the escape velocity for the 
current altitude and percent reached. 

 

• Apsis is the orbital periapsis, semi-
major axis and apoapsis. 

 

• Period is the orbital inclination, 
eccentricity and period. 

 

• Angles is the orbital argument of 
periapsis, longitude of ascending 
node, mean anomaly and true 
anomaly. 

 

• Altitude E and Altitude T is the 
altitudes respect to the center and above main level of the Earth and the 
nearest planet. 

 

• Gravity E and Gravity T is the gravity factor and acceleration felt by the 
spacecraft due to the Earth and the nearest planet. 

 

• Accel is the total acceleration felt by the spacecraft. 
 

• Inertial is the acceleration felt by the spacecraft without the gravity. 
 

• Drag is the drag force caused by the friction with the atmosphere. 
 

• Lift is the lift force generated by the spacecraft wings and main body. 
 

• Pitch is the spacecraft pitch angle respect to the horizontal vector, the 
deviation angle, the angle of attack and the attitude thrust. 

 

• Magnetic is the Earth magnetic field declination, inclination and strength. 
 

• Air is the atmosphere density and pressure. 
 

• Temp is the atmosphere temperature, relative humidity and wind 
heading, visible only if the atmospheric model is available. 

 

• Speed is the atmosphere vertical and horizontal wind speed, visible only 
if the atmospheric model is available. 

 

• Burn is the propellant burn rate and the spacecraft static temperature. 
 

                                                      
16 Adobe Reader http://www.adobe.com 

• Thrust is the thrust due to the engine in acceleration terms, factor and 
percent of throttle. 

 

• Mass is the current spacecraft mass, burned mass and percent of the 
remaining propellant. 

 

• Range SE, Range HE and Range HM are the maximum and minimum 
speed and height respect to the Earth and respect to the Moon. 

 

• Max G is the maximum G force. 
 

• Impulse is the total impulse, the specific orbital energy and the maximum 
attitude control thrust. 

 

• Delta V is the delta-V due to the engine thrust and to the drag. 
 

• Delta V G is the delta-V due to the gravity drag and to the lift. 
 

• Time A/D is the accelerating time during takeoff and the decelerating 
time during the landing phase. 

 

• Proximity is the probability of collision between the spacecraft and the 
satellites or the asteroids. 

 

• Lat, Lon and Alt are the coordinates as a projection pointing to the 
center of the nearest planet. The camera distance is also presented. 

 

• Ground is the distance to the ground and the ground level, visible only if 
the terrain model is available. 

 

• Camera is the camera yaw, pitch and roll angles and altitude relative to 
the main level of the nearest planet. 

 

 PANELS Log panel 

Press F3 to show or hide the Log 
panel where a definition of the 
mini-launcher and a register of 
the events are presented. Use 
the Copy log option in the 
context menu to copy all the text 
to the clipboard or the Save log 
option to save the log to a text 
file. Select the Extended log 
option to show more detailed 
information about the mission 
and the parameters of the 
spacecraft or the High definition 
option to increase the precision 
of the numbers in the messages. 
 
 
 
 
 
 
 
 
 
 

 PANELS Graph panel 

Press F4 to show or hide the Graph panel. This 
panel shows a graph with the most important time-
dependent parameters of a simulation or a balloon 
trajectory. The graph can be configured with the 
context menu. Use the Simulation and Balloon sub-
menus to activate or deactivate some elements in 
the graph. Select Copy data or Copy image to copy 
the data or the graph image to the clipboard. Use 
the Save data option to save the graph data to a file 
in CSV format. For the spacecraft trajectory, green 
is the total acceleration, blue is the engine thrust, 
red is the atmosphere drag and yellow is the static 
temperature. The background color of the graph will 
become magenta when ground stations are 
available and gray when airspaces are detected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
For the balloon trajectory, green is the altitude, red is the horizontal speed, 
yellow is the air temperature and blue is the air relative humidity. 
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 PANELS Propellant editor 

Press F7 to show or hide the Propellant editor. This panel shows the list of all 
available propellants and chemical components. Select a propellant to 
change its performances and components: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• List of the chemical components in the database 
• Thrust curve graph 
• Component name and mass or mixture percent ratio

17
 

• List of the propellants 
 
Select the propellant components and mixture ratio, the 
combustion Chamber and nozzle Exit pressures and then 
press the Calc button to calculate the propellant 
performance using the CPROPEP

18
 simulator. You can add 

or remove a propellant from the list with using the           buttons. The optimal 
mixing ratio of the propellant components can be calculated automatically by 
pressing the     button. The precision of the propellant calculation can be 
adjusted with the text box on the left. Press the    button to show the 
configuration menu. Select None to use mixture ratios with no decimal digits 
or Low, Med or High to use 1, 2 or 3 digits. 
 

Press the        button to generate a graph of the propellant performance. This 
graph will be shown in the 3D Graph panel and it will be also automatically 
exported to a CSV file in the Graphs folder using the name of the current 
propellant. The parameter used in the graph can be defined in the Data sub-
menu of the configuration menu. Also, the range 
and step of the horizontal and vertical axes of the 
graph can be defined in this menu. Activate the 
Show hidden lines option to show all the lines in 
the graph or deselect it to avoid drawing the lines 
over those below. Press the        button to show 
the Burn editor and calculate the thrust curve of a 
solid propellant engine. 
 

These are the parameters of the propellant: 
 
Chamber Combustion chamber pressure. 
Exit Nozzle exit pressure. 
Ratio Nozzle throat to exit expansion area ratio. 
Temp Combustion chamber temperature. 
Density Propellant density (in normal conditions). 
Cost Propellant cost. 
Type Liquid, solid or hybrid. 
Hypergolic Hypergolic propellant (auto ignited). 
Volume Propellant volume correction due to bulkheads. 
IspSL Specific impulse at sea level. 
IspV Specific impulse in vacuum. 
 

 PANELS View panel 

Press F8 to show or hide an extra 3D view. Right click 
on it to show the context menu. You can select a 
specific Follow, Look at and Relative to modes to see 
the simulation from a different point of view. The FOV 
sub-menu and the Flat view, Orthogonal and Auto 
zoom options have the same functionality as the main 
3D viewer. Hide or change the size of the 3D icons 
with the Ship scale sub-menu. Use the Clone sub-
menu to copy the 3D view configuration to or from the 
main 3D viewer. Also, select the Add view option or 
press Ctrl+Alt+F8 to add more View panels. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                      
17 Source http://www.astronautix.com/props/index.htm 
18 CPROPEP http://sourceforge.net/projects/rocketworkbench 

 PANELS Link panel 

Press F9 to show or hide the Link panel. Use this panel to configure and 
activate an external link. You can use an external device to take control of 
the simulation using a protocol described in the “Hardware-in-the-loop” 
section below. Select the Control link mode and specify in Link port any 
available COM port to use a RS-232 serial connection or Network to use an 
UDP-IP network connection. 
 

You can also use the Tracking link mode to track the position of a real object. 
This mode can process the NMEA

19
 commands “$GPGGA” or “$GPRMC” 

from an external GPS connected to a serial port or the Audio input. Also, it 
can use the APRS

20
 tracking service to track the object position. The ground 

station position can be set to the current launching coordinates in the Setup 
panel with the Fixed option. The Select option is useful to set the current 
position to any selected ground station or location in the 3D viewer. For the 
tracking object, a satellite can also be selected with this option. 
 

Use the Rover link mode to control and track the position of a vehicle 
connected to a serial port. The Terminal link mode is useful to connect the 
simulator to any device and send commands to it or receive information from 
this device. Also, use the Graph mode to read data from a device and 
generate a graph. See the “Hardware-in-the-loop”, “Black-box connection 
example”, “GPS Tracking” and “Rover Tracking” sections for more details. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click the arrow       button at the top of the panel to 
show the configuration menu and select the 
desired connection type or the elements of the 
simulation that must be implemented by the 
external device. The text box on the right shows a 
register of the link events and protocol errors. 
 

In the Options sub-menu, use the NMEA output, 
Binary mode, Text mode and Double precision 
options to define the type of data used in the 
Control mode. Activate Wait for device to 
synchronize the simulator with the external device. 
The Test mode option is useful to test the events 
log output without any connected device. Select the 
Log link input, Log station input, Log output and the 
Full data log options to activate the log of the 
messages received by the device. Also, the 
Tracking log option activates the log of the tracking 
objects position. Activate the Tracking sync option 
to synchronize the simulation with the tracking 
object position. Use the Tracking follow options to 
select the object that the camera will follow. Select 
the refresh time of the server read process in the 
Refresh time sub-menu. The Relative angles option 
shows the angles in the labels relative to the 
ground station. Select Path altitudes to show or 
hide the ground projection of the tracking path. 
Activate the Save password option to save the 
password used to login in the server. Use the Auto 
save log option to save the events log to a file. Use 
the Models sub-menu to select a different 3D 
model for the rover, the ground station and the 
tracking object. 

                                                      
19 National Marine Electronics Association 
http://www.nmea.org 
20 APRS tracking service http://aprs.fi 
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 AUXILIARY PANELS Payload camera 

Press Ctrl+Alt+F2 or the     button in the Link panel to show the Payload 
camera. This panel shows the video input from any video device connected 
to the computer. It can be used to show the live video from the camera of the 
payload, like a rover or a satellite. Press the   button again, press 
Ctrl+Alt+F7 or use the Add camera option in the context menu to open 
multiple instances of this panel and show the video input of all the connected 
devices. Note that the number of video devices that can be shown at the 
same time is limited in some computers and the video input can be seen as a 
blank screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When this panel is shown, all the available cameras will be scanned and a 
thumbnail of every device will be placed in the Camera selector at the bottom 
of the window. Click on a camera thumbnail in the selector, press the 1 to 9 
keys or use the context menu to select the video and audio devices that the 
panel will show. Press the       button or use the Refresh cameras option in 
the context menu to refresh the thumbnails of the cameras. 
 
 
 
 

Click on the       button or select Start video stream 
in the context menu to activate the video 
streaming of the selected device in MMS stream 
format. If the video streaming is successfully 
activated, the URL address of the streaming 
server will be shown in the popup message and it 
will be also copied to the clipboard. This URL can 
be used in the Video player or any player that 
supports the MMS streaming protocol to connect a 
remote computer to the streaming server and 
show the live video from the onboard camera of 
the payload. 
 

Also, select Restart device to restart the video 
device if it was disconnected and connected 
again. With the Stream quality options, the 
bandwidth of the video stream can be adjusted for slow network connections. 
Select Video settings or Audio settings to access the advanced device 
settings. The video can be resized with the Video size sub-menu and the Full 
screen option. Press Ctrl+F11 or double click on the video to switch to full 
screen mode and press Escape to exit this mode. 
 

 AUXILIARY PANELS Remote control 

Press Ctrl+Shift+F2 or the     button in the Link 
panel to show or hide the Remote control panel. Use 
this panel along with the Rover link mode to control a 
vehicle connected to the computer. This panel is also 
shown automatically when the Rover link mode is 
selected and closed when the mode is deactivated. 
Select the type of vehicle in the Mode option and the 
control device in the Device option. You can 
configure any input axis and connect it to a specific 
control parameter. Finally, click the    button to 
activate the remote control and click it again to 
deactivate it. You can also use the Input axes 
options to configure the axes read from the inertial 
sensor in the Control and Rover link modes. Also, 
select the Align axes option to align the axes to the 
launch site or activate Normalize vector to normalize 
the input vector. See the “Hardware-in-the-loop”, 
“Black-box connection example” and “Rover Tracking” sections for more 
details. 
 

 AUXILIARY PANELS Information, Search and Ruler 

Click with the mouse on any object in the 3D viewer to select it and show the 
Information overlay with basic parameters. Click on the    icon or press 
Alt+Enter to show the Web browser with extended information about the 
object. To deselect it and hide the Information overlay, click on any empty 
space. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Also, click on the       icon or press Ctrl+F3 to show the 
Search panel. You can use this panel to search objects 
in the database. Type any word in the upper text box 
and the program will search the database for objects 
that match the specified word. Click on any object in the 
results list to select it or double click it to activate the 
Follow→Object mode on the object. At the top of the 
panel, press the arrow       button to access the search 
options. Here you can select the limit of the search 
results and the type of the objects used in the search. 
Select the Sort list option to sort the list items by name. 
 

Hold the Ctrl key and click with the mouse on an object 
in the 3D viewer to add it to the selection Ruler tool. 
This tool is useful to calculate the distance between two 
objects or the angle between three objects. If an object 
was already selected when adding the object, it will be 
used as center point. If no object was selected, the 
spacecraft will be used instead. A line connecting the two objects and the 
distance between them will be shown in the 3D viewer. Use Ctrl+click on 
another object to add it to the selection. Two lines connecting the center point 
and the other two objects, the two distances and the angle between the two 
lines will be shown. In the Tactic follow mode, the azimuth and elevation 
angles will also be shown. When this tool is no longer needed, click on any 
empty space to unselect the items and hide it. 
 

Hold the Shift key and click with the mouse on a planet in the 3D viewer to 
change the Relative To mode of the camera. Use Shift+click on any empty 
space to reset the mode to Auto. 
 

 AUXILIARY PANELS Web browser 

Press Ctrl+Alt+F3 to show or hide the Web browser. Use this panel to 
navigate through the project’s web page hosted by Google. There is also a 
list of useful web links in the Panels→Links sub-menu with information about 
astronautics and science. Use the Application folder option to browse all the 
folders and files of the simulator. Press Ctrl+F12 to show or hide the toolbar 
and Ctrl+F11 to switch to full screen mode. Use the                          buttons 
in the toolbar to navigate through the web pages or access the Links menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 AUXILIARY PANELS Video player 

Press Ctrl+F4 to show or hide the Video player. This 
panel can be used as a video player to play video 
files. Right click on the video to show the context 
menu and access the player options. Select Open 
video to open a video file or Open URL to open a 
video stream in a remote server. Also, you can use 
the Video stream option in the Panels sub-menu to 
open an URL stream. The Open URL option can be 
used to connect the player to the stream server of 
the Payload camera panel in the same computer or 
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in a remote computer and show the live video from the onboard camera of 
the payload. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The video can be resized with the Video size options or it can be played at 
full screen size with Full screen. Press Escape to exit this mode. Also, show 
or hide the player controls with the Show controls option. The Sync video 
option will synchronize the simulation with the current video. Press 
Ctrl+Alt+F6 or use the Add player option to add more Video player panels. 
 

 AUXILIARY PANELS 360º player 

Press Ctrl+Alt+F4 to show or hide the 360º player. This panel can play video 
files in a panoramic format. This video recording technique uses several 
video cameras with a normal FOV (field of view) like 60º or 90º to span the 
total FOV of the video to a wider angle up to 360º. This player can play up to 
10 video files at the same time so the resulting panoramic video can be 
watched from any angle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The video files must have the same name like “WikiSat”, followed by a 
number from 0 to 9. When the open dialog is shown, select the first video file 
in the list, for example “WikiSat1.wmv”. All the video files in the list with the 
same name: “WikiSat1.wmv”, “WikiSat2.wmv”, “WikiSat3.wmv”, X will be 
automatically opened and played. If the screen is large enough, all the videos 
will be shown. If the width of the panoramic video is too large to fit in the 
screen, the window will be resized to the screen width. Press the Num4 or 
Num6 keys in the numeric keypad to change the view position, so the rest of 
the videos that do not fit in the screen can be visible. The angle of the current 
position is shown in the window caption. Press the Num5 key to reset the 
position to 0º. Also, press the Space key to play or pause all the videos. The 
videos can be resized so they fit inside the screen limits. Press the Num+ or 
Num- keys in the numeric keypad to change the zoom level. Press Ctrl+F11 
to switch to full screen mode and press Escape to exit this mode. 
 

 AUXILIARY PANELS Trajectory editor 

Press Ctrl+F5 to show or hide the Trajectory editor. Use this panel to 
automatically calculate a trajectory. 
 

• Balloon trajectory calculates the trajectory for a 
high altitude balloon launch. Define the desired Burst 
altitude, the estimated Ascent and Descent rates and 
the Mission time for fixed-volume balloons. 

 

• Low Earth orbit adjusts the parameters of the 
current preset for a low Earth orbit. Define the 
desired Orbit altitude or period. 

 

• Medium Earth orbit adjusts the parameters of the 
current preset for medium or high Earth orbits like geostationary orbits. 
Define the desired Orbit altitude or period. 

 

• Moon mission adjusts the parameters of the current preset for a 
trajectory that lands on the Moon. Define the desired parking Orbit altitude 
and the estimated Mission time. 

 

When the required parameters are defined, press the Calculate button to 
start the calculation of the trajectory. If there are any errors in the input 
parameters, a warning will be shown and the errors will be corrected. Review 
the corrections and press the button again to continue with the calculation. At 
any time, you can press the button to abort the process. See the “Balloon 
trajectory”, “Low Earth orbit mission”, “GEO orbit mission” and “Moon landing 
mission” sections below for more information about mission design. 

 AUXILIARY PANELS Burn editor 

Press Ctrl+Shift+F7 to show or hide the Burn editor. Use this panel to 
calculate the thrust curve of an engine that uses solid propellant. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Information about the engine specifications 
• Propellant cross and longitudinal sections 
• Thrust curve graph 
• Input parameters of the engine and the propellant 

 

To calculate a thrust curve, enter the required parameters of the engine and 
the propellant in the data text boxes and press Enter. The thrust curve, the 
cross and longitudinal sections of the propellant and the information about 
the engine specifications will be updated. Use the Propellant list to retrieve 
the data from a propellant designed with the Propellant editor. The Burn rate 
parameter uses two elements, a and n that define the burn rate as a function 
of the combustion chamber pressure. This is calculated using the formula: 
Burn rate = a · Pressure[atm] ^ n. Also, press the    button to select a 
predefined burn rate curve. These curves are defined as BRN files in the 
Engines folder. All the parameters related to the size of the engine and the 
propellant can be specified as a fixed number or as a percent ratio of the 
engine or propellant sizes. In this way, all the parameters can easily be 
scaled by changing only the total length or the propellant length. Use the Up 
and Down cursor keys in the text boxes to quickly adjust these parameters 
and find the optimal point. If any parameter is out of range, the preview of the 
graph will not be generated and a short description of the invalid parameter 
will be shown. 
 

Press the      button near the Preset text box to save 
the curve as a custom engine in ENG file format or a 
generic thrust curve in CUR file format. These files 
will be saved in the Engines folder and they can be 
used in the Stages panel or the Propellant editor. 
The format of the file that will be saved or the quality 
of the graph can be selected in the Preset menu. 
Press the      button to show this menu. Also, use 
this menu to save the current burn preset or load a 
preset previously saved. The preset files will be 
saved as INI files in the Engines folder and the 
current preset will be saved on exit as Default. Press 
the       button to calculate the optimal nozzle Throat 
and Exit parameters. 
 

Move the mouse pointer over the graph to show the 
parameters and the propellant burn progress at a 
specific burn time. Right click on it to access the 
context menu and select the parameter that will be 
shown in the graph. If the nozzle parameters have 
been calculated, use the Burn graph, Nozzle throat 
or Nozzle exit options to select the graph that will be 
shown. Activate Burn preview to show a small burn 
progress when the cursor in the graph is hidden. 
Select the Copy data or Copy image options to copy 
the data at the current position and the engine 
specifications or the graph image to the clipboard. 
The graph can also be saved in CSV file format with 
the Save data option. 
 

These are the input parameters of the simulation: 
 

Preset Name of the burn preset, generic curve or custom engine. 
Propellant List of available propellants from the Propellant editor. 
Burn rate Burn rate of the propellant or predefined burn rate curve. 
Exponent Exponential parameter of the burn rate (optional). 
Max pressure Motor chamber burst pressure or maximum material stress. 
Ext pressure Pressure outside the motor chamber. 
Burn pressure Pressure at the end of thrust. 
Mol Effective molar mass of the propellant mixture. 
Kmix Ratio of specific heats of the propellant mixture. 
K2ph Ratio of specific heats of the two phase flow (optional). 
Density Density of the propellant. 
Temperature Temperature of the combustion chamber. 
Efficiency Efficiency of the nozzle. 
Dry mass Engine dry mass or percent ratio of the total mass. 
Chamber Length of the motor chamber or percent of the propellant. 
Length Length of the propellant or percent of the motor chamber. 
Diameter Diameter of the propellant or percent of the propellant length. 
Throat Diameter or area of the nozzle throat or burn area ratio. 
Exit Diameter or area of the nozzle exit or expansion area ratio. 
Thickness Thickness of the motor chamber or percent of the diameter. 
Type Type of geometry used in the propellant design. 
Segments Number of segments in which the propellant is divided. 
Exposed Ends of the propellant exposed to burning. 
Core length Length of the propellant core or percent of the length. 
Core diameter Diameter of the propellant core or percent of the diameter. 
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Fins Number of fins in Star Burner geometry. 
Fin depth Length of the propellant fins in Star Burner geometry. 
Fin width Width of the propellant fins in Star Burner geometry. 
 

Press the        button to show or hide the engine specifications: 
 

Class Engine classification and total impulse. 
Isp Specific impulse. 
Avg thrust Average engine thrust. 
Max thrust Maximum engine thrust. 
Max pressure Maximum combustion chamber pressure. 
Burst pressure Burst pressure of the combustion chamber. 
At burn time Time of the maximum combustion chamber pressure. 
Burnout time Time of the propellant burnout. 
Thrust time Time of the end of thrust. 
Avg burn rate Average propellant burn rate. 
Geometry Geometry of the propellant core. 
Chamber Length of the motor chamber. 
Length Length of the propellant. 
Diameter Diameter of the propellant. 
Thickness Thickness of the motor chamber walls. 
Core length Length of the propellant core. 
Core diameter Diameter of the propellant core. 
Fin depth Length of the propellant fins in Star Burner configuration. 
Fin width Width of the propellant fins in Star Burner configuration. 
Throat Diameter of the nozzle throat and burn to throat area ratio. 
Exit Diameter of the nozzle exit and nozzle expansion ratio. 
Volume Propellant volume. 
Mass Propellant mass and loading volume ratio. 
Dry mass Engine dry mass (without propellant) and dry mass ratio. 
Total mass Engine total mass (with propellant). 
 

See the “Thrust curve calculation” section below for more information about 
the design of solid propellant engines. 
 

 AUXILIARY PANELS Notepad editor 

Press Ctrl+F6 to show or hide 
the Notepad editor. With this 
panel you can edit all the text 
files used in the simulator or 
another text file. 
 

Use the context menu to access 
the panel options. In the Edit 
sub-menu there is a list of all the 
data files that can be edited in 
text format. Select Apply to save, 
apply the changes and reload the 
modified file. Use the Load and 
Save options to edit any text file 
or the Clear all option to clear all 
the text in the editor and create a 
new text file. Also, select Fixed 
font to use a fixed width font for 
the text. 
 

This panel can also be used as a 
text calculator by selecting the 
Use calc option or by pressing Alt+Enter. This 
calculator uses the muParser

21
 open source 

library and can be useful to adjust the mission 
trajectory parameters or any other type of 
calculation. Type a mathematical expression that 
you want to calculate and then press Enter. The 
list of all available functions, operators and 
variables can be accessed by selecting 
Edit→Functions and Edit→Variables in the 
context menu. Variables can be created or 
assigned with the expression “variable=value” 
and deleted using “variable=”. 
 

All the text in the editor and the variables will be 
automatically saved on exit to the “Notepad.txt” 
and “Variables.lst” files in the Data folder to use 
them the next time the simulator is started. 
 

 AUXILIARY PANELS 3D Graph 

Press Ctrl+F9 to show or hide the 3D Graph panel. Use this panel to show 
the 3D graph of a propellant performance generated by the Propellant editor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                      
21 muParser math library http://muparser.sourceforge.net 

Click on the panel and drag the mouse with the left or right buttons to move 
or rotate the graph and use the mouse wheel to zoom in and out. Double 
click on any empty space to change the camera point of view so the graph 
can be seen from different angles. Click on any point in the graph to select it. 
The value and the position of this point will be shown. Also, double click on 
the point to center the camera on it. Click on any empty space to deselect it. 
Click with the right button on the panel to show the context menu. At the top 
of this menu, a list with all the available graphs will be shown. Select a graph 
to load it and show it on the panel. These graphs must be stored in the 
Graphs folder using a CSV format file. Press Ctrl+Alt+F9 or use the Add 

graph option to add more 3D Graph panels. Also, select Delete graph to 
delete the CSV file of the current graph. 
 

The graph shown in the panel can be configured 
with the options in the context menu. Use the Graph 
style sub-menu to show or hide some elements in 
the graph. The Default style option restores the 
graph to the default configuration and the Basic style 
option hides all the elements but the graph itself. 
Select the Information option to see some 
information about the graph ranges, the position of 
the maximum Z value in the graph and the color 
table used in the Auto color mode. Also, activate the 
Max value to show the maximum Z value as a 
vertical red line. When a graph is loaded or 
generated, the panel automatically adjusts the graph 
ranges so it can be seen centered on the panel. 
Deactivate the Adjust axes options to disable this 
feature. Also, deactivate the Solid graph option to see 
the lines behind the graph or select Wireframe to 
show the graph as transparent lines only. Use the 
Shadows option to show or hide the shadows in the 
graph. 
 

The color of the graph and the lines can be changed 
using the Graph color and Line color sub-menus. 
Select Auto to draw the graph using a color table as a 
function of the Z values. Use the Z scale sub-menu to 
adjust the vertical scale of the graph. This option is 
useful for graphs that are very flat and the Z values 
are very similar. Select Auto to automatically adjust 
the Z scale. Use the View sub-menu to change the 
point of view of the camera. Activate the Orthogonal 
option to use an orthogonal view and deactivate it to 
use a conic view. If this option is activated, the graph 
can be represented in 2D mode when the camera is 
aligned with the X, Y or Z axes. Change the panel 
size with the Size sub-menu and the Full screen 
option. 
 

 AUXILIARY PANELS Input graph 

Press Ctrl+Shift+F9 or the      button in the Link panel to show or hide the 
Input graph. Use this panel to read data in comma-separated format from any 
device and generate a graph in real time. This panel is also shown 
automatically when the Graph link mode is selected and closed when the 
mode is deactivated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
To generate the graph, configure the parameters of the connection in the 
Link panel and then select the Graph mode. The device must send the data 
in text format represented by numbers, separated by commas and terminated 
with a semicolon or an End of line character, like CR(13), LF(10), CR-LF(13-
10) or NULL(0). Up to 8 numbers can be sent in a line, the rest will be 
ignored. Every time a line of data is received, the graph will increase the time 
pointer and it will be updated automatically so the data can be seen in real 
time. This is an example of a line of data that will generate 4 graph lines: 
 

12.9,39.6,72.3,98.4; 
 

For every number specified in the line, the simulator will generate a graph of 
different color, using the time of arrival of the data for the horizontal axis of 
the graph. The vertical axis will be adjusted to the minimum and maximum 
values from all the visible graphs. Optionally, a command can be specified in 
the first parameter of the line. You can use the "I" or "INIT" command 
without parameters to clear and initialize the graph. The rest of the 
commands not starting with a number will be ignored. This way, it can be 
compatible with other protocols, like a device that uses the "A" command to 
send the data from its inertial sensor. The labels of the graphs can also be 
defined with the "I" command so they can be identified in the graph panel: 
 

I,Data 1,Data 2,Data 3,Data 4; 
 

The simulator will clear the graph every time the link is started but not when 
the link is stopped. 
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Y+ 

X+ 
Z+ 

 
 
 
 
 
 
 
 
 
 
 
 
 

The graph can be configured with the context menu. 
Use the options at the top of this menu to activate or 
deactivate any element in the graph. Select the Copy 
data or Copy image options to copy the data or the 
graph image to the clipboard and the Save data option 
to save the graph data to a file in CSV format. Use the 
Clear graph option to clear all the data in the graph. 
When the data is received, the cursor is automatically 
moved to the end of the graph. You can activate or 
deactivate the automatic scroll with the Auto scroll 
option in the context menu. When this option is 
deactivated, move the mouse over the graph to show 
the data at a specific time on the left side of the panel. 
Also, click and drag the graph or use the mouse wheel 
to scroll the graph. Activate the Histogram option to 
generate a histogram of the data received. You can 
use the Density menu to increase or decrease the 
number of steps of the histogram. Select the Double 
precision option in the Link panel menu to increase the 
precision of the numbers in the graph. 
 

 AUXILIARY PANELS Color selector 

Press Ctrl+F10 to show or hide the Color 
selector. Use this panel to change the color of 
all the elements in the 3D viewer and the text of 
the panels. Click on any element of the list to 
select it and show the current color assigned to 
that element. Also, click on the    button to 
change the text font used for the element. 
 

The color components of the selected element 
are shown in the lower part of the panel. To 
select a different color, click on a sample of the 
palette on the left. Click on the samples at the 
top of the palette to change the transparency of 
the color. Note that some elements do not use 
transparency and this value will be ignored. The 
color can also be specified with the text boxes 
of the components. Enter the desired value for 
every color component or press the      buttons 
near the text boxes. The selected color will be 
shown in the box near the Apply button. Press 
this button to apply the new color to the 
selected element and update the 3D viewer. 
 

Right click on any element of the list, the color 
palette or the color sample to show the context 
menu. Select Reset color or double click on the 
color sample to reset the selected color to the 
default color. Use the Reset all colors option to 
restore the default color for all the elements in 
the list or the Reset all fonts option to restore 
the default fonts. The type of the palette can be 
selected with the Palette and Gradient options. Use 
the Gradient palette mode to select the color with 
more precision. Also, use the RGB mode or HSL 
mode options to change the type of the color 
components. RGB mode uses Alpha, Red, Green 
and Red components in a range of 0 to 255.  HSL 
mode uses Alpha, Hue, Saturation and Luminance 
components in a range of 0 to 100, except Hue that 
uses a range of 0 to 360. 
 

 

 AUXILIARY PANELS Preset editor 

Press Ctrl+Alt+F12 to show or hide the Preset editor. This panel can be 
used to modify all the parameters of the mission and the spacecraft. Press 
the Load button to load a preset from a file. Then press the Apply button to 
apply the changes to the simulator so you can test it or press the Save button 
to apply and save the changes to a file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 TUTORIALS PicoRover to the Moon 

The general procedure for a mission design is as follows: 
 

• Decide the purpose of the mission, kind of trajectory and the 
number of vehicles involved. 

 

• Design if required a new propellant using the Propellant editor. 
 

• Design the launcher, the payload and the hover if required using 
the Setup panel and the Stages and payload panel. Choose the 
aerodynamics parameters like Lift to Drag ratio and type of 
launcher tip. 

 

• Design the basic mission parameters like the launch moment. 
Launch date and time, Launch site coordinates and other especial 
parameters. In example from an aircraft launch: Launch initial 
heading, Launch initial speed; and from a balloon, Launch altitude 
and Launch initial pitch. Also design the Launch trajectory arc. 
There is no other option in this simulator to define this path. There 
are some options for the trip like Orbit parking delay, Abort stage, 
and Braking distance. 

 

• Design each launcher stage: Stage mass, Dry mass, Thrust, inter-
stage Delay and basic construction parameters such as the Stage 
diameter or front area, Stage length, Stage emissivity and type of 
engine or type of Stage propellant used. 

 

There are some parameters that shall be adjusted during the simulation such 
as the Launch trajectory arc, the inter-stage Delay or others. There is an 
automatism for adjusting a low Earth orbit mission and a Moon landing 
mission described in the next two sections. For any other type of mission 
these parameters should be adjusted by hand. The Data panel or the Graph 
panel can help you to adjust these parameters. Also you can use any remote 
control method to develop any part of the mission like Hardware-in-the-loop 
because you can use real hardware for a subsystem. 
 

Depending on the type of mission there are different procedures to follow. 
Here we present an example of a ball-like rover to the Moon. 
 

This is the procedure to design a mission to the Moon: 
 

• Decide the Payload mass. Here is 500 grams of a PicoRover. 
 

• Decide the number of stages and the performances. In this 
example there are 2 stages and the hover. Best mass distribution 
is 90% - 10%. Also use a direct trajectory of minimum energy like 
29º at 19 km to 3º at 56 km. 

 

• Next step is to adjust the total mass until we reach the escape 
velocity. This is 1,476 kilograms. 

 

• We need to adjust the launch date and time depending on the 
launch site. In our example it is Canary Islands: 28.2ºN, 16.6ºW 
and 0 m. A direct trajectory is used to obtain the best performance, 
but the range for possible launch dates is limited. The launch Date 
and time and the Initial heading must be adjusted so the launcher 
orbital plane and the Moon orbital plane intersect at the point 
where the Moon will be located at the end of the trajectory. This is 
2007-06-26 at 12:09:00 UTC and 87.2º. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Propellant cost is only $48,835. Gross mass is 1,476 kg and dimensions are 
487 mm diameter by 5.01 m long. Time to arrival is 2d 12h 6m. There is a 
video available in http://www.youtube.com/watch?v=MKRx0s1HPSo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Simulator coordinate system 
 

This simulator uses the ecliptic coordinate system as a reference frame. The 
X axis is aligned with the Vernal Equinox and the Y axis with the Summer 
Solstice. The Z axis is perpendicular to the ecliptic plane, which is the plane 
where the Earth orbits around the Sun. 
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 TUTORIALS Low Earth orbit mission 

This is the procedure to design a mission in order to inject a satellite in a low 
Earth orbit. The parameters of the “LEO” preset are shown as an example: 
 

• Define the basic parameters for the mission: 
 

 • Launching site coordinates:  Tenerife: 28.2ºN, 16.6ºW 
 • Orbital altitude:   250 km 
 • Orbital period:   89 minutes 30 seconds 
 • Initial heading:   87.2º 
 • Number of stages and propellant used: 2 stages, APCP 
 • Payload mass:   20 g 
 

• Press the Preset       button in the Toolbar and select “LEO” to reset all the 
mission parameters to a LEO orbit defaults. At any time press the Reset 
simulation     button in the Toolbar to apply the changes for the initial 
parameters in the simulation. In the Log panel a mission briefing will be 
shown with basic parameters like stages 
mass or initial speed. 

 

• Enter the launching site latitude and 
longitude in the Lat and Lon text boxes at 
the Setup panel. Also, enter the initial 
altitude in the Alt text box or leave it blank to 
specify a ground level. 

 

• Press the     button in the Setup panel to show the 
Trajectory editor and select the Low Earth orbit 
mode. Enter the desired orbital altitude in the Orbit 
text box. 

 

• Enter the initial trajectory heading in the Heading 
text box at the Setup panel. Best performance is 
achieved using 90º heading to use all the initial Earth 
rotation speed. The resulting orbital plane inclination 
depends on this parameter but also on the launching 
site latitude. For example, an Equatorial orbit can only be achieved by 
launching the spacecraft from the Equator or by using an orbital plane 
change maneuver. On the other hand a Polar orbit can be achieved from 
any point in the Earth surface. 

 
 
 
 
 
 
 
 

• Press the            buttons at the Stages panel to add or remove stages and 
define the desired number of stages. Make sure that the check box on the 
left of the Stage label is checked. 

 

• Select the propellant or stage type in the Type text box at the Stages 
panel for every stage by pressing the       button on the right side. 

 

• Enter the stage mass percentage in the Mass text box for every stage on 
the left side of the Stages panel. This parameter is useful to scale all the 
stages when the total mass is adjusted to achieve the desired orbital 
speed and altitude. Usually, 90% - 10% for a 2 stages launcher and 80% - 
15% - 5% for a 3 stages launcher are good mass distributions. Depending 
on the payload mass and the type of propellant used in every stage, this 
parameter should be re-adjusted to obtain a better performance. 

 

• Enter the payload mass in the Payload text box at the Stages panel. 
 

• The next step is to define the Launch trajectory arc adjusting the 
parameters: Full Mass, Start angle and last stage Delay located at the 
Setup and Stages panels. In this way, the payload will be deployed at the 
orbital altitude, at the exact orbital speed and with a null vertical speed.  

 

• The process of adjusting the trajectory can be done automatically by the 
simulator by pressing the Calculate button in the Trajectory editor. This 
process can take several minutes, depending on the CPU power of the 
computer used. To cancel the process at any time, press the Escape key, 
the Stop button or the     button in the popup message. The algorithm 
works well within the range of 150 km to 500 km orbital altitude. If the 
selected altitude is outside this range, the design parameters of the stages 
are incorrect or the performance of the propellant is too low, the algorithm 
will fail and these parameters must be corrected. 

 

• In the case that the automatic algorithm can not adjust the trajectory, the 
process can be done by hand by following the next steps: 

 

• To reach the desired orbital altitude and speed, the total mass of the 
launcher must be adjusted. Enter this value in the Mass text box located 
at the top of the Stages panel. Usually, this value can be from about 10 
times the payload mass for a high performance propellant like LO2 / LH2, 
to about 1,000 times the payload mass for a small launcher with a low 
performance propellant like APCP. The following graphs show the full 
mass to payload mass ratio and can be useful to calculate the required 
launcher mass. These graphs have been calculated using the “LEO” 
preset for a 250 km orbit altitude and using APCP, N2O4 / MMH and LO2 / 
LH2 propellants for the stages. The horizontal axis shows the payload 
mass and the vertical axis of the first graph can be used to determine the 
launcher mass. The second graph shows the increment for the mass ratio 
of small launchers of less than 100 kg mass. This is due to their lower 
ballistic coefficient that increases the atmosphere drag. The same effect 
makes smaller payloads to slow down faster when in orbit and the total 
orbit time is reduced as is shown in the last graph. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Clear the Delay text box for the first stage in the Stages panel and set a 

standard inter-stage delay of 3 seconds for the rest of the stages. 
 

• Press the Events control       button in the Toolbar and select the Pause 
check box for the Last stage engines off event. Make sure that all the 
rest of the Pause options are disabled. 

 

• Press the Play            button in the Toolbar to start the simulation and test 
the trajectory. When the burn out event is triggered, the simulation will 
pause. The next step is to reach the required orbital speed. The current 
orbital speed is shown inside the Data panel at the Orbit row as a 
percentage on the right side of the panel. If the orbital speed is below 
100%, the total mass of the spacecraft must be increased. If it is above, 
the total mass must be decreased. Adjust this parameter, press the Reset 
simulation      button in the Toolbar and repeat this step until an orbital 
speed of 100% is reached. Press the       button in the Toolbar to speed up 
all this process. 

 

• When the orbital speed is reached, if the spacecraft is above or below the 
desired orbital altitude, the trajectory angle must be adjusted. The current 
altitude is shown near the spacecraft icon or inside the Data panel at the 
Altitude E row. If the spacecraft is below the desired orbital altitude, 
increase the Start angle in the Setup panel. If it is above the orbital 
altitude, decrease the angle. When the final altitude is changed, also the 
burn out speed will change so the total mass must be re-adjusted to 
compensate the speed gain or loss. Repeat the simulation until an 
acceptable altitude at orbital speed is reached. 

 

• Normally, at this point the spacecraft orbit will be eccentric. The last step is 
to convert it to a circular orbit. To achieve this, the vertical speed of the 
spacecraft must be null at burn out. The current vertical speed is shown in 
the Data panel at the Speed V row. If the vertical speed is positive, the 
inter-stage delay for the last stage must be increased. If it is negative, the 
delay must be decreased. As in the last step, when the delay is changed, 
the burn out speed and altitude also change. Re-adjust the total mass to 
compensate the speed deviation and the trajectory angle to compensate 
the altitude. Adjust the parameters and repeat the simulation until the 
vertical speed at burn out is close to zero and the required orbital speed 
and altitude are reached. 

 

 TUTORIALS GEO orbit mission 

This is the procedure to design a mission in order to inject a satellite in a 
medium or high Earth orbit. In this example, a GEO orbit (Geostationary 
Earth Orbit) will be used but this procedure can be useful to design any other 
type of medium or high Earth orbit. The parameters of the “GEO” preset are 
shown as an example: 
 

• Define the basic parameters for the mission: 
 

 • Launching site coordinates:  Amazon: 0ºN, 50ºW 
 • Orbital altitude:   35,786 km 
 • Orbital period:   23 hours 56 minutes 
 • Parking orbit altitude (optional):  150 km 
 • Initial heading:   90º 
 • Number of stages and propellant used: 2 stages, APCP & N2O4/MMH 
 • Injection stage mass and propellant: 200 g, N2O4/MMH 
 • Payload mass:   20 g 
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• Press the Preset       button in the Toolbar and select “GEO” to reset all 
the mission parameters to a GEO orbit defaults. At any time press the 
Reset simulation     button in the Toolbar to apply the changes for the 
initial parameters in the simulation. In the Log panel a mission briefing will 
be shown with basic parameters like stages 
mass or initial speed. 

 

• Enter the launching site latitude and 
longitude in the Lat and Lon text boxes at 
the Setup panel. Also, enter the initial 
altitude in the Alt text box or leave it blank to 
specify a ground level. 

 

• Press the     button in the Setup panel to show the 
Trajectory editor and select the Medium Earth orbit 
mode. Enter the desired orbital altitude in the Orbit 
text box. Alternatively, the orbital period can be used 
for this parameter. This is the time that the 
spacecraft will need to complete an orbit around the 
Earth. In this case, a GEO orbit is used, so the 
orbital period will be about 1 day to synchronize the 
spacecraft with the Earth rotation speed. In this way, 
it will appear motionless to ground observers, at a 
fixed position in the sky. The sidereal day of 23 hours and 56 minutes is 
used because the Earth rotation around the Sun must be corrected. 

 

• Enter the initial trajectory heading in the Heading text box at the Setup 
panel. Best performance is achieved using 90º heading to use all the initial 
Earth rotation speed. The resulting orbital plane inclination depends on 
this parameter but also on the launching site latitude. For example, an 
Equatorial orbit can only be achieved by launching the spacecraft from the 
Equator or by using an orbital plane change maneuver. On the other hand 
a Polar orbit can be achieved from any point in the Earth surface. 

 
 
 
 
 
 
 
 
 

• Press the            buttons at the Stages panel to add or remove stages and 
define the desired number of stages. Make sure that the check box on the 
left of the Stage label is checked. For this type of trajectory, the last stage 
will be used as an injection stage. 

 

• Select the propellant or stage type in the Type text box at the Stages 
panel for every stage by pressing the       button on the right side. Note 
that, if a parking orbit is needed, the stage engine used for the last stage 
before the injection stage must use a linear thrust curve. This is because 
the stage engine must be stopped and restarted during the parking orbit 
maneuver. 

 

• Enter the stage mass percentage in the Mass text box for every stage on 
the left side of the Stages panel, except for the injection stage that will be 
defined later. This parameter is useful to scale all the stages when the 
total mass is adjusted to achieve the desired orbital speed and altitude. 
Usually, 90% - 10% for a 2 stages launcher and 80% - 15% - 5% for a 3 
stages launcher are good mass distributions. Depending on the payload 
mass and the type of propellant used in every stage, this parameter 
should be re-adjusted to obtain a better performance. 

 

• Enter the injection stage mass in the Mass text box for the last stage on 
the left side of the Stages panel. This stage will be used to accelerate the 
spacecraft to the orbital speed when the desired orbital altitude is reached. 
Define the stage parameters like the rest of the stages except for the 
stage Mass that must be fixed. Usually, this value can be from about 1.5 
times the payload mass for a high performance propellant like LO2 / LH2, 
to about 30 times the payload mass for a low performance propellant like 
APCP. In this example, a high dry mass ratio will be used because the 
stage is very small and lower dry mass ratios would be difficult to achieve. 

 

• Enter the payload mass in the Payload text box at the Stages panel. 
 

• The next step is to define the Launch trajectory arc adjusting the 
parameters: Full Mass, Start angle, last stage and injection stage Delay 
and injection stage Dry mass, located at the Setup and Stages panels. In 
this way, the payload will be deployed at the orbital altitude, at the exact 
orbital speed and with a null vertical speed.  

 

• The process of adjusting the trajectory can be done automatically by the 
simulator by pressing the Calculate button in the Trajectory editor. This 
process can take several minutes, depending on the CPU power of the 
computer used. To cancel the process at any time, press the Escape key, 
the Stop button or the     button in the popup message. The algorithm 
works well for orbital altitudes above 500 km. If the selected altitude is 
below this point, the design parameters of the stages are incorrect or the 
performance of the propellant is too low, the algorithm will fail and these 
parameters must be corrected. 

 

• In the case that the automatic algorithm can not adjust the trajectory, the 
process can be done by hand by following the next steps: 

 

• In this example, the first step will be to design a parking orbit that will be 
used later to adjust the position of the satellite in the geostationary orbit. 
This step is optional for other types of orbits, but it is still recommended to 
use it to design an efficient trajectory. 

 

• To reach the parking orbit altitude and the orbital speed, the total mass of 
the launcher must be adjusted. Enter this value in the Mass text box 
located at the top of the Stages panel. Depending on the orbital altitude, 
this value can be from about 10 to 100 times the payload mass for a high 
performance propellant like LO2 / LH2, to about 1,000 to 15,000 times the 
payload mass for a low performance propellant like APCP. If a parking 
orbit is needed, liquid propellant should be used for the last stage before 
the injection stage, so the engine thrust can be adjusted. In this example, 

a mixed combination of APCP and N2O4 / MMH propellants are used, so 
the total mass of the launcher is about 3,000 times the payload mass. 

 

• Clear the Delay text box for the first stage in the Stages panel and set a 
standard inter-stage delay of 3 seconds for the rest of the stages. 

 

• Press the Events control       button in the Toolbar and select the Pause 
check box for the Stage abort event. Make sure that all the rest of the 
Pause options are disabled. Enter the number of the last stage before the 
injection stage in the Abort text box at the Stages panel. In this example, 
2 stages are used before the injection stage, so the number will be 2. 

 

• Press the Play            button in the Toolbar to start the simulation and test 
the trajectory. When the stage abort event is triggered, the simulation will 
pause. The next step is to reach the required orbital speed. The current 
orbital speed is shown inside the Data panel at the Orbit row as a 
percentage on the right side of the panel. If the orbital speed is below 
100%, the total mass of the spacecraft must be increased. If it is above, 
the total mass must be decreased. Adjust this parameter, press the Reset 
simulation      button in the Toolbar and repeat this step until an orbital 
speed of 100% is reached. Press the       button in the Toolbar to speed up 
all this process. 

 

• When the orbital speed is reached, the spacecraft trajectory must be 
adjusted for a short Earth parking orbit. This orbit will be useful later to 
adjust the position of the satellite in the orbit. In this example, an orbit of 
150 km altitude is used because the delta-V loss due to the atmosphere 
drag of one orbit at this altitude is less than 1 m/s. First, enter the parking 
orbit altitude in the End at text box at the bottom of the Setup panel. Then, 
activate the Pause check box for the Earth orbital speed event in the 
Options panel. Restart the simulation and when the orbital speed is 
reached or the stage abort event is triggered, the simulation will pause. 

 

• If the spacecraft is above or below the parking orbit altitude of 150 km, the 
trajectory angle must be adjusted. The current altitude is shown near the 
spacecraft icon or inside the Data panel at the Altitude E row. If the 
spacecraft is below the orbital altitude, increase the Start angle in the 
Setup panel. If it is above the orbital altitude, decrease the angle. Repeat 
the simulation until an altitude of 150 km at orbital speed is reached. 

 

• Normally, at this point the spacecraft orbit will be eccentric. The next step 
is to convert it to a circular orbit. To achieve this, the vertical speed of the 
spacecraft must be null at burn out. The current vertical speed is shown in 
the Data panel at the Speed V row. If the vertical speed is positive, the 
inter-stage delay for the last stage before the injection stage must be 
increased. If it is negative, the delay must be decreased. When the delay 
is changed, the altitude at orbital speed also changes. Re-adjust the 
trajectory angle to compensate the altitude deviation. Adjust the parameter 
and repeat the simulation until the vertical speed at orbital speed is slightly 
above zero and the required parking orbit altitude is reached. 

 

• Once the trajectory is adjusted for the parking orbit, the total mass must be 
re-adjusted to reach the desired orbital altitude. Before adjusting this 
parameter, deactivate the Pause check box for the Stage abort and the 
Earth orbital speed events in the Options panel and activate the Apogee 
event. In this example, the orbital period will be 23 hours and 56 minutes 
that corresponds to an orbital altitude of 35,786 km. These two parameters 
can be calculated from each other using the following equation, where T is 
the orbital period in seconds, a is the semi-major axis of the orbit in meters 
and µ is the standard gravitational parameter: 

 

 
 
 

• Restart the simulation and when the spacecraft reaches the apogee it will 
pause. If the vertical speed adjusted in the previous step was negative, an 
apogee event can occur before the last stage burn out. Continue the 
simulation until the last stage burns out. When the apogee is reached after 
the burn out, if the spacecraft is above or below the desired orbital altitude, 
the total mass must be adjusted. If the spacecraft is below the desired 
orbital altitude, increase the total mass in the Setup panel. If it is above the 
orbital altitude, decrease the total mass. Repeat the simulation until an 
altitude of 35,786 km is reached at the trajectory apogee. 

 

• When the orbital altitude is reached, depending on the correction made for 
the total mass, the altitude and vertical speed at orbital speed in the 
parking orbit could be slightly changed. To check this, activate the Pause 
check box for the Earth orbital speed event in the Options panel and 
deactivate the Apogee event. Run the simulation and check the altitude 
and vertical speed at orbital speed. If the parameters are not correct, re-
adjust the last stage delay to compensate the vertical speed deviation and 
the trajectory angle to compensate the altitude. Repeat the simulation until 
the vertical speed at orbital speed is slightly above zero and the required 
orbital altitudes at the parking orbit and at the trajectory apogee are 
reached. 

 

• The last step is to adjust the inter-stage Delay and the Dry mass of the 
injection stage to reach to the orbital speed at the trajectory apogee with a 
null vertical speed. The required delay will be approximately the time 
elapsed between the last stage burn out and the apogee event. Look in 
the Log panel for the time stamp of the last Stage engines off and the 
Apogee events and calculate the time elapsed between them. Enter this 
value in the Delay text box of the injection stage. Then, clear the Abort 
text box in the Stages panel, deactivate the Pause check box for the 
Stage abort, Earth orbital speed and Apogee events in the Options 
panel and activate the Last stage engines off event. 

 

• Restart the simulation and when the injection stage burns out it will pause. 
If the vertical speed is positive, the inter-stage delay for the injection stage 
must be increased. If it is negative, the delay must be decreased. Also, if 
the orbital speed is below 100%, the dry mass of the injection stage must 
be decreased. If it is above, the dry mass must be increased. Repeat the 
simulation until the orbital speed is reached with a null vertical speed. 

 

• Finally, use the Earth park delay in the Setup panel to adjust the position 
of the satellite in the orbit. This is useful in the geostationary orbit used in 
this example because the satellite is located at a fixed position in the sky. 
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 TUTORIALS Moon landing mission 

This is the procedure to design a mission that deploys a rover on the Moon 
surface using an Earth parking orbit and a direct landing trajectory. The 
parameters of the “Moon” preset are shown as an example: 
 

• Define the basic parameters for the mission: 
 

 • Launching site coordinates:  Tenerife: 28.2ºN, 16.6ºW 
 • Launching date and time:  2007-06-26, 12:09:00 UTC 
 • Total mission time:   2.5 days 
 • Parking orbit altitude:   150 km 
 • Initial heading:   87.2º 
 • Number of stages and propellant used: 2 stages, APCP & N2O4/MMH 
 • Hover mass and propellant used: 9.5 kg, N2O4/MMH 
 • Payload mass:   500 g 
 

• Press the Preset      button in the Toolbar and select “Moon” to reset all 
the mission parameters to a Moon mission defaults. At any time press the 
Reset simulation      button in the Toolbar to apply the changes for the 
initial parameters in the simulation. In the Log panel a mission briefing will 
be shown with basic parameters like stages 
mass or initial speed. 

 

• Enter the launching site latitude and 
longitude in the Lat and Lon text boxes at 
the Setup panel. Also, enter the initial 
altitude in the Alt text box or leave it blank to 
specify a ground level. 

 

• Enter the launching date and time in the Time text boxes located at the 
top of the Setup panel. Note that for the type of trajectory used in this 
example, the launching time must be adjusted later, so the spacecraft 
trajectory intercepts the Moon. Usually, there will be two moments in the 
day where this condition will be true. To avoid this, the initial heading could 
be adjusted instead, but at the cost of performance. 

 

• Press the     button in the Setup panel to show the 
Trajectory editor and select the Moon mission mode. 
Enter the desired total mission time in the Mission 
time text box and the parking orbit altitude in the 
Orbit text box. 

 

• Enter the initial trajectory heading in the Heading 
text box at the Setup panel. Best performance is 
achieved using 90º heading to use all the initial Earth 
rotation speed. The resulting orbital plane inclination depends on this 
parameter but also on the launching site latitude. The orbital plane along 
with the launching date and time are very important for this type of mission 
because the spacecraft orbital plane and the Moon orbital plane must 
intersect at the point where the Moon will be located at the end of the 
trajectory. Also, note that the Moon orbital plane inclination is never 
beyond 28º of latitude and it also rotates around the Earth through the 
years. Therefore, for some locations under 28ºN or above 28ºS latitude, 
both orbital planes sometimes will be almost parallel and it will be difficult 
to find a point where they intersect. In this case, choose another launching 
date or change the initial heading. 

 
 
 
 
 
 
 
 

• Press the            buttons at the Stages panel to add or remove stages and 
define the desired number of stages. Make sure that the check box on the 
left of the Stage label is checked. 

 

• Select the propellant or stage type in the Type text box at the Stages 
panel for every stage by pressing the      button on the right side. Note that 
the stage engine used for the last stage must use a linear thrust curve. 
This is because the stage engine must be stopped and restarted during 
the parking orbit maneuver. 

 

• Enter the stage mass percentage in the Mass text box for every stage on 
the left side of the Stages panel. This parameter is useful to scale all the 
stages when the total mass is adjusted to achieve the required escape 
speed. Usually, 90% - 10% for a 2 stages launcher and 80% - 15% - 5% 
for a 3 stages launcher are good mass distributions. Depending on the 
hover and payload mass and the type of propellant used in every stage, 
this parameter should be re-adjusted to obtain a better performance. 

 

• Activate the check box on the left of the Hover label to define the lander 
stage. This stage is used to decelerate the spacecraft when it approaches 
the Moon surface at the altitude specified in the Brake text box at the 
extended parameters of the Setup panel. The later the brake the better the 
stage performance. Define the stage parameters like the rest of the stages 
except for the stage Mass that must be fixed. Usually, this value can be 
from about 1.5 times the payload mass for a high performance propellant 
like LO2 / LH2, to about 30 times the payload mass for a low performance 
propellant like APCP. In this example, N2O4/MMH propellant is used and 
the dry mass of the stage is increased to 20% to include the mass of all 
the devices used for navigation, braking altitude detection and attitude 
control. The mass is about 20 times the payload mass. Also, the stage 
engine must use a linear thrust curve because the engine thrust must be 
adjusted during the braking maneuver. 

 

• Enter the payload mass in the Payload text box at the Stages panel. 
 

• The next step is to define the Launch trajectory arc adjusting the 
parameters: Full Mass, Start angle, last stage Delay, Earth park delay 
and launching Time, located at the Setup and Stages panels. In this way, 
the payload will be deployed at the Moon surface safely. In this example, a 
low Earth parking orbit of 150 km of altitude is used so the trajectory can 
be adjusted for almost every location in Earth and every date and time. A 

more efficient trajectory without parking orbit could be used but then the 
launching location, date and time options will be reduced to a small range 
and the mission design will be more complex. 

 

• The process of adjusting the trajectory can be done automatically by the 
simulator by pressing the Calculate button in the Trajectory editor. This 
process can take several minutes, depending on the CPU power of the 
computer used. To cancel the process at any time, press the Escape key, 
the Stop button or the     button in the popup message. The algorithm 
works well for locations above 28ºN or under 28ºS latitude. If the selected 
latitude is in the range of 28ºS to 28ºN, the algorithm could fail to reach the 
Moon. This can be corrected by adjusting the initial heading or the 
launching date, as described in the previous steps. Also, if the design 
parameters of the stages are incorrect or the performance of the 
propellant is too low, the algorithm will fail and these parameters must be 
corrected. 

 

• In the case that the automatic algorithm can not adjust the trajectory, the 
process can be done by hand by following the next steps: 

 

• To reach the parking orbit altitude and the escape speed, the total mass of 
the launcher must be adjusted. Enter this value in the Mass text box 
located at the top of the Stages panel. Usually, this value can be from 
about 100 times the payload mass for a high performance propellant like 
LO2 / LH2, to about 15,000 times the payload mass for a low performance 
propellant like APCP. For this type of mission, liquid propellants should be 
used for the last stage and the hover stage so the engine thrust can be 
adjusted. In this example, a mixed combination of APCP and N2O4 / MMH 
propellants are used, so the total mass of the launcher is about 3,000 
times the payload mass. 

 

• Clear the Delay text box for the first stage in the Stages panel and set a 
standard inter-stage delay of 3 seconds for the rest of the stages. 

 

• Press the Events control       button in the Toolbar and select the Pause 
check box for the Last stage engines off event. Make sure that all the 
rest of the Pause options are disabled. 

 

• Press the Play            button in the Toolbar to start the simulation and test 
the trajectory. When the burn out event is triggered, the simulation will 
pause. The next step is to reach the required escape speed. The current 
escape speed is shown inside the Data panel at the Escape row as a 
percentage on the right side of the panel. If the escape speed is below 
100%, the total mass of the spacecraft must be increased. If it is above, 
the total mass must be decreased. Adjust this parameter, press the Reset 
simulation      button in the Toolbar and repeat this step until an escape 
speed of 100% is reached. Press the       button in the Toolbar to speed up 
all this process. 

 

• When the escape speed is reached, the spacecraft trajectory must be 
adjusted for a short Earth parking orbit. This orbit will be useful later to 
adjust the trajectory and reach the Moon. In this example, an orbit of 150 
km altitude is used because the delta-V loss due to the atmosphere drag 
of one orbit at this altitude is less than 1 m/s. First, enter the parking orbit 
altitude in the End at text box at the bottom of the Setup panel. Then, 
activate the Pause check box for the Earth orbital speed event in the 
Options panel. Restart the simulation and when the orbital speed is 
reached, the simulation will pause. 

 

• If the spacecraft is above or below the parking orbit altitude of 150 km, the 
trajectory angle must be adjusted. The current altitude is shown near the 
spacecraft icon or inside the Data panel at the Altitude E row. If the 
spacecraft is below the orbital altitude, increase the Start angle in the 
Setup panel. If it is above the orbital altitude, decrease the angle. Repeat 
the simulation until an altitude of 150 km at orbital speed is reached. 

 

• Normally, at this point the spacecraft orbit will be eccentric. The next step 
is to convert it to a circular orbit. To achieve this, the vertical speed of the 
spacecraft must be null at burn out. The current vertical speed is shown in 
the Data panel at the Speed V row. If the vertical speed is positive, the 
inter-stage delay for the last stage must be increased. If it is negative, the 
delay must be decreased. When the delay is changed, the altitude at 
orbital speed also changes. Re-adjust the trajectory angle to compensate 
the altitude deviation. Adjust the parameter and repeat the simulation until 
the vertical speed at burn out is close to zero and the required orbital 
altitude is reached. 

 

• When the trajectory is adjusted for the parking orbit, also the burn out 
speed will change so the total mass must be re-adjusted to compensate 
the speed gain or loss. This time, the required escape speed will be 
99.66% instead of 100% because this is the required speed to reach the 
Moon distance from Earth in about 2.5 days. For a mission time of 1.5 
days, the escape speed will be 101.75%. The maximum mission time 
possible is about 5 days and is achieved using an escape speed of 
99.19%. To reach the required escape speed, deactivate the Pause check 
box for the Earth orbital speed event in the Options panel and make sure 
that the Last stage engines off event is still active. Repeat the simulation 
until an escape speed of 99.66% is reached. 

 

• When the escape speed is reached, depending on the correction made for 
the burn out speed, the altitude and vertical speed at orbital speed could 
be slightly changed. To check this, activate again the Pause check box for 
the Earth orbital speed event in the Options panel. Run the simulation 
and check the altitude and vertical speed at orbital speed. If the 
parameters are not correct, re-adjust the last stage delay to compensate 
the vertical speed deviation and the trajectory angle to compensate the 
altitude. Repeat the simulation until the vertical speed at orbital speed is 
close to zero and the required orbital altitude and escape speed are 
reached. 

 

• At this point, the spacecraft trajectory will be good enough to reach the 
Moon distance in the required mission time. But in most cases, the 
spacecraft will not intercept the Moon. To check the trajectory, deactivate 
the Pause check box for the Earth orbital speed and Last stage 
engines off events and activate the Moon distance event in the Options 
panel. Also, press the Follow      button and select Ship to align the 
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camera with the Moon orbital plane and zoom out until you see the entire 
scene. Then, run the simulation to see the direction of the spacecraft 
trajectory. 

 

• To intercept the Moon with the type of trajectory used in this example, two 
more parameters must be adjusted: the Earth park delay and the 
launching Time. To help with this process, press the Tools       button and 
activate the Orbital plane tool. This tool will show the spacecraft orbital 
plane as two yellow circles projected over the Earth surface and at the 
Moon distance. Also, activate the Planets position check box on the right 
side of the Trajectory tool. This tool shows the position of the planets at 
the end of the Mission time specified in the Trajectory editor. The “Moon 
Park High” preset is shown as an example: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Usually, the spacecraft orbital plane and the Moon orbital plane will 

intersect at two points, as seen in the picture. But in some cases, if the 
latitude of the launching site is in the range of 28ºS to 28ºN, the two orbital 
planes could be almost parallel, making difficult or impossible to find or 
adjust the intersection points. This can be corrected by adjusting the initial 
heading or the launching date, as described in the previous steps. 

 

• Using the parking orbit that was adjusted before, the spacecraft trajectory 
can be directed to any of the two intersection points. By adjusting the 
Earth park delay, the trajectory will be rotated around the spacecraft 
orbital plane axis. Also, by adjusting the launching Time, the trajectory and 
the spacecraft orbital plane will be rotated around the Earth rotation axis 
so the intersection points can be adjusted to the desired position. These 
two parameters must be adjusted so the spacecraft orbital plane and the 
Moon orbital plane intersect at the point where the Moon will be located at 
the end of the trajectory. If the Planets position tool is activated, this point 
will be shown as Moon’ in the 3D viewer. In this example, a mission time 
of 2.5 days is used. So in the time that the spacecraft reaches the Moon, it 
will rotate around the Earth about 33º. This rotation will be about 20º for a 
mission of 1.5 days and about 65º for a slow mission of 5 days. 

 

• Press the Reset simulation       button in the Toolbar. Then, click and 
drag up or down the      button near the launching Time text box in the 
Setup panel, to adjust the launching Time. Also, you can double click on it 
to select the current real date and time. The Earth will rotate around its 
axis and also, the launching site and the spacecraft orbital plane will rotate 
too so the intersection points can be adjusted. Adjust the launching Time 
until any of the two intersection points coincides with the Moon’ point. 

 

• The next step is to adjust the Earth park delay in text box located at the 
extended parameters of the Setup panel, so the spacecraft trajectory 
points to the selected intersection point. In this example, a 150 km parking 
orbit has been selected. The time needed to complete an orbit at this 
altitude is 87.5 minutes. To rotate the trajectory 1 degree, the Earth park 
delay must be increased 0.243 minutes. This value must be equal or 
greater than “0m” and lower than “87.5m”. If the required value gets out of 
this range, subtract or add 87.5 to the value to make it fit into this range. In 
any text box using time units, the value can be entered as seconds, 
minutes, hours or days. Just add a “s”, “m”, “h” or “d” at the end of the 
number. Run the simulation to see the direction of the spacecraft trajectory 
and adjust the Earth park delay until the final position of the spacecraft is 
aligned with the Moon orbital plane and reaches the Moon’ point. Note 
that, when the spacecraft is near to the Moon, its gravity will change the 
shape of the final part of the spacecraft trajectory and it will be moved 
away from the spacecraft orbital plane. To correct this, adjust the 
launching Time as described in the previous step. 

 

• Repeat the last two steps until the spacecraft touches the surface of the 
Moon at the required coordinates. These coordinates are shown in the 
Data panel at the Lat Lon row. 

 

• If the Hover stage performance is not good enough or the Brake altitude 
is set too low, the spacecraft will crash on the Moon surface. The 
remaining propellant for the current stage is shown as a percentage in the 
Data panel at the right side of the Mass row. If this value is equal to 0%, it 
means that the Hover engine performance is too low. Increase its 
performance and repeat all the process from the beginning if the Hover 
mass is changed. If the remaining propellant is greater than 0%, it means 
that the Brake altitude is too low. Increase the Brake altitude in the Setup 
panel or the Hover engine thrust in the Stages panel and repeat the 
simulation. 

 

 TUTORIALS Balloon trajectory 

This is the procedure to calculate the trajectory for a balloon that will launch 
the spacecraft from a high altitude. The parameters of the balloon and the 
parachute must be specified before the trajectory can be calculated. A typical 
mission for a small payload of 4 kg mass is used as an example: 
 

• Define the basic parameters for the balloon trajectory: 
 

 • Launching site coordinates:  Tenerife: 28.2ºN, 16.6ºW 
 • Launching date and time:  2007-06-26, 12:09:00 UTC 
 • Balloon burst altitude:   32 km 
 • Balloon ascent rate:   5 m/s 
 • Balloon weight:   1.6 kg 
 • Parachute terminal velocity:  5 m/s 
 • Payload mass:   4 kg 
 

• The size and weight of the balloon will be determined by the required 
payload mass. For every type of balloon, the manufacturer will give the 
specific parameters for a given payload mass. The following table can be 
used to determine these parameters: 

 
Balloon 
Weight 

Burst 
Altitude 

Ascent 
Rate 

Payload 
Mass 

10 g 8,000 m 1.5 m/s 25 g 

30 g 11,000 m 2.0 m/s 75 g 

50 g 13,000 m 3.0 m/s 125 g 
100 g 16,000 m 4.0 m/s 250 g 

200 g 18,000 m 5.0 m/s 500 g 

300 g 19,000 m 5.0 m/s 750 g 
350 g 21,000 m 5.0 m/s 875 g 

400 g 23,000 m 5.0 m/s 1,000 g 
500 g 27,000 m 5.0 m/s 1,250 g 

600 g 28,000 m 5.0 m/s 1,500 g 

750 g 29,000 m 5.0 m/s 1,875 g 
800 g 30,000 m 5.0 m/s 2,000 g 

950 g 31,000 m 5.0 m/s 2,375 g 

1,000 g 32,000 m 5.0 m/s 2,500 g 
1,200 g 33,000 m 5.0 m/s 3,000 g 

1,500 g 35,000 m 5.0 m/s 3,750 g 

1,600 g 36,000 m 5.0 m/s 4,000 g 
2,000 g 38,000 m 5.0 m/s 5,000 g 

 
• Enter the launching date and time in the 

Time text boxes located at the top of the 
Setup panel. Also, enter the launching site 
latitude and longitude in the Lat and Lon 
text boxes and the initial altitude in the Alt 
text box or leave it blank to specify a ground 
level. 

 

• If a KML path was already loaded or calculated, press the Path       button 
in the Toolbar and select Clear KML paths to delete it. Then, press the 
Reset simulation     button to apply the changes to the launching site 
parameters. Also, press the Follow        button and select Tactic to have a 
better view of the launching site. 

 

• Press the      button in the Setup panel to show the 
Trajectory editor and select the Balloon trajectory 
mode. Enter the balloon burst altitude in the Burst 
text box. If no burst altitude is specified, a 32,000 
meters altitude will be used as default. Enter “0” to 
indicate that there is no burst. Also, enter the balloon 
ascent rate in the Ascent text box. If no ascent rate 
is specified, a 5 m/s rate will be used as default. 

 

• The last parameter needed for the trajectory prediction is the terminal 
velocity at sea level when the balloon explodes at the burst altitude and 
falls down. Enter this parameter in the Descent text box. This parameter is 
determined mainly by the size of the parachute used and the mass of the 
balloon and the payload. The terminal velocity of any object that is not 
designed to slow down the falling speed is about 50 to 70 m/s. But the 
balloon itself can slow down the speed up to 25 m/s after it bursts. If no 
terminal velocity is specified, a 5 m/s velocity will be used as default. The 
following table can be used to calculate the terminal velocity at sea level 
using the payload mass and the parachute diameter: 

 
Parachute 
Payload 

0.5 m 0.75 m 1.0 m 1.5 m 2.0 m 

100 g 2.9 m/s 1.9 m/s 1.4 m/s 1.0 m/s 0.7 m/s 
200 g 4.0 m/s 2.7 m/s 2.0 m/s 1.3 m/s 1.0 m/s 
500 g 6.4 m/s 4.3 m/s 3.2 m/s 2.1 m/s 1.6 m/s 
750 g 7.8 m/s 5.2 m/s 3.9 m/s 2.6 m/s 2.0 m/s 

1,000 g 9.0 m/s 6.0 m/s 4.5 m/s 3.0 m/s 2.3 m/s 
1,500 g 11.1 m/s 7.4 m/s 5.5 m/s 3.7 m/s 2.8 m/s 
2,000 g 12.8 m/s 8.5 m/s 6.4 m/s 4.3 m/s 3.2 m/s 
3,000 g 15.6 m/s 10.4 m/s 7.8 m/s 5.2 m/s 3.9 m/s 
4,000 g 18.1 m/s 12.0 m/s 9.0 m/s 6.0 m/s 4.5 m/s 
5,000 g 20.2 m/s 13.5 m/s 10.1 m/s 6.7 m/s 5.0 m/s 

 
• The algorithm for the balloon trajectory prediction uses an atmospheric 

model to determine the parameters of the atmosphere at every point of the 
trajectory. These parameters change constantly every day so they should 
be updated as frequently as possible. The atmospheric model can also 
calculate the weather forecast up to 8 days in the future with a 3 hours 
step. To update the model, press the Path      button and select the 
Update atmosphere option. The file of the model for the selected date and 
time will be downloaded from the server. If a file for the same date and 
time was downloaded before, a dialog box will prompt for overwriting the 
file. Do this only if the file was downloaded using the forecast feature. In 
this way, the old file can be replaced with a better forecast for the model. 

Moon initial position 

Moon final position 
Earth 
rotation axis 

Intersection points 

Spacecraft 
orbital plane 

Moon 
orbital plane 

Spacecraft trajectory 

Earth position 
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• In a balloon trajectory there are two elements that are very important: the 
wind speed at the ground level and the wind speed and direction at the 
upper layers of the atmosphere. The Atmosphere tool is useful to measure 
the wind speed at any atmosphere layer. Press the Tools       button and 
select the Atmosphere check box. Then, press the Options tab and 
activate the Wind speed layer or the Wind speed vectors options. The 
layer can be selected with the Atmosphere layer option. The wind speed at 
the ground level is shown in the picture as colored vectors in the small 
window and the wind speed at the 250 millibar atmosphere layer is shown 
in the main window. The colors of the vectors indicate the speed of the 
wind: white and green for a low speed wind, yellow for a medium speed 
wind and red, magenta and blue for a high speed wind. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• A high altitude balloon is designed to minimize its weight and this makes it 
very fragile. Medium or high wind speeds of more than 10 m/s, can make 
the balloon explode before it can be released. Also, the wind at upper 
layers of the atmosphere is important to determine the direction and the 
distance of the balloon trajectory. Usually, the winds with higher speeds 
are located at an altitude of about 10 km in the 250 millibar atmosphere 
layer. In this layer, high speed winds called jet streams, with a speed of 
more than 50 m/s, can make the balloon travel long distances in a short 
period of time. To minimize this effect, the balloon ascent rate must be 
higher than 5 m/s and the descent rate must not be lower than 5 m/s. This 
will reduce the time that the balloon is exposed to high speed winds. This 
video is an example of a balloon traveling 700 km due to jet streams: 
http://www.youtube.com/watch?v=wx5e9T5cAuA 

 

• Finally, press the Calculate button in the Trajectory editor to calculate the 
trajectory. The path will be shown in the 3D viewer and the launching point 
of the current preset will be set at the balloon burst point. The trajectory 
will be also saved as a KML file with the same name as the current preset. 
Press F4 to show the Graph panel and see detailed information about all 
the parameters in the trajectory. These parameters can be saved in a CSV 
format file using the context menu of the panel. 

 

 TUTORIALS Onboard sensor 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the procedure to install a sensor onboard the satellite. This sensor will 
follow a ground station or a planet if the Tools→Stations tool is activated and 
the proper group of stations is chosen in Options→Station network option. 
This option can be seen by selecting the Onboard sensor option in the 
Panels sub-menu and selecting the proper sensor in Options→Sensor 
option: 
 

• Add your sensor in the “Sensors.lst” file in the Sensors folder. Each 
line contains comma separated parameters like: Trade mark and 
model, Lens type [inches], Horizontal FOV [degrees], Width [pixels], 
Height [pixels], Zoom, Web link 

 

• Add your group of ground stations or target points in the 
“Stations.cvs” file inside the Stations folder. Each line contains 
comma separated parameters like: Group, Point name, Latitude 
[degrees], Longitude [degrees], Altitude [meters]. 

 

• In this example, select in Options→Station network the group of 
stations called ARAGON. 

 

• Activate the Tools→Stations tool. 
 

• In this example, select in Options→Sensor the TOSHIBA 
TCM8230MD camera sensor. 

 

• Activate the Onboard sensor option in Panels sub-menu. 
 

• In order to hide the labels, unselect the Tools→Sensor→Labels tool. 
 

Every sensor comes with a default lens specified in the “Sensors.lst” file, but 
this lens can be replaced by one of the lenses listed in the “Lenses.lst” file 
inside the Sensors folder. This file contains comma separated parameters 
like: Trade mark and model, Lens type [inches], Focal length [millimeters], 
FNO (Brightness), Horizontal FOV [degrees], Vertical FOV [degrees], Web 
link. To replace the sensor lens, select it in the Options→Lens option. Be 
aware that only lenses that match the sensor lens type can be used for that 
sensor. 
 

Notice that this is a realistic simulation of the sensor view and the size of the 
window can not be changed. The texture quality can improve the sensor 
accuracy up to a limit. For best performance, the 3D terrain model can be 
activated in Tools→Terrain. For every ground station in range, the distance 
to the station and the elevation angle will be shown near the station label. 
Also, the field of view of the sensor and the ground projection will be shown 
in the main 3D viewer. The sensor window in Follow mode→Onboard will 
show information about the sensor resolution at the bottom of the view if both 
Tools→Sensor→FOV projection and Tools→Sensor→Labels options are 
activated. This information shows the covered area size and the pixel size (in 
meters per pixel or feet per pixel) of this particular sensor projection at the 
distance over any surface in the planet. This tool is useful to know the picture 
resolution of each pixel when a satellite is mapping the surface of a planet. 
All these elements can be deactivated with the Tools→Sensor option so that 
the image is as close as possible to the sensor view. 
 

An example of a sensor based on a 1.3 Mpix camera for the “Sensors.lst” file: 
 

TOSHIBA TCM8230MD,0.1666667,57.4,660,492,1, 
http://www.sparkfun.com/datasheets/Sensors/Imaging/TCM823
0MD.pdf 
 

An example of a ground station located at Zaragoza (Spain) for the 
“Stations.csv” file: 
 

ARAGON,Zaragoza,41.65,-0.883333,263 
 

A predefined list of ground stations can be defined in the Setup panel so the 
attitude control of the satellite can use them as targets. It is sorted by priority, 
where the first ground stations have higher priority over the last ones. In this 
way, when more than one ground station become available, the satellite will 
point to the one that has the highest priority. This list will be saved with the 
current preset. 
 

To define a target list, press the      button in the Setup panel to show the 
extended mission parameters and the      button to activate the target list. 
The Search panel will be shown. In this panel the ground stations can be 
searched by typing in the text box any word that matches the name of the 
ground stations or the name of their group. In this example, type “wikisat” to 
show all the ground stations of this group in the list. Select all the items in this 
list by using the context menu and selecting the Select all option. In the 
Setup panel, press the      button to add all the selected items to the target 
list. Also, you can drag and drop the items from one list to another. 
 

Next, in the Search panel, type “aragon” to show the ground station 
“Zaragoza” that was defined before and add it to the target list. This item will 
be placed in the last position of the list, but it must have the highest priority. 
To do this, select it in the target list and press the      button to move it to the 
first position in the list. Finally, type “nasa dsn” in the Search panel to show 
all the ground stations of this group and add them to the target list. 
 

There is a video available in http://www.youtube.com/watch?v=yybJAlJhym4 
 

 TUTORIALS Attitude control 

Attitude control is simulated during each stage burn to control the trajectory 
and in flight when the satellite is deployed to follow any ground station on the 
ground. The default software algorithm includes a PID module to simplify the 
design related to the attitude control subsystem. The PID module simulates 
the actual attitude control system on board the launcher. This allows tune up 
the control system to obtain an optimum control, and determine how attitude 
changes affect the final trajectory. A different PID controller can be defined 
for each stage. The control parameters are the control force and the PID 
gains, which can be adjusted in the stage parameters panel, accessed from 
the Stages panel by clicking the lower right arrow       button. Then the stage 
is selected by clicking over the desired one in the Stages panel. 
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X 
Z 
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The control force is unlimited by default, but a thrust limit can be imposed to 
simulate the system constraints. Also a magnetorquer based system can be 
simulated for the satellite control. The PID has three gains: proportional, 
integral and derivative. An increase in the proportional gain reduces the 
overshot and the settling time (stabilization time). The integral gain 
accelerates the speed of the response and reduces the number of 
oscillations. The derivative gain reduces the overshot but also the response 
velocity. Too high or low values of any gain can destabilize the system or 
produce undesired responses. 
 

For example, in the LEO N-Prize Balloon preset, if the initial launch angle is 
set to 90º and the start and final angles to 30º, it requires from the control 
system a fast change of 60º in the attitude angle. Setting all the gains to 1, 
the initial overshot is about 8º, and the oscillations are very slowly damped. If 
the gains are set to 2, 5 and 1 respectively, the overshot is reduced to 4º, 
only two oscillations are performed and the launcher is stabilized at the 
correct angle in only 25 seconds. Attending to the control force, if it is limited 
to 10 mN, and the previous simulation is repeated, the overshot grows to 24º, 
and the launcher reach its final attitude angle in 31 seconds after two 
oscillations. Finally, if the control algorithm is disabled with the option 
Simulation→Trajectory control, the ideal trajectory can be calculated and 
compared with the real trajectories to determine which is closest to the ideal. 
 

If the previous simulations are repeated with the end angle set to 0º, in no 
case the satellite is finally injected into orbit, but it can be seen how the 
trajectory is very dependent on the design of the control system as the 
apogee achieved are 463.3 km, 436.1 km and 255.2 km respectively. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Deviation and Trace are two visual tools available for the satellite control 
optimization. Deviation are two yellow lines over a blue background located 
at the upper and left sides of the sensor window. It shows graphically the 
relative angle between where the satellite is pointing and the point it should 
track, like a ground station, a planet, a star or the center of the Earth. The 
longitudinal and lateral deviation allow see the satellite’s oscillations and 
responses in both X and Y axes to tune up the attitude control system 
accordingly. Trace are two yellow lines located at the right and bottom sides 
of the window. It works in the same way as Deviation showing the distance in 
the View panel from the point of view to the objective, which is affected by 
the satellite’s roll. One or both of these tools can be activated with the option 
Tools→Sensor→Deviation/Trace. To visualize them, select the option 
Panels→Onboard sensor to show the sensor window. 
 

As an example, in the LEO preset the control limit is set to 0.1 Am², which is 
a typical value for small magnetorquers. Also, the visibility angle for the 
ground stations is set to 0º. After the launch, the satellite starts the 
movement to point to Madrid26 Ground Station at 6 min 14.7 sec. After some 
oscillations the satellite finally points to the ground station at 6 min 40 sec. 
Using the Deviation tool, it is seen that the longitudinal axes stabilizes before 
than the lateral axes. The Trace tool allows determine when the system is 
completely stabilized. In this case the PID gains were as default 2, 5 and 1. If 
they are changed to 3, 5 and 2 respectively, the number of oscillations and 
their amplitude are reduced, and a smaller 
settling time of 6 min 37 sec is achieved. 
 
PID controller basics 
 

The PID controller algorithm involves three separate constant parameters: 
the proportional, the integral and derivative values, denoted P, I, and D. 
These values can be interpreted in terms of time: P depends on the present 
error, I on the accumulation of past errors, and D is a prediction of future 
errors, based on current rate of change. The proportional, integral, and 
derivative terms are summed to calculate the output of the PID controller. 
Defining u(t) as the controller output, the final form of the PID algorithm is: 

 
 
 
 

where the tuning parameters are: 
 
Proportional gain, Kp 
 

Larger values typically mean faster response since the larger the error, the 
larger the proportional term compensation. An excessively large proportional 
gain will lead to process instability and oscillation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Integral gain, Ki 
 

Larger values imply steady state errors are eliminated more quickly. The 
trade-off is larger overshoot: any negative error integrated during transient 
response must be integrated away by positive error before reaching steady 
state. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Derivative gain, Kd 
 

Larger values decrease overshoot, but slow down transient response and 
may lead to instability due to signal noise amplification in the differentiation of 
the error. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Spacecraft coordinate system 
 

These are the spacecraft rotation axes 
used in the simulator for the stages or 
payload design parameters and the 
calculations of the angular velocities and 
accelerations. Pitch corresponds to a 
rotation around X axis, Yaw around Y 
axis and Roll around Z axis. The origin of 
the axes is located at the center of mass 
of the spacecraft. 
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 TUTORIALS Thrust curve calculation 

This is the procedure to calculate the thrust curve of an engine that uses 
solid propellant and generate a custom engine file that will be used later in a 
trajectory simulation. In this example, the parameters of the “KNDX” burn 
preset will be used. This preset defines a small rocket using a low 
performance propellant composed by potassium nitrate and dextrose 
(KNDX). These are the basic parameters of the rocket: 
 

  • Motor casing size: 110 x 62.4 mm (cylinder) 
  • Propellant size: 100 x 60 mm 
  • Propellant core size: 100 x 18 mm 
  • Propellant geometry: Core burner (both ends exposed) 
  • Propellant type: KNDX (65% Potassium Nitrate / 35% Dextrose)  
  • Nozzle throat / exit: 6.8 / 23.5 mm (12:1 expansion ratio) 
  • Maximum pressure: 70 atm 
  • Ambient pressure: 1 atm 
 

Press F7 to show the Propellant editor and select KNDX in the propellant list. 
This propellant uses 2 components: 65% of Potassium Nitrate and 35% of 
Dextrose. 
 
 
 
 
 
 
 
 
 
 
This is a typical mixing ratio of the two components but it can be modified to 
obtain a different propellant performance or combustion temperature. Check 
the mixing ratio and change it if necessary. Then, press the Calc button to 
recalculate the propellant parameters and the      button to save the changes. 
Once the propellant composition is adjusted, click the     button or press 
Ctrl+Shift+F7 to show the Burn editor and calculate the thrust curve. 
 

Press the     button at the top of the 
panel to show the Preset menu and 
select the KNDX burn preset. All the 
parameters of the propellant and the 
engine will be updated. Now select 
KNDX in the Propellant list to update 
the propellant parameters if they were 
modified in the previous step. Note 
that if the propellant is modified again 
in the Propellant editor, the parameters in the Burn editor will be 
automatically updated. All these parameters have an effect on the heat and 
the pressure of the gas that is generated when the propellant burns in the 
combustion chamber. This energy will be converted in thrust when the gas is 
accelerated through the nozzle. See more information about the calculation 
of the solid propellant performance at Richard Nakka’s Experimental 
Rocketry

22
. These are the parameters related to the propellant performance: 

 

• Burn rate: Linear combustion rate of the propellant when it burns. It can 
not be calculated by the chemical simulator and must be obtained by 
empirical methods. This parameter is composed by two elements, a and n 
that define the burn rate as a function of the combustion chamber 
pressure. The a parameter is the burn rate at standard atmosphere 
pressure. The n parameter is optional and represents the exponent in the 
formula: Burn rate = a · Pressure[atm] ^ n. Also, press the     button to 
select a predefined burn rate curve. In this example, the KNDX burn rate 
curve will be used. This curve determines the propellant burn rate as a 
function of the combustion chamber pressure. It is defined in a BRN 
format file located at the Engines folder. This file contains a list of pressure 
ranges in MPa followed by the corresponding a and n parameters used in 
the formula: Burn rate[mm/s] = a · Pressure[MPa] ^ n. 

 

• Mol: Effective molar mass of the propellant components. This is calculated 
by the chemical simulator but can be corrected manually. 

 

• K: Ratio of specific heats of the propellant. The first parameter is related to 
the gas in the combustion chamber and is calculated by the chemical 
simulator. The second parameter is optional and is related to the nozzle 
exhaust gas and the calculation of the thrust. This is only required for a 
two phase flow of the gas in the nozzle. This happens when the exhaust 
gas contains small solid particles that decrease the overall acceleration of 
the gas at the nozzle exit. 

 

• Density: Density of the propellant. This is calculated by the chemical 
simulator but can be adjusted depending on the propellant preparation. 

 

• Temperature: Temperature of the combustion chamber. This is calculated 
by the chemical simulator but can be corrected manually. 

 

The next step will be to define the size of 
the engine and the propellant. All the 
parameters related to the sizes can be 
defined as a percent ratio. In this way, the 
rocket can easily be scaled by changing 
only the total length or the propellant 
length. Basically, a rocket launcher is 
composed of motor casing, propellant, 
combustion chamber and nozzle. When 
solid propellant is used, the motor casing and the combustion chamber are 
usually the same and the propellant is contained in it. In this example, the 
propellant is contained in a cylinder of 110 mm length and 60 mm inner 
diameter that will be used as a combustion chamber. It is recommended to 
leave a small distance between the end of the propellant and the nozzle. This 
area will work as an expansion chamber to absorb small pressure peaks due 

                                                      
22 Richard Nakka's Experimental Rocketry 
http://www.nakka-rocketry.net/techs.html 

to small bubbles in the propellant grain. In this case, the distance will be 10 
mm, so the propellant length is 100 mm. Enter these parameters in the text 
boxes: 
 

• Chamber: Length of the combustion chamber. It can be specified as a 
percent ratio of the propellant length. Also, the volume of the combustion 
chamber can be specified together with the propellant diameter so it can 
be calculated. In this case, 110 mm is defined or 110% can also be used. 

 

• Length: Length of the propellant. It can be specified as a percent ratio of 
the motor chamber length. Also, the volume or the mass of the propellant 
can be specified together with the propellant diameter so it can be 
calculated. In this case, 100 mm length is defined. 

 

• Diameter: Diameter of the propellant. It can be specified as a percent ratio 
of the propellant length. Also, the volume or the mass of the propellant can 
be specified together with the propellant length so it can be calculated. In 
this case, 60 mm is defined or 60% can also be used. 

 

Now the geometry of the propellant must be 
specified. This will determine the way in which the 
propellant is burned. In this example, the Core 
Burner geometry with both propellant ends 
exposed to burning has been selected. This 
geometry produces almost a linear thrust curve 
while maintaining the combustion chamber walls 
protected from heat. It is interesting to know that the configuration with only 
the nozzle end exposed is easier to build. But despite this, it has the problem 
that the propellant is asymmetrically exposed to the pressure and may 
fracture, resulting in a catastrophic explosion. This will also apply to the Star 
Burner geometry. On the other hand, the End Burner geometry does not 
have this asymmetric problem and produces a more linear thrust curve but 
the chamber walls are more exposed to the high temperature of the 
combustion. The propellant core is the part of the propellant that has been 
removed to increase the burning area. In this case, the core is defined as a 
cylinder of 18 mm diameter and the full length of the propellant to expose 
both ends of the propellant to burning. Enter the propellant core sizes and 
geometry in the text boxes: 
 

• Type: Geometry of the propellant core. Core Burner defines the core as a 
cylinder centered in the propellant. The propellant burns from inside until 
the burning reaches the chamber walls. Star Burner is equivalent to Core 
Burner but it adds some fins to the propellant core to increase the burn 
rate. Finally, End Burner is defined by a simple cylinder without any core. 
The propellant burns from the end near the nozzle to the opposite side. 
When this geometry is used, the parameters of the core are not available. 

 

• Segments: Number of segments in which the propellant is divided. This is 
used to increase the exposed area and produce a more linear thrust curve 
but in this example a single segment will be used. 

 

• Exposed: Ends of the propellant that are exposed to burning. This can be 
None, Nozzle end and Both ends. Exposing both ends produces a more 
linear thrust curve. In this case, both ends are exposed. 

 

• Core length: Length of the propellant core. This can be from zero to the 
full length of the propellant and it can be also specified as a percent ratio 
of the propellant length. It must be 100% when multi-segment or both ends 
exposed options are used. In this example, the full length of the propellant 
is used. That is, 100 mm length or 100% can also be specified. 

 

• Core diameter: Diameter of the propellant core. This can be from zero to 
near the diameter of the propellant. Large core diameters produce more 
linear thrust curves but reduce the volume of the combustion chamber 
used by the propellant. In this example, a core of 18 mm diameter is 
specified or 30% of the propellant diameter can also be used. 

 

• Number of fins: Number of fins in the Star Burner geometry. Increasing 
this number will accelerate the propellant burning. Enter a value of 1 to 
simulate a C-Slot geometry. This parameter is not used in this example. 

 

• Fin depth: Length of the fins in the Star Burner geometry. This can be 
from zero to the radius of the propellant. Large values will produce a faster 
burning at the beginning while reducing the burn rate at the end. This 
parameter is not used in this example. 

 

• Fin width: Width of the fins in the Star Burner geometry. Typical values 
range from almost zero to the radius of the propellant core. This parameter 
has a minor effect on the burn rate and it is often defined by the propellant 
mixing procedure. This parameter is not used in this example. 

 

Finally, the parameters of the nozzle will be defined. The nozzle is an 
important part of a rocket because it converts the pressure of the gas in the 
combustion chamber to an acceleration of this gas and finally thrust. The 
shape of the nozzle is a key parameter in the thrust efficiency. The nozzle is 
defined by three parameters: the throat diameter, the exit diameter and the 
length. As described in this article

23
 about nozzle design, a simple shape of a 

cone of 12º internal angle has a good efficiency. Better efficiency can be 
achieved by using a more complex shape, such a Bell 
nozzle. In the simulation, the nozzle length is not used 
because the algorithm does not calculate the complex flow 
of the exhaust gas. But an approximation can be obtained 
when the 12º angle of the cone is applied to the shape. The 
ratio of the throat area to the exit area is called nozzle 
expansion ratio. This parameter is important because it must 
be calculated so that the pressure of the exhaust gas is 
equal to the pressure outside the rocket. If the exit pressure 
is higher, the nozzle is underexpanded and part of the thrust 
is lost. If the exit pressure is lower, the nozzle is 
overexpanded and the exhaust gas flow is unstable so it 
may cause the nozzle to break. To help calculating this ratio, 
the nozzle Exit parameter in the text box can be left blank. In 
this way, the simulator calculates the ideal expansion ratio 

                                                      
23 Rocket engine nozzle 
http://en.wikipedia.org/wiki/Rocket_engine_nozzle 
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at every point on the thrust curve and it can be seen in the thrust graph that 
will be generated later. Also, if the nozzle is highly overexpanded or the 
combustion pressure is very low, it can produce negative thrust. This will be 
shown in the graph as a red background. Note that a nozzle designed to 
work in vacuum will always be underexpanded because it can not expand to 
an infinite size. More information about nozzle design and thrust calculation 
can be found in this NASA web page

24
. The optimal nozzle parameters can 

also be calculated by pressing the        button. In this example, a nozzle of 
6.8 mm throat diameter and 23.5 mm exit diameter will be used. This 
corresponds to a 12:1 expansion ratio. The nozzle is designed so it has an 
efficiency of 90%. Enter the nozzle sizes and efficiency in the text boxes: 
 

• Throat: Diameter of the nozzle throat. Also, it can be defined as a nozzle 
throat area to propellant burning area ratio. Typical values goes from 50:1 
for a high performance propellant or high burn rates to 300:1 for a low 
performance propellant or low burn rates. In this example, 6.8 mm 
diameter is specified or a 300:1 ratio can also be used.  

 

• Exit: Diameter of the nozzle exit. This can also be defined as a nozzle 
throat area to nozzle expansion area. Typical values goes from 3:1 for a 
low combustion chamber pressure and atmospheric external pressure to 
10:1 for a high chamber pressure or 50:1 for a high chamber pressure and 
vacuum as external pressure. This parameter can be left blank so the 
simulator calculates the ideal nozzle expansion ratio at every point on the 
thrust curve. In this example, 23.5 mm diameter is defined or a 12:1 ratio 
can also be used. 

 

• Efficiency: Efficiency of the nozzle. A value of 85% is typical for a low 
efficiency nozzle. Higher efficiency of 95% or above can be achieved with 
advanced nozzle shapes. In this case, an efficiency of 90% is defined. 

 

Some additional parameters like the combustion chamber mass and 
thickness, the external pressure or the end of thrust pressure will be defined. 
In this example, the cylinder that contains the propellant has an outer 
diameter of 62.4 mm, so the thickness of the walls is 1.2 mm. The dry mass 
of the rocket is 116 g. The dry mass is the mass of all materials without the 
propellant mass. This includes the combustion chamber, the nozzle and any 
material that does not burn in the combustion like the material that protects 
the chamber walls from the combustion heat. It also must include other 
components of the rocket like attitude control, thermal shield, parachute, etc. 
The maximum pressure that the cylinder can resist is 70 atm. We know the 
thickness of the cylinder walls so we can let the simulator calculate this 
pressure by specifying the maximum stress of the material. Also, the material 
density can be specified in the dry mass parameter so the mass of the 
cylinder can be calculated. Finally, the rocket is designed to work at standard 
atmospheric pressure, so the external pressure is 1 atm. The pressure gauge 
that determines the end of the thrust is 0.1 atm. Enter these parameters in 
the text boxes: 
 

• Thickness: Thickness of the combustion chamber walls. This can also be 
specified as a percent ratio of the propellant diameter. In this case, 1.2 
mm is defined or 2% can also be used. 

 

• Dry mass: Dry mass of the engine (without the propellant mass). This can 
be specified as a percent ratio of the total mass. Also, the density of the 
combustion chamber material can be specified together with the thickness, 
so the mass can be calculated. In this example, a dry mass of 116 g is 
specified or 20% can also be used. 

 

• Burst pressure: Motor chamber burst pressure. This is the maximum 
pressure that the motor chamber can resist. Also, the maximum stress of 
the material can be specified together with the thickness so the maximum 
pressure can be calculated. Press the      button to select the maximum 
stress and density parameters from a list of common materials. This list is 
defined in the “Materials.lst” file at the Engines folder. In this example, a 
burst pressure of 70 atm is defined. 

 

• External pressure: Pressure outside the motor chamber. This parameter 
is important in the design of the nozzle expansion ratio. In this example, a 
standard atmospheric pressure will be used so this will be 1 atm. 

 

• Burnout pressure: The pressure gauge that determines the end of the 
thrust. This is used to stop the simulation at the point where the thrust 
generated is too low to be useful. In this case, 0.1 atm is defined. 

 

 
 
 
 
 
 
 
 
 
 
 
At this point all the parameters of the simulation are 
defined. Press Enter to start the simulation and 
calculate the thrust curve. The graph and the cross 
and longitudinal sections of the propellant will be 
updated. Press the    button to show extended 
information about the engine specifications. There 
are some parameters related to the engine 
performance and the thrust curve like Class, Isp, 
Maximum thrust and Burnout time. Other 
parameters are related to the engine, nozzle and 
propellant sizes, the mass and the propellant core 
geometry. This information is useful if any 
parameter was specified as a percent ratio, mass, 
volume, density or material stress. The simulator 
will calculate the parameter and it will be shown 
here. Also, the propellant mass, volume and total 

                                                      
24 NASA - Rocket thrust equations 
http://www.grc.nasa.gov/WWW/K-12/rocket/rktthsum.html 

mass will be calculated. In this example, note that the maximum pressure of 
73.6 atm is higher than the selected chamber burst pressure. This is shown 
in the graph as a blue background. To correct this, select the Aluminum alloy 
option in the Pressure text box to recalculate the graph. This material 
increases the chamber burst pressure to 159 atm. This is high enough to 
resist the maximum pressure generated. Move the mouse pointer over the 
graph to show all the parameters and the propellant burn progress at a 
specific burn time. Right click on it to access the context menu and switch the 
parameter that will be shown in the graph. If the nozzle Exit parameter was 
left blank, select Expansion ratio in the context menu to show the ideal 
expansion ratio at every point of the thrust curve. The average expansion 
ratio will be shown in the extended information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The last step is to generate a custom engine in ENG file format so it can be 
used in a trajectory simulation. Press the        button near the Preset text box 
to save the curve as a custom engine. Now this engine can be used in a 
trajectory simulation. To test the engine, press the Preset        button in the 
Toolbar and select the LEO preset. In the Stages panel, press the       button 
to deactivate the Stage 2. Press the     button in the Type text box of the 
Stage 1 and select the KNDX custom engine from the list to update the 
parameters of the Stage 1 with the engine calculated before. The LEO preset 
is designed to put a satellite in orbit and the spacecraft trajectory must 
perform a curve to reach the orbital speed. In this case, a vertical trajectory 
will be used because the total impulse of the small rocket will not be high 
enough to exit the atmosphere. Change the trajectory angles in the Start and 
End text boxes of the Setup panel to a 90º angle. To start the trajectory 
simulation, press the Play            button in the Toolbar. The small rocket will 
reach an apogee of about 1 km and a maximum speed of Mach 1 at burnout 
in only 1.5 seconds. Note that if the custom engine is modified in the Burn 
editor and saved to a file, the parameters of the engine in the Stages panel 
will be automatically updated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Burn editor has been compared with the MotorSim 2.0

25
 simulator using 

a Finocyl 5-Star geometry. There are small differences because MotorSim 
does not calculate the efficiency loss when the nozzle is overexpanded. 
 

 TUTORIALS Multistage 

 
 
 
 
 
 
 
The LEO Multistage Balloon preset is an example of a multistage launcher 
using the small Noris Raketen D7 custom engine. Only one “Noris-D7” stage 
is defined but it is repeated one or more times to find the optimal number of 
stages. The string “xN” is added to the stage Type in the Stages panel to 
emulate a multistage of “N” components. 
 
 
 
 
 
 
 
 
 
 
 

                                                      
25 MotorSim 2.0 rocket motor simulator 
http://content.billkuker.com/projects/rocketry/software/motorsim-2-0 
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Starting from one stage and adding more, the apogee altitude increases until 
the total mass is too high for the thrust of a single stage. Then the overall 
performance decreases to a point where the first stage can not lift off. The 
first example shows the apogee altitude reached using a multistage of 1 to 15 
“Noris-D7” components and starting at ground level. The red graph is 
calculated using 1 second of inter-stage delay. The blue graph is calculated 
without using delay. The highest altitude of about 4 km is achieved using 13 
stages with no inter-stage delay. 
 
 
 
 
 
 
 
 
 
 
 
 
The same simulation is repeated but this time starting at 35 km of altitude. 
The maximum apogee of 79 km is achieved using 16 stages with no delay. 
 

 TUTORIALS Custom engines 

RASP was the original rocket flight simulator, started by the model rocket 
pioneer G. Harry Stine. Many iterations later, it is still in use as wRASP. It 
reads motor data from text files with the “.ENG” extension. This format, 
named “RASP” or “ENG”, has become the standard for motor data 
interchange. This simulator can read the RASP ENG file format and use it as 
a custom stage engine. Put the .ENG file inside the Engines folder and select 
it in the Type drop-down box of any stage in the Stages panel. This is a 
description of the file format taken from the ThrustCurve

26
 web site. 

 

The Header Line 
 

Blank lines and lines beginning with semicolons are ignored at the beginning 
of the entry. The first line interpreted is the “header line”, which contains info 
on the motor itself. The header contains seven pieces of info, separated by 
spaces. All seven must be present for the entry to be read successfully. 
Here’s a sample fragment, with a few comments and the header line: 
 

; Rocketvision F32 
; from NAR data sheet updated 11/2000 
; created by John Coker 5/2006 
F32 24 124 5-10-15 .0377 .0695 RV 

 
1. motor name 
  2. diameter 
    3. length 
      4. delays 
        5. prop. weight 
          6. total weight 
            7. manufacturer 
 

1. Motor name. This is the common name of the motor, as you 
would like to see it listed in your simulator program. 

 

2. Diameter. This is the casing diameter in millimeters (mm). 
 

3. Length: This is the casing length, also in millimeters (mm). 
 

4. Delays. This is the list of available delays, separated by 
dashes. If the motor has an ejection charge but no delay use 
“0” and if it has no ejection charge at all use “P” (plugged). 

 

5. Propellant weight. The weight of all consumables in the motor. 
For solid motors this is simply the propellant itself, but for 
hybrids it is the fuel grain(s) plus the oxidizer (such as N2O). 
This weight is expressed in kilograms (kg). 

 

6. Total weight. The weight of the motor loaded and ready for 
flight, also in kilograms (kg). 

 

7. Manufacturer. The motor manufacturer abbreviated to a few 
letters. NAR maintains a list of manufacturer abbreviations in 
the combined master list. This list is available in PDF format at: 
http://nar.org/SandT/pdf/CombinedList.pdf 

 

Data Points 
 

Starting immediately after the header line, the remaining lines contain sample 
data points. Each sample specifies a time in seconds (s) and a thrust in 
Newtons (N) as two floating-point numbers, separated by spaces and usually 
preceded by a few spaces for readability. 
 

; Rocketvision F32 
; from NAR data sheet updated 11/2000 
; created by John Coker 5/2006 
F32 24 124 5-10-15 .0377 .0695 RV 
   0.01 50 
   0.05 56 
   0.10 48 
   2.00 24 
   2.20 19 
   2.24  5 
   2.72  0 
; 
 

An implicit first point at 0,0 is assumed and should not be specified explicitly. 
The final point must have a thrust of zero and it indicates the motor’s burn 
time. The points should be in increasing order of time and the thrusts should 
trace out the thrust curve as representatively as possible. After the final data 
point, the entry may contain comments and blank lines, but nothing else. 
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 TUTORIALS Low-cost access to space 

This tutorial shows how to use the Trajectory editor in order to design a 
launcher capable of injecting a femto-satellite with a mass of 100 grams or 
less into a 250 km LEO orbit. This tutorial will show how the total mass will 
grow with the payload mass but also the mission time will be increased. 
 

Nowadays, the access to the space is very limited by the available launchers 
of the space agencies that are focused on heavy payloads for few tons. 
There is a need of lighter, quicker and cheaper launching method for small 
payloads. This simulator is contributing to the low-cost access to space with 
a project called QuickFAST, an European platform to provide independent 
access to space. In the list of mission presets we have included three cases 
inside the category of femto-satellite payloads: 20g, 50g and 100g. In this 
tutorial we will use the Trajectory editor to design a quick access to the space 
for a femto-satellite of 75 grams. The designed orbit will be a circular orbit of 
250 km of altitude and an inclination with more than 50 degrees because we 
want to cover most of Europe territory. This inclination demands for extra 
propellant since the desired launching place is the #GranCanariaSpaceport. 
 

As an example of how to automatically calculate a LEO trajectory for a small 
payload of 75g we will use the LEO QuickFAST 50g preset. These are the 
basic parameters of the mission: 
 

 • Launching site coordinates:  Las Palmas: 28.2696ºN, 16.6427ºW 
 • Orbital altitude:   250 km 
 • Orbital period:   89 minutes 30 seconds 
 • Initial heading:   40º 
 • Number of stages and propellant: 2 stages, C1-C2 
 • Payload mass:   75 g 
 

Press the Preset       button in the Toolbar and select the LEO QuickFAST 

50g preset to load the mission parameters. Change the Payload mass in the 
Stages panel to 75g. The rest of the parameters, like the trajectory Heading 
in the Setup panel or the number of stages and propellant in the Stages 
panel are the same in this mission so they do not need to be changed. Now 
press the     button in the Setup panel to show the Trajectory editor and 
select the Low Earth orbit mode. Enter the desired orbital altitude in the Orbit 
text box, in this case 250km. Press the Calculate button to automatically 
calculate the trajectory. An error message will be shown because the Mass 
and Thrust parameters of at least one stage must be variable. This way the 
simulator can adjust the total size and mass of the launcher to determine the 
required value. In this example, the Mass and Thrust parameters of both 
stages were fixed values so they have been automatically changed to 
variable values. Review the corrections and press the Calculate button again 
to start the calculation. This time the simulator will calculate the trajectory, 
adjusting the launcher parameters for a total mass of 14 kg. Now you can 
press the Play            button in the Toolbar to test the trajectory and calculate 
the satellite coverage area and the mission time. Also, you can change the 
preset name to LEO QuickFAST 75g and save it to the disk. 
 

The following graphs have been generated using the simulated trajectories of 
the LEO QuickFAST 20g, 50g, 75g and 100g mission presets: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The results show how the total mass will grow with the payload mass from 6 
kg for a payload of 20 grams to 18 kg for a payload of 100 grams. In addition, 
the mission time depends on the payload mass as well from 9 days for a 
payload of 20 grams to 51 days for a payload of 100 grams. Depending on 
the femto-satellite mission it should be selected the payload mass for the 
required duration. 
 

A quick mission where the satellite is only required for few days should be 
burned as soon as possible to leave the orbit free for another mission. In the 
opposite, if the event to be observed by the femto-satellite camera is inside a 
time window or the event lasts for few weeks, it should be required a heavier 
femto-satellite. It should be taking into account that, since femto-satellites are 
based on batteries, the larger the mission the shorter number of photos per 
day can be taken. Otherwise, extra electrical power source will be required 
such as solar panels. The problem with solar panels is that they reduce the 
available mass for aboard sensors making difficult to accomplish the low 
mass requirements for a femto-satellite. 



  Mini-launcher Simulator Moon2.0 

   REFERENCE MANUAL Page 23 of 37 

 TUTORIALS Report tool 

The Report tool can be used as a presentation tool to describe a mission or a 
simulation. It shows the text inside the “Report.txt” file located at the Logs 
folder. The text can be formatted in pages and then navigate through them 
using the Page down and Page up keys. 
 

To activate this tool, click the Render tools      button and select Report or 
press the Ctrl+J key. The first page will be shown as an overlay text over the 
simulation. Because the text is shown behind all the panels, it is 
recommended to hide all the panels that are not needed for the presentation. 
Press the Page down key to go to the next page or the Page up key to 
return to the previous one. Also, press the Home key to go to the first page 
or the End key to go to the last one. Press them again to return to the last 
page. 
 

The text in the “Report.txt” file can be formatted in pages. The character used 
to split the text in pages is the vertical bar “|”. If a line contains a vertical bar it 
will be treated as a page break and the rest of the line will be ignored. This 
line can be used as a comment for the page. To change the text font used for 
this tool, click the Screen options     button in the Toolbar and select the 
Report font option. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To edit the “Report.txt” file, use the Notepad panel and select Edit→Report in 
the context menu. The text shown with the Report tool will be updated every 
second to reflect the changes made to the “Report.txt” file from an external 
editor or another application. But this function will not work if the simulation is 
paused. 
 

This is a short example of the “Report.txt” file: 
 

|Page 1, this line is ignored 
REPORT TOOL 
This is the text of the first page. 
|Page 2, this line is ignored 
FORMATTING THE TEXT 
The character used for a page break is the vertical bar. 
|Last page, this line is ignored 
This is the text of the last page. 

 
 

 TUTORIALS Sync mode 

The Sync mode synchronizes the simulation with the real date and time. 
When this mode is active, use the             buttons in the Toolbar to change 
the time speed from real time to 10 years every step. The current scale of 
time will be shown in the second row of the Data panel. 
 

If real time is selected, you can press the Play          button at any time to 
deactivate the Sync mode and start the simulation at that point. If the time 
speed is greater than real time, the process can be paused or resumed, 
moved back and forward or resynchronized with the real time position with 
the                       buttons. Note that the Sync mode can not be activated 
when a normal simulation is in progress. 
 

In the Presets→Demos menu there are some demo presets that use the 
Sync mode. The “Jupiter moons fly-by” demo will be used as an example of 
how to use the Sync mode and Follow→Object features. 
 

Open the Options panel by pressing the      button in the Toolbar and select 
Viewer→Deep space to change the 3D viewer settings to a deep space 
mission defaults. Also set the Sun shadow to Dark to show a more realistic 
shadow for the planets. Select the Tools tab in this panel and activate the 
Moons option so the moons of the planets are shown and can be selected. 
Close the Options panel. 
 

Now click with the right button on the 3D viewer to show the context menu 
and activate the Sync mode. The date and time of the simulation will be 
synchronized with the real time. By default the time speed of this mode is set 
to real time and is shown in the second row of the Data panel as “xReal”. Use 
the          buttons in the Toolbar to adjust the time speed to “x1 min” and 
press the Pause         button to pause the synchronization. Then, in the 
Setup panel, click and drag the      buttons on the right side of the Date and 

Time text boxes to set the date to “2012-03-12” and the time to “21:00:00” so 
the planets are moved to the desired position. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Then, press the Follow        button and select Jupiter to move the camera to 
that planet. Zoom out the camera until the moons of Jupiter can be seen and 
click on Europa to select it. An overlay on the right side of the 3D viewer will 
show information about the moon. Press the Follow       button again and this 
time select Object. The camera will move to the moon position and will follow 
it. Next, zoom in the camera until the moon can be seen well enough and 
rotate it until Jupiter appears in the background at the right side of the 3D 
viewer. Finally, press the Play           button to start the fly-by of the moons 
around Jupiter. 
 

At any time, use the context menu to deactivate the Sync mode or press the 
Preset    button and select Default settings to restore the default 
configuration for the 3D viewer. 
 

 TUTORIALS Online maps 

The Map panel can be used to display the most popular online maps like 
Google Maps

27
 from Google, Bing Maps

28
 from Microsoft and some other 

open-source maps like OsmaRender from the OpenStreetMap
29

 project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right click on the map to access the context menu and the map options. In 
the Map sub-menu are listed all the available online maps. Select Default to 
deactivate the online maps. Some maps are designed to be used as an 
overlay and can be selected using the Overlay sub-menu. 
 

To move the map, left click and drag the mouse and use the mouse wheel or 
the Zoom options to zoom in and out. Also, double click with the mouse on 
any position to move the map to that position and zoom in one level. With the 
Full screen option, the map can be resized to the entire screen. Press 
Escape to exit this mode. You can use the option Follow mode to follow the 
position of the spacecraft in the simulation and the Show info option to show 
or hide the current position and the cursor at the center of the map. 
 

The current position of the map can be changed in the position text box. Click 
on it, enter the desired latitude and longitude separated by one space and 
press Enter. Also, enter the name of any city or village in the world to use the 
Google Maps search engine and find its coordinates. In this text box, press 
the arrow    button to show the Locations menu and go to the desired 
location. Press the      button to open the web browser with the main page of 
the current online map. 
 

The definition of all the online map services is stored in the “Maps.ini” file 
located at the Terrain folder. The downloaded tiles for the maps will be saved 
also in the Terrain folder, inside a folder with the same name as the map 
service, for faster access to the map. This feature can be enabled or disabled 
with the Download tiles option in the context menu. Also, use the Download 
map sub-menu to download the visible area of the map from the minimum to 
the selected zoom level. 
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 TUTORIALS Software-in-the-loop 

This simulator has the ability to control the launcher in three ways: Software-
in-the-loop, Hardware-in-the-loop and Network-in-the-loop. This is a very 
powerful tool in order to test any subsystem inside the mission thanks to the 
concept of black-box. 
 
 
 
 
 
 
 
 
 
 
If you want to test any control algorithm, it is easy to change the current 
source because this is an Open Source project. You can select any part of 
the mission separated by the “Case” keyword in the function Sub Nav() 
inside the “Sys.bas” file located at the Source folder. You have in this file a 
definition of each variable and units. 
 

 TUTORIALS Hardware-in-the-loop 

The next level of control is to implement your own subsystem and testing it 
using a RS-232 connection. Select Control link mode in the Link panel and 
any available COM port in Link port. You may use the following protocol. 
 

Either serial or socket connection uses ASCII text or Binary data. Use the 
Options sub-menu in the Link panel to select Text mode or Binary mode and 
Double or Single precision for 64 or 32 bit floating point numbers in IEEE 
754

30
 format. In Text mode, the proposed protocol is the same in both 

options and are comma separated numbers with an ending “;” character 
where decimal character is “.”, negative values character is “-”, optional 
positive values character is “+”, exponential symbol is “e” or “E” and not a 
number characters are “NaN”. Each block start with a code of four 
characters: INIT, DATA or CTRL. INIT and DATA blocks are sent from the 
simulator to the external device and CTRL block is replied by the external 
device. 
 

INIT. This block is sent to the device at the start of the simulation or every 
time the connection is lost and could be used by the black-box as a reset 
command. The syntax for Text mode is: 
 

INIT,TimeStep,Date,Time,Lat,Lon,Alt,Speed,Heading, 
StartAngle,EndAngle,StartAlt,EndAlt,Abort,TotalMass, 
Stages,StageNMass,StageNDry,StageNThrust,StageNDelay, 
PayloadMass; 
 

Example: 
INIT, .05,2007-06-26,12:09:00, 28.2,-16.6, 0, 409.895238938115, 87.2, 15, 88, 15000, 91000, 

 4, 34.7, 2, 31.212, 3.1212, 567.151258333333, 121, 3.468, .3468, 57.0093253333333, 3, .02; 
 

The binary structure for Binary mode and Double precision in C++ syntax is: 
 

typedef struct tagInitStage { 
  double Mass, Dry, Thrust, Delay; 
} InitStage; 
 

typedef struct tagInitBlock { 
  char Name[4]; double TimeStep; char Date[10], Time[8]; 
  double Lat, Lon, Alt, Speed, Heading, StartAngle, 
    EndAngle, StartAlt, EndAlt, TotalMass, PayloadMass; 
  char Abort, Stages; InitStage Stage[5]; 
} InitBlock; 
 

TimeStep: Time step of simulation loop in seconds. 
 

Date, Time: Launch date and time in UTC time format: YYYY-MM-DD, 
HH:MM:SS. 
 

Lat, Lon, Alt: Launch geo-coordinates using the WGS84 system in 
degrees and altitude in meters respect to average sea level. 
 

Speed: Relative initial speed respect to the planet’s center with planet’s 
rotation in meters per second. 
 

Heading: Clockwise launch direction where Northing is 0 degrees. 
(0=North, 90=East). 
 

StartAngle, EndAngle: Start and final angle of the launch trajectory 
where vertical (azimuth) is 90 degrees. (90=vertical, 0=horizontal). 
 

StartAlt, EndAlt: Start and final altitude check point of the launch 
trajectory in meters. 
 

Abort: Number of stages before abort. 
 

TotalMass: Wet launcher mass in kilograms. 
 

Stages: Number of stages without the hover and the payload. The StageN 
parameters are repeated for every stage. 
 

StageNMass: Wet mass of stage N in kilograms. 
 

StageNDry: Dry mass of stage N in kilograms. 
 

StageNThrust: Thrust in vacuum of stage N in Newtons. 
 

StageNDelay: Delay after stage N in seconds. 
 

PayloadMass: Payload mass in kilograms. 
 
 

DATA. This block is sent to the device each simulation loop. The syntax for 
Text mode is: 
 

DATA,T,M,Mt,Mf,F,Te,eG,eH,eX,eY,eZ,eA,eR,eVR,eVRX,eVRY, 
eVRZ,eVA,eVAX,eVAY,eVAZ; 
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Example: 
DATA, 0, 34.7, 34.7, 6.6092, 0, .222435897435897, 9.80060472243182, 6378137, 

-968534.704408334,-6278974.38685793,-563074.387898972, 9.31322574615479E-10, 

 9.31322574615479E-10, 409.895238938115,-403.764758270368, 64.7999721286988, 

-28.0907546200786, 1.43754951773129E-12,-5.04984942750752E-13, 

-1.22130777713281E-12, 5.65637814364806E-13; 
 

The binary structure for Binary mode and Double precision in C++ syntax is: 
 

typedef struct tagDataBlock { 
  char Name[4]; 
  double T, M, Mt, Mf, F, Te, eG, eH, eX, eY, eZ, eA, eR, 
    eVR, eVRX, eVRY, eVRZ, eVA, eVAX, eVAY, eVAZ; 
} DataBlock; 
 

T: Time stamp since the launch in seconds. 
 

M: Current launcher mass in kilograms. 
 

Mt: Current launcher wet mass without burned stages in kilograms. 
 

Mf: Current launcher dry mass without burned stages in kilograms. 
 

F: Current thrust in Newtons as a function of the thrust curve and the 
atmospheric pressure. 
 

Te: Propellant consumption at full thrust in kilograms per second. 
 

eG: Current planet’s gravity in meters per second squared. 
 

eH, eX, eY, eZ: Current altitude respect to the planet’s center and its X, 
Y, Z components in meters. 
 

eA: Current altitude respect to the sea level in meters. 
 

eR: Current height respect to the ground in meters. This parameter is valid 
only when the altitude to the surface is less than one planet radius and the 
option “matrix terrain” is activated in the simulator. 
 

eVR, eVRX, eVRY, eVRZ: Current relative speed respect to the planet’s 
center and its X, Y, Z components in meters per second. 
 

eVA, eVAX, eVAY, eVAZ: Current relative speed respect to the planet’s 
atmosphere and its X, Y, Z components in meters per second. 
 

CTRL. This block is expected by the simulator to be replied before the 
“timeout” interval has elapsed, if not then it goes to PAUSE mode. The 
syntax for Text mode is: 
 

CTRL,Tt,St,Nt,Rt,Ut,Vt,Wt; 
 

Example: 
CTRL, 0, 2, 1, 1, .151852289219914, .984452730767299, 8.82819525355084E-02; 
 

The binary structure for Binary mode and Double precision in C++ syntax is: 
 

typedef struct tagCtrlBlock { 
  char Name[4]; double Tt; 
  char St, Nt, At, Bt; double Rt, Ut, Vt, Wt; 
} CtrlBlock; 
 

Tt: Time stamp since the launch in seconds to check the correct packet. 
 

St: Current mission phase: Crashed=-2, Landed=-1, Launch=0, TakeOff=1, 
Landing=2, Revert=3, Satellite=4, Transfer=5, StandBy=6, Aborted=7. NOT 
YET IMPLEMENTED 
 

Nt: Active stage (1, 2 X N). NOT YET IMPLEMENTED. 
 

Rt: Thrust control from 0=stopped to 1=full throttle. 
 

Ut, Vt, Wt: Attitude control vector. It must be a normalized vector if the 
Normalize vector option in the Remote control panel is not activated, that is 
to say: Ut² + Vt² + Wt² = 1. By default, this vector must also be defined in the 
simulator reference system that is aligned with the ecliptic plane (the plane 
XY where the Earth orbits around the Sun). If the Align axes option is 
activated, the axes must be aligned with the launch site. The Z+ axis 
corresponds to the vertical vector, the Y+ axis to the North and the X+ axis to 
the East. Note that the axes are always locked in the initial position so they 
not move while the Earth rotates during the launch maneuver. Also, the axes 
read from the inertial sensor of the device can be mapped or inverted with 
the options of the Remote control panel. To see the simulator X, Y, Z axes in 
the OpenGL viewer you may select the tool Tools→Axes. 
 

 TUTORIALS Network-in-the-loop 

The last level of control is to implement your own subsystem and testing it 
using a UDP-IP connection type. Select Control link mode in the Link panel 
and Network in Link port. In Text mode, the size of INIT and DATA blocks 
must be 512 bytes and CTRL block must be 128 bytes. You may use the 
same protocol described before in the “Hardware-in-the-loop” section. 
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 TUTORIALS Black-box connection example 

In this section an example of connection with an external device is presented 
using Hardware-in-the-loop and an open Arduino

31
 microcontroller unit 

(MCU) as a black-box showed below. It is a reply of the Arduino Mini and has 
an inertial platform. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is an example of Arduino code to test the communication. The simulator 
must be configured with the Link panel in Control mode and using a RS-232 
connection type. The speed should be configured to 57600 baud thus the 
MCU is set to 115200 bauds because the clock is only 8 MHz. All the 
simulation control flags like Launch trajectory must be deactivated. The 
simulator ignores the commands. 
 

// Globals 
char data[512]; int i; 
 

void setup() { 
  Serial.begin(115200); i = 0; 
} 
 

void loop() { 
  if (Serial.available() > 0) 
    data[i++] = Serial.read(); 
  if ((i >= 512) || (data[i - 1] == ';')) { 
    if (data[0] == 'I') { 
      // Process INIT block 
    } else if (data[0] == 'D') { 
      // Process DATA block 
      Serial.print("CTRL,0,1,1,1,0,1,0;"); 
    } 
    i = 0; 
  } 
} 
 

The following example uses the IMU of an Arduino to control the attitude of 
the launcher during the launch trajectory. The time stamp is copied to the 
CTRL block. The simulator must be configured in the Link panel in Control 
mode and using a RS-232 connection type. The simulation control flags must 
be deactivated except Launch trajectory. The simulator rotates the launcher 
following the commanded attitude vector. Note that the serial port 
configuration of the Arduino is set to 38400 bauds but sometimes it is not 
able to read all the information coming from the simulator. Test mode must 
be selected in the Link panel because only the time stamp in the DATA block 
is used. Also, the Normalize vector option in the Remote control panel must 
be activated because the inertial sensor data is sent without processing. 
 

#define LED_PIN         13 
#define BMA180_ADDRESS  0x80 
#define I2C_SPEED       100000L 
 
char data[512]; int i; // Data link 
uint8_t rawADC[7]; 
 
#define toINT(LSByte, MSByte) ((int) ((unsigned int) \ 
  (MSByte) << 8) | ((unsigned char)(LSByte))) 
 
void waitTransmissionI2C() { 
  uint16_t count = 255; 
  while (!(TWCR & (1 << TWINT))) { 
    count--; if (count == 0) {TWCR = 0; break;} 
  } 
} 
 
void i2c_rep_start(uint8_t address) { 
  TWCR = (1 << TWINT) | (1 << TWSTA) | (1 << TWEN); 
  waitTransmissionI2C(); 
  TWDR = address; TWCR = (1 << TWINT) | (1 << TWEN); 
  waitTransmissionI2C(); 
} 
 
void i2c_write(uint8_t data) { 
  TWDR = data; TWCR = (1 << TWINT) | (1 << TWEN); 
  waitTransmissionI2C(); 
} 
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uint8_t i2c_readAck() { 
  TWCR = (1 << TWINT) | (1 << TWEN) | (1 << TWEA); 
  waitTransmissionI2C(); 
  return TWDR; 
} 
 
uint8_t i2c_readNak() { 
  TWCR = (1 << TWINT) | (1 << TWEN); 
  waitTransmissionI2C(); 
  uint8_t r = TWDR; 
  TWCR = (1 << TWINT) | (1 << TWEN) | (1 << TWSTO); 
  return r; 
} 
 
void i2c_writeReg(uint8_t add, uint8_t reg, uint8_t val) 
{ 
  i2c_rep_start(add + 0); i2c_write(reg); i2c_write(val); 
  TWCR = (1 << TWINT) | (1 << TWEN) | (1 << TWSTO); 
} 
 
uint8_t i2c_readReg(uint8_t add, uint8_t reg) { 
  i2c_rep_start(add + 0); i2c_write(reg); 
  i2c_rep_start(add + 1); 
  return i2c_readNak(); 
} 
 
void init_imu() { 
  PORTC |= 1 << 4; PORTC |= 1 << 5; 
  TWSR = 0; TWBR = ((16000000L / I2C_SPEED) - 16) / 2; 
  TWCR = 1 << TWEN; 
  delay(10); i2c_writeReg(BMA180_ADDRESS, 0x0D, 1 << 4); 
  delay(5); 
  uint8_t control = i2c_readReg(BMA180_ADDRESS, 0x20); 
  control &= 0x0F; control |= (0x01 << 4); 
  i2c_writeReg(BMA180_ADDRESS, 0x20, control); 
  delay(5); control = i2c_readReg(BMA180_ADDRESS, 0x30); 
  control &= 0xFC; control |= 0x00; 
  i2c_writeReg(BMA180_ADDRESS, 0x30, control); 
  delay(5); control = i2c_readReg(BMA180_ADDRESS, 0x35); 
  control &= 0xF1; control |= (0x05 << 1); 
  i2c_writeReg(BMA180_ADDRESS, 0x35, control); 
  delay(5); ADCSRA |= _BV(ADPS2); ADCSRA &= ~_BV(ADPS1); 
  ADCSRA &= ~_BV(ADPS0); 
} 
 
void read_imu() { 
  TWBR = ((16000000L / 400000L) - 16) / 2; 
  i2c_rep_start(BMA180_ADDRESS); i2c_write(0x02); 
  i2c_rep_start(BMA180_ADDRESS + 1); 
  rawADC[0] = i2c_readAck(); rawADC[1] = i2c_readAck(); 
  rawADC[2] = i2c_readAck(); rawADC[3] = i2c_readAck(); 
  rawADC[4] = i2c_readAck(); rawADC[5] = i2c_readAck(); 
  rawADC[6] = i2c_readNak(); // Temperature 
} 
 
void setup() { 
  pinMode(LED_PIN, OUTPUT); 
  Serial.begin(38400); 
  init_imu(); 
  i = 0; 
} 
 
void loop() { 
  digitalWrite(LED_PIN, HIGH); 
  if (Serial.available() > 0) { 
    data[i++] = Serial.read(); 
    if ((i >= 512) || (data[i - 1] == ';')) { 
      if (data[0] == 'I') { 
        // Process INIT block 
      } else if (data[0] == 'D') { 
         
        // Process DATA block 
        digitalWrite(LED_PIN, LOW); 
        Serial.print("CTRL,"); 
        for (i = 5; (data[i] != ',') && (data[i] != ';') 
            && (i < 512); i++) Serial.print(data[i]); 
        Serial.print(",0,1,1,"); 
         
        // Include the vector control 
        read_imu(); delay(10); 
        Serial.print(toINT(rawADC[0], rawADC[1]) >> 2); 
        Serial.print(","); 
        Serial.print(toINT(rawADC[2], rawADC[3]) >> 2); 
        Serial.print(","); 
        Serial.print(toINT(rawADC[4], rawADC[5]) >> 2); 
        Serial.print(";"); 
      } 
      i = 0; 
    } 
  } 
} 
 

This example code is located at the “WikiLauncher_IMU.zip” file inside the 
Source→Arduino folder. 

USB cable 
 

to computer 

FTDI 
 

USB to SPI 
RS232 port 

MCU + IMU 
 

ATmega328P 
BMA180 
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 TUTORIALS GPS Tracking 

This simulator can track the position of a real object and process the 
“$GPGGA” or “$GPRMC” NMEA

32
 commands from an external GPS 

connected to a serial port or the Audio input. Also, it can use the APRS
33

 
tracking service to track the object position. In the Link panel, select the 
desired connection type in the Link port and Station port text boxes and then 
select the Tracking link mode to start the tracking. The position and the path 
of both objects will be shown in the OpenGL viewer. 
 

The GPS must be configured to send the “$GPGGA” or “$GPRMC” NMEA 
commands through the COM ports or the Audio input. The Audio input must 
use a 6 kHz PWM (Pulse Width Modulation) signal with a MSB (Most 
Significant Bit first) bit order. An example of Arduino code is located at the 
“PWM_6kHz.zip” file inside the Source→Arduino folder. To use the APRS 
tracking service, select APRS in the port menu and specify the User and 
Password required to accessing this service. Note that the Audio and APRS 
modes can not be used in both Link port and Station port at the same time. 
 

This is the description of the NMEA command “$GPGGA”: 
 

$GPGGA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh 
                      1             2    3    4         5 6 7    8   9  10 11 12 13  14   15 
 

1. Time of position in UTC 
2. Latitude in ddmm.mm 
3. N or S 
4. Longitude in dddmm.mm 
5. E or W 
6. GPS quality indicator (0=invalid; 1=GPS fix; 2=Diff. GPS fix)  
7. Number of satellites in use (not those in view) 
8. Horizontal dilution of position 
9. Antenna altitude above / below mean sea level (geoid) 
10. Meters (antenna height units) 
11. Geoidal separation (diff. between WGS-84 ellipsoid and mean 

sea level; N<0 = geoid is below WGS-84 ellipsoid) 
12. Meters (geoidal separation units) 
13. Age in seconds since last update from diff. reference station 
14. Diff. reference station ID# 
15. Checksum hexadecimal 
 

Every time the position is received from the GPS or the APRS tracking 
service, the simulation launch coordinates will be updated in Setup panel. If 
the Tracking Sync option is activated, when the altitude is equal or greater 
than the launch altitude, the simulator will run the simulation so the real and 
the predicted trajectories can be compared. Also if the Tracking Log option is 
activated, the trajectories will be saved in a KML file inside the Presets folder. 
 

 TUTORIALS Rover Tracking 

The Rover link mode can be used to control a rover and track its position 
using a serial connection. In the Link panel, specify the desired COM port in 
Rover port and then select the Rover link mode. When the link is activated, 
the simulator will send the “I” command through the serial port with the list of 
the waypoints to the rover. This list can be edited using the buttons located at 
the bottom of the panel. Use the          buttons to add or remove waypoints 
from the list and the      button to show de 2D map. You can change the X 
and Y positions of any waypoint by clicking and dragging the waypoint with 
the mouse in the map. Also click and drag the map to move it or zoom in and 
out using the mouse wheel. 
 

I,X1,Y1,X2,Y2,...,XN,YN; 
 

Example: 
I,5.2,4,-3.1,9,-5.5,6,-7,-8.4; 
 

XN,YN: Position X,Y of the point N, in meters. 
 

After the “I” command is sent, the simulator will track the position sent by the 
rover using the “D” command. The rover can also send the “A” command to 
track the inertial sensor data. Every time that any of these commands are 
received, the position and attitude of the rover will be updated in the 2D map. 
 

D,T,X,Y,Z; 
 

Example: 
D,10.2,-8,3.5,0; 
 

T: Elapsed time since the start, in seconds. 
 

X,Y,Z: Position X,Y,Z of the rover relative to the landing site, in meters. 
 

A,X,Y,Z; 
 

Example: 
A,0,0,9.8; 
 

X,Y,Z: Accelerometer data from inertial sensor X,Y,Z axes, in meters per 
second squared. 
 

If the rover sends the “A” command with the inertial sensor data, you can 
press the       button to show the rover 3D model and its current attitude with 
pitch and roll angles in degrees. The axes can also be mapped with the 
options in the Options→Input axes sub-menu. Press the arrow      button to 
access the command list. Use the Add to command sub-menu to add special 
characters to the end of the commands, like NULL, CR or LF. In this 
example, no terminating characters are used. 
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Remote control 
 

Press the      button to show the Remote control 
panel if it is not visible and then click the        button 
at the bottom of the panel or press Enter to control 
the rover. By default, the input device used is the 
keyboard but also the mouse or a joystick can be 
selected in the Device option. If Keyboard is 
selected, you can press the arrow keys to control the 
rover. If Mouse is selected, click the        button and 
drag the mouse in any direction. If Joystick is 
selected, just move the joystick to control the rover. 
In this mode, you can select the axes that control the 
Steering or the Thrust of the rover in the text boxes 
or invert the direction by clicking the check box near 
the axis. To deactivate the remote control just press 
the     button again. When the remote control is 
activated, the simulator will send the following 
commands through the serial port: 
 

Direct control commands: 
  

F Forward The rover will move forward 
B  Backward The rover will move backward 
L  Left The rover will turn left 
R  Right The rover will turn right 
S  Stop The rover will stop 
H  Halt The rover will deactivate all the servos and wait 
 

Waypoint mode commands: 
 

I  Init The rover will follow the waypoint list 
D  Data The rover sends the time elapsed and its position 
A  Attitude The rover sends the data from the inertial sensor 
 

Configuration commands (optional): 
 

C0; Reset to default parameters 
C1; Show current parameters 
C2; Show time and position using a D command 
C3; Show inertial sensor data using an A command 
CA130; Steering neutral position, in degrees 
CB180; Steering left limit, in degrees 
CC80; Steering right limit, in degrees 
CD71; Thrust neutral position, in degrees 
CE75; Thrust forward limit, in degrees 
CF66; Thrust backward limit, in degrees 
CG0.5; Slow thrust step, in degrees 
CH1; Fast thrust step, in degrees 
CI5; Slow steering step, in degrees 
CJ10; Fast steering step, in degrees 
CK50; Servo update interval, in milliseconds 
CL1000; Standby delay, in milliseconds 
 
Example: 
SSSFFFFLFLFLFRFRFRFFFSSBBBBRBRBLBLBLSSSSSH 
 

The time interval for the commands is defined in Timeout. The simulator will 
send the “S” command when no key is pressed or the joystick is not moved. 
If the Space key is pressed or the connection is closed, the “H” command will 
be sent to the rover to put it in standby mode. 
 

Real-time configuration (optional) 
 

To help adjusting the rover internal parameters without updating the Arduino 
code, the “C” command can be used. Every command starts with a “C”, 
followed by a character, optionally a number for the parameter and always 
terminated with a semi-colon “;”. Commands from “C0” to “C3” are debug 
commands and “CA” to “CL” are used to set a specific parameter for the 
rover. Type any command in the text box under the log of events and press 
Enter to send it to the Rover. When the rover is finally adjusted, these 
parameters can be written directly to the Arduino code and then the part for 
the real-time configuration can be removed from the code to free some 
memory. The list with all these commands is stored in the “Rover.ini” file 
inside the Models folder and can be edited with the Notepad panel. An 
example code for the Arduino MCU using the Direct control and the 
Configuration commands is located at the “PicoPilot_Antiroll.zip” file inside 
the Source→Arduino folder. 
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 TUTORIALS OpenGL Icons 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Models folder contains the 3D models displayed during the flight. To 
personalize these models you can use a free version of Caligari 
trueSpace3.2

34
 (TS3) that supports the extension .COB in ASCII format. This 

software is used to generate 3D objects and the simulator is able to open 
.COB format files in text version. There are 11 models for a common mission 
that corresponds with the current stage and the file name: 
 

• Balloon “Balloon.cob” →  “BalloonEmpty.cob” 
• Stage 1 “Stage1.cob” →  “Stage1Empty.cob” 
• Stage 2 “Stage2.cob” →  “Stage2Empty.cob” 
• Stage 3 “Stage3.cob” →  “Stage3Empty.cob” 
• Stage 4 “Stage4.cob” →  “Stage4Empty.cob” 
• Stage 5 “Stage5.cob” →  “Stage5Empty.cob” 
• Hover “Hover.cob” 
• Rover “Rover.cob” 
• Satellite “Satellite.cob” 
• Ground station “Station.cob” 
• Tracking object “Tracking.cob” 

 

You can put these files with the .COB extension in the Models folder so the 
simulator can use them. Optionally, every model can be located inside a 
folder with the same name as the model. If the object uses textures, they 
should be stored also in this folder. The model for every stage must contain 
the stage itself and all the upper stages, but only if they are visible. If the 
Simulation→Empty stages option is selected, a 3D model with the same 
name as the stage but with the “Empty” suffix will be used. 
 

The center of mass parameter CM in Stages panel will be taken from the 
parameter CentreOfGravity inside the PhAn command. Also, the Emissivity 
parameter will be calculated as a mean value for all the polygons in the 3D 
model, based on the Shininess parameter Ks, inside the Mat1 command. 
 

The object loader is compatible with the following trueSpace3.2 commands: 
Caligari V00.01ALH, Grou V0.01, PolH V0.04, Unit V0.01, Mat1 V0.06, PhAn 
V0.04, Lght V0.04, Chan V0.08 and END  V1.00. All these commands have 
Id, Parent and Size properties. The rest of the commands are ignored. 
 

• Caligari V00.01ALH command ensures that this file was 
generated by trueSpace3.2 because the load algorithm was made 
efficient for speed and not for robust. Also, it is possible to write 
manually the file in text format if the rules are followed. In this 
sense, this reader is case sensitive and separations have to be 
done in the proper order as trueSpace3.2 does. 

 

• Grou V0.01 command groups objects. It has its own Name - 
center and Transform matrix. Grou command could have Units, 
PolH, Chan and Grou but can not have the rest of commands. 

 

• PolH V0.04 command is a polyhedron. It has its own Name - 
center, Transform matrix, World vertices, Texture vertices and 
Faces. PolH command could have Units, Mat1 and PhAn but can 
not have the rest of commands. 

 

• Unit V0.01 command has the number of units inside this object 
 

• Mat1 V0.06 command has few material properties, included 
textures. 

 

• PhAn V0.04 command has few physics and anatomy properties. 
 

• Lght V0.04 command has information about illumination. 
 

• Chan V0.08 command has rotations and translations through the 
time. It is used for dynamics. 

 

• END  V1.00 command closes the object list. 
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 DIRECT KEYS Advanced controls 

These are some special mouse and keyboard commands used for advanced 
control of the 3D viewer and the simulation. 
 

Global keys for all the panels: 
 

  • F1 Show or hide the Help panel 
  • F2 Show or hide the Data panel 
  • F3 Show or hide the Log panel 
  • F4 Show or hide the Graph panel 
  • F5 Show or hide the Setup panel 
  • F6 Show or hide the Stages panel 
  • F7 Show or hide the Propellant editor 
  • F8 Show or hide the View panel 
  • F9 Show or hide the Link panel 
  • F10 Show or hide the Options panel 
  • F11 Enter or exit full screen mode 
  • F12 Show or hide the Toolbar 
  • Shift + F1 to F5 Follow modes from Free to Ship 
  • Shift + F6 to F7 Relative to modes Auto and Earth 
  • Shift + F8 Flat view 
  • Shift + F9 Orthogonal render 
  • Shift + F11 Switch from OpenGL to GDI render  
  • Shift + F12 Sync mode 
  • Ctrl + F2 Show or hide the Onboard sensor 
  • Ctrl + F3 Show or hide the Search panel 
  • Ctrl + F4 Show or hide the Video player 
  • Ctrl + F5 Show or hide the Trajectory editor 
  • Ctrl + F6 Show or hide the Notepad panel 
  • Ctrl + F7 Show or hide the 2D map 
  • Ctrl + F8 Show or hide the Rover 3D model 
  • Ctrl + F9 Show or hide the 3D Graph panel 
  • Ctrl + F10 Show or hide the Color selector 
  • Ctrl + F11 Full screen mode for the active panel 
  • Ctrl + F12 Show or hide the panel toolbar 
  • Ctrl + Shift + F4 Open an URL with the Video player 
  • Ctrl + Shift + F7 Show or hide the Burn editor 
  • Ctrl + Shift + F8 Show or hide the Stage 3D model 
  • Ctrl + Alt + F2 Show or hide the Payload camera 
  • Ctrl + Alt + F3 Show or hide the Web browser 
  • Ctrl + Alt + F4 Show or hide the 360º Player 
  • Ctrl + Alt + F5 Show or hide the logo 
  • Ctrl + Alt + F6 Add an extra Video player 
  • Ctrl + Alt + F7 Add an extra Payload camera 
  • Ctrl + Alt + F8 Add an extra View panel 
  • Ctrl + Alt + F9 Add an extra 3D Graph panel 
  • Ctrl + Alt + F10 Show or hide the Google Earth window 
  • Ctrl + Alt + F11 Switch from 2D to 3D panels style 
  • Ctrl + Alt + F12 Show or hide the Preset editor 
  • Alt + Enter Show information in the Web browser 
  • Ctrl + Enter Restart simulation 
  • Shift + Enter Reset simulation 
  • Ctrl + Space Play or pause simulation 
  • Ctrl + Shift + Enter Apply changes and repeat simulation 
  • Ctrl + Alt + Enter Recalculate the trajectory 
  • Ctrl + Tab Switch to panel menu 
  • PrtScr Take a screen snapshot 
  • Pause or Ctrl + Alt + PrtScr Start or stop the video recording 
  • Escape Exit program 
 

Mouse commands for the 3D viewer, 3D Graph, 3D models and View panels: 
 

  • Left click + Drag Move camera in X and Y axes 
  • Shift + Left click + Drag Move camera in X and Z axes 
  • Ctrl + Left click + Drag Move Launch coordinates 
  • Right click + Drag Rotate camera in Pitch and Yaw 
  • Ctrl + Right click + Drag Rotate camera in Pitch and Yaw slowly 
  • Left and Right click + Drag Rotate camera in Roll 
  • Ctrl + Left and Right click + Drag Rotate camera in Roll slowly 
  • Center click + Drag Change the camera Zoom 
  • Ctrl + Center click + Drag Change the camera FOV 
  • Wheel up and down Change the camera Zoom 
  • Double click Reset camera Yaw, Pitch and Roll 
  • Left click on an object Select the object 
  • Shift + Left click on a planet Select the camera Relative To mode 
  • Ctrl + Left click on an object Add objects to the selection Ruler tool 
  • Double click on an object Activate the Follow mode for the object 
  • Right click Show the camera context menu 
  • Center click Change the camera Follow mode 
  • Cursors Move camera in X and Y axes 
  • Ctrl + [Shift] + Cursors Rotate camera in Pitch and Yaw 
  • Shift + Left or Right Rotate camera in Roll 
  • Shift + Up or Down Change the camera Zoom 
  • Alt + Up or Down Change the camera FOV 
  • Alt + Left or Right Move the center of the 3D viewer 
  • Ctrl + [Shift] + [Alt] + PageUp Move to the previous snap points 
  • Ctrl + [Shift] + [Alt] + PageDown Move to the next snap points 
  • Ctrl + 1 to 9 Load a path stored in memory 
  • Ctrl + F11 Enter or exit full screen mode 
 

Mouse commands for the Toolbar: 
 

  • Ctrl + Play button Restart the simulation 
  • Ctrl + Shift + Play button Advance the simulation one time step 
  • Ctrl + PrevSnap button Move to previous 10 snap points 
  • Ctrl + NextSnap button Move to next 10 snap points 
  • Ctrl + Shift + PrevSnap button Move to previous 100 snap points 
  • Ctrl + Shift + NextSnap button Move to next 100 snap points 
  • Ctrl + Alt + PrevSnap button Move to the first snap point 
  • Ctrl + Alt + NextSnap button Move to the last snap point 
  • Ctrl + SpeedUp button Speed up the simulation slowly 
  • Ctrl + SpeedDown button Slow down the simulation slowly 
  • Ctrl + Record button Take a screen snapshot 
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  • Alt + Record button Activate Onboard video recording mode 
  • Center click Customize toolbar buttons 
 

Mouse and keyboard commands for the Graph panel and the Input graph: 
 

  • Left click + Drag or Mouse wheel Move the graph position 
  • [Ctrl] + Left or Right Move the cursor position 
  • [Ctrl] + PageUp or PageDown Move the cursor position faster 
  • Home Move the cursor position to the start 
  • End Move the cursor position to the end 
  • Up or Down Increase or decrease vertical scale 
  • 1 to 8 Activate or deactivate a data graph 
  • Num+ or Num+ Adjust the histogram density 
  • Double click Toggle auto-scroll mode 
  • Center click Toggle histogram mode 
 

Keyboard commands for the graph in the Burn editor: 
 

  • [Ctrl] + Left or Right Move the cursor position 
  • [Ctrl] + PageUp or PageDown Move the cursor position faster 
  • Home Move the cursor position to the start 
  • End Move the cursor position to the end 
  • Insert Go to the maximum pressure point 
  • Delete Go to the propellant burnout point 
 

Mouse commands for the Map panel in Waypoint editor mode: 
 

  • Left click + Drag Move the map position 
  • Wheel up and down Zoom the map in and out 
  • Double click Reset the map position and zoom 
 

Mouse and keyboard commands for the Map panel in Online map mode: 
 

  • Left click + Drag Move the map position 
  • [Ctrl] + [Shift] + Cursors Move the map position 
  • Ctrl + Left click or Center click Move the map to the cursor 
  • Double click Move and zoom the map to the cursor 
  • Center click + Drag Zoom the map in and out 
  • Wheel up and down Zoom the map in and out. 
  • PageUp or PageDown Zoom the map in and out 
  • Ctrl + F11 Enter or exit full screen mode 
  • Enter Show coordinates and cursor 
 

Keyboard commands for the coordinates text box in the Map panel: 
 

  • Up or Down Select a location in the position text box 
  • Enter Enter the map latitude and longitude 
 

Mouse and keyboard commands for the Video player panel: 
 

  • Left click or Space Play or pause the video 
  • Ctrl + Left click + Drag Move the video position 
  • Shift + Left click + Drag Move the video position slowly 
  • PageUp or PageDown Move the video position 
  • Shift + PageUp or PageDown Move the video position slowly 
  • Ctrl + PageUp or PageDown Move the video position faster 
  • Home Move the video position to the start 
  • End Move the video position to the end 
  • Alt + Enter or Escape Exit from full screen mode 
  • Ctrl + F11 Enter or exit full screen mode 
  • Escape Close the panel 
 

Keyboard commands for the 360º player panel: 
 

  • Num4 or PageUp Move the view position to the left 
  • Num6 or PageDown Move the view position to the right 
  • Num5 or Home Reset the view position to 0º 
  • Num0 or Space Play or pause all the videos 
  • Num+ Increase the size of the videos 
  • Num- Decrease the size of the videos 
  • Ctrl + F11 Enter or exit full screen mode 
  • Escape Close the panel 
 

Keyboard commands for the Notepad panel: 
 

  • Enter Calculate result in calculator mode 
  • Alt + Enter Activate calculator mode 
  • Ctrl + Enter Calculate result in text mode 
  • Shift + Enter Repeat and calculate selected text 
  • Alt + Insert Show all defined variables 
  • Alt + F1 Show all functions and operators 
 

Keyboard commands for the Web browser: 
 

  • Alt + Left or Right Navigate backward or forward 
  • F5 Reload the current page 
  • Ctrl + F11 Enter or exit full screen mode 
  • Ctrl + F12 Show or hide the toolbar 
 

Command line switches: 
 

quiet Do not show splash screen at startup (also press Shift, Ctrl or Alt) 
nosave Do not save changes on exit (also press Shift, Ctrl or Alt) 
gdi Use GDI 2D render instead of OpenGL 3D render 
nolog Deactivate log write to “Log.txt” in the debug compiled executable 
 

 DOWNLOADS Terrain files 

The file “moon-20_terrain_world.rar” contains the Earth elevations, the file 
“moon-20_terrain_moon.zip” contains the Moon elevations and the file 
“moon-20_terrain_mars.zip” contains the Mars elevations. Currently, there 
are no elevations for other planets. There is a portable version with only 
Spain and Canary Islands which is the file “moon-20_terrain_spain.zip”. The 
file “moon-20_geoid_earth.zip” contains the Earth geoid altitude over 
ellipsoid. These files should be extracted and placed in the Terrain folder. 
 

 DOWNLOADS High definition textures 

The textures used for the Earth and the Moon can be improved by extracting 
and replacing the current ones in the Textures folder for one of the following 
files: “moon-20_compressed_textures_2K.zip” for a resolution of 2048 x 1024 
pixels, “moon-20_compressed_textures_4K.zip” for a resolution of 4096 x 
2048 pixels, “moon-20_compressed_textures_8K.zip” for a resolution of 8192 
x 4096 pixels and “moon-20_compressed_textures_16K.zip” for a resolution 
of 16384 x 8192 pixels (for Earth only). Some video cards have problems 
with the DDS compressed texture format. The file “moon-
20_uncompressed_textures.zip” is a set of textures in BMP format that work 
in almost all the video cards. You should extract and place these files in the 
Textures folder. 
 

 DOWNLOADS Asteroids database 

The file “moon-20_asteroids.gz” contains the asteroids database. This file 
should be extracted and placed in the Planets folder. Note that the asteroids 
trajectories are updated frequently and new asteroids are discovered almost 
every day. Because of this, it is recommended to download the updated 
version of this file from the Lowell Observatory server or using the Update 
asteroids option in the Path sub-menu. 
 

 DOWNLOADS Airspace files 

The file “moon-20_airspaces.zip” contains the KML files needed to rebuild 
the database used in the Airspaces render tool. Download this file and 
extract all the KML files in the Airways folder. These files are updated 
frequently and new versions of a specific zone can be downloaded from the 
Lloyd Bailey 3D Airspace web page. Download the updated KML or KMZ files 
and copy them to the Airways folder overwriting the older ones. If the 
airspace file is a KMZ file, it must be converted to KML before it can be 
processed. Use Google Earth to convert the file or simply change the file 
extension to ZIP and extract the KML file. Finally, use the Update airspaces 
option in the Path menu to rebuild the database. 
 

The “Airport.csv”, “Seaport.csv” and “City.csv” files in the Airways folder are 
CSV files with the list of all the airports, seaports and cities in the world. You 
can edit these files to update the data in the simulator. The “Airway.bin” and 
“Rnav.bin” files contain the information about the airways inside the Spanish 
airspace. Also, the “Country.bin” and “Populated.bin” files contain the data of 
the land and water boundaries of all the countries in the world and the highly 
populated areas. Currently no updates are available for these binary files. 
 



  Mini-launcher Simulator Moon2.0 

   REFERENCE MANUAL Page 29 of 37 

 TUTORIALS NOTAM for a stratospheric balloon 

This is the tutorial to generate a report to request the publication of a NOTAM 
(NOtice To AirMen) to the Airworthiness Authority (AESA in Spain) as a 
result of an air activity, in our case a “non manned light free balloon” launch. 
 

The report has to be sending by e-mail at least one month before the launch 
day to guarantee the necessary time to establish the contact between the 
Airworthiness Authority and both: The Airways Operator and The Military 
Staff. In case of necessity, some of the agencies can request extra 
information or directly notify the incompatibility of the launch, because of the 
air traffic or military maneuvers. The e-mail has to include the name of the 
organization responsible of the balloon launch and the person responsible of 
the organization (that has not to be the same of the launch) with his contact 
data. In case of civil responsibility, the contact with each person will be 
established. Civil Aviation indications breach may result in the prohibition of 
future launches requested by the organization of the air activity. Also we 
have to attach to the report: A study of winds before the launch and a 
compatibility study of the balloon trajectory with airways. Thus, we 
recommend the use of the tool called Moon2.0, which can be free 
downloaded here: 
 

http://code.google.com/p/moon-20/downloads/list 
 

 
 
The last version has directly updated the balloon trajectory, which did not 
happen in old versions of Moon2.0. Another advance of this version is that 
the airspaces and airways are updated too, so we only have to activate the 
particular option to see that, like we explain later. But the most important 
advance is the tool that allows to know the exactly moment when the balloon 
enters and leave an aerospace or an airway; that allows us to know for how 
long the balloon is inside it. 
 

The study of winds before the launch is as follows. The Moon2.0 has a wind 
tool as was explained in the Balloon trajectory tutorial.  
 

 
 
The compatibility study of the balloon trajectory with airways is as follows. To 
see the airways, first we will show the top view and for that we have to press 
the right button of the mouse and select the Flat view option, like the next 
figure shows. 
 

 
 

We recommend activate the tracing of the aircraft (Follow ship), which we 
can found pressing the right button in the mouse and selecting the option 
showed in the next photo. 
 

 
 
With the wheel of the mouse we can increase or decrease the zoom, which 
allows see better the interest areas. 
 

After that, we will explain the steps to show the airways and airspaces and to 
select the option of airspace detection, which show us when the balloon 
enters and leaves a particular airspace. 
 

First of all, we have to press the Options button       (Viewer options) of the 
tools menu and in the Tools tab we will select the check box option called 
Airways; like the next photo shows. 
 

 
 
The next step is to click in the tab called Simulation and select the following 
check box options as next photo shows: Airspace detection, Area detection, 
Balloon trajectory, Empty stages, High definition detection and Airspaces. 
 

 
 
After that, we have to press in the Events tab and select the following check 
box options: Enter airspace and Exit airspace. In this tab, we can observe 
that there are three of for which case; the different check box option in front 
of the other tabs the Pause, which serves to stop the image when this event 
occurs and this allows us see better the characteristics of this event. 
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The last step is to press in the Options tab and here we will select the next 
options: Airspaces, Lower airways, RNAV routes and Use airways altitude, 
like the next photo shows. If we do not need the airspaces of all the zones, 
because our balloon does not cross them, we have the option to choose the 
airspaces that we need; this option is in the list called Airspaces, where we 
will select the zone that we want and this will appear in the place where now 
there is the name: All zones. Next photo shows this process. 
 

 
 
Observe that the Labels of Airspaces are not selected otherwise so many 
names impede a proper vision of the situation. After these steps, we can 
observe the airspaces and the airways like this: 
 

 
 
Increasing the zoom, we observe in more detail airspaces and airways. This 
is one of the most important photos for the report because the controller will 
see the possible conflict with real traffic. The photo shows the time to 
airspace clearance, in this case 23 minutes after the balloon release. 
 

 

In the next photo we can see an isometric view that shows the altitude of 
airspaces and airways. In this example the balloon, starting from the 
Zaragoza TMA, crosses the W-851 airway in 23 minutes and leave the 
Spanish airspace in 1 hour and 36 minutes when 30 km of altitude is 
reached. At 32 km the rocket will be ignited autonomously. Apart from this, 
we can observe the information given by the Log panel, in which are detailed 
the moment when the balloon enters and leave each airspace and airway. 
 

 
 
The report has to be sending to: 
 

AESA. Servicio de Trabajos Aéreos y Aviación Deportiva 
 

aviaciondeport.aesa@fomento.es 
 
Our NOTAM will look similar to the following photo. In it we can observe the 
characteristic data of the launch. This information will be read by all the pilots 
affected before the starting of the flight. 
 

 
 
The regulation of non manned free balloons use is in the Regulation of air 
circulation of the Royal Decree 57/2002. The appendix S contains all the 
information about this type of activities. It is recommendable the reading of it 
before preparing a mission to know what we can do and what not.  
 
 
References: 
 

http://www.mtc.gob.pe/portal/transportes/aereo/regulaciones/docs/rap_rev15/
rap101/rap_101_subparte_d_rev15.PDF 
 

http://www.boe.es/boe/dias/2002/01/19/pdfs/C00001-00697.pdf (Spanish) 
 

http://www.boe.es/boe/dias/1968/05/09/pdfs/A06766-06767.pdf (Spanish) 
 

http://www.icao.int/Documents/annexes_booklet.pdf 
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 TUTORIALS NOTAM para globo estratosférico 

Este es el tutorial para generar un informe para solicitar a AESA (Aviación 
Civil) la publicación de un NOTAM (NOtice To AirMen) como resultado de 
una actividad aérea, en nuestro caso el lanzamiento de un “globo libre no 
tripulado”. 
 

El informe debe ser enviado por e-mail al menos un mes antes del 
lanzamiento para garantizar que les dará tiempo de contactar con AENA y el 
Estado Mayor. En caso de necesidad, alguno de los dos organismos pueden 
solicitar información extra o simplemente notificar que el lanzamiento es 
incompatible, ya sea por tráfico aéreo o por maniobras militares. En el e-mail 
deberemos incluir el nombre de la organización responsable del 
lanzamiento, así como de la persona responsable de la misma (que no tiene 
que ser necesariamente el mismo que suelte el globo) con sus datos de 
contacto. En caso de responsabilidad civil se contactaría con dicha persona. 
El no cumplimiento de las indicaciones de Aviación Civil podría provocar que 
no dejen lanzar más a la organización que solicita la actividad aérea. 
Además debemos acompañar el informe con el estudio de vientos sobre la 
trayectoria del globo y compatibilidad con las aerovías. Por ello es 
recomendable usar una herramienta que se llama Moon2.0 y que se puede 
descargar gratis aquí: 
 

http://code.google.com/p/moon-20/downloads/list 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Introducir en el panel Setup la fecha y hora UTC y las coordenadas del 
lanzamiento como se muestra en la figura siguiente. Es decir, hay que 
rellenar con información válida los campos: Launch date, Launch time, 
Launch site latitude, Launch site longitude y Launch site altitude. Este último 
es importante para generar la trayectoria y tiene que ser la altura a la que 
creemos que llegará nuestro globo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Una vez introducido los datos, pulsaremos el botón para reiniciar la 
simulación       (Reset simulation) para ver los resultados, comprobando que 
la localización del lanzamiento así como la hora del día coincide con lo 
esperado. La hora es la Universal Time Clock o UTC o también hora del 
meridiano de Greenwich. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Para visualizar las aerovías, primeramente mostraremos la vista plana o 
llamada también vista ortogonal y para ello pulsaremos con el botón 
secundario del ratón sobre el cohete para sacar el menú contextual, 
marcando la opción Flat view, tal y como se muestra en la figura anterior. 
Recomendamos activar el seguimiento de la aeronave (Follow ship) que está 
en el menú contextual en el submenú Follow tal y como se muestra en la 
figura siguiente. Con la rueda del ratón podemos aumentar y disminuir el 
zoom para ver de cerca el área de interés. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A continuación pulsaremos sobre el botón de opciones del visor      (Viewer 
options) de la barra de herramientas y en la pestaña Options marcaremos 
las opciones siguientes: Lower airways, RNAV routes, Use airways altitude y 
Airways labels, tal y como se ve en la figura anterior. En ese momento 
aparecerán las aerovías inferiores en verde y las aerovías superiores en azul 
oscuro, como se muestra en la figura siguiente. Cerramos los paneles que 
no usemos, ajustamos la vista e imprimimos la pantalla para el informe. 
 
 



  Mini-launcher Simulator Moon2.0 

   REFERENCE MANUAL Page 32 of 37 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
El siguiente paso es realizar una predicción de la trayectoria según los 
vientos. Es necesario tener conexión a Internet porque se usa un modelo de 
vientos muy preciso que se mantiene actualizado al día. Para ello usaremos 
la herramienta Download balloon trajectory en el botón Path      de la barra 
de botones como se ve en la figura anterior. Cuando se conecta al servidor, 
aparece alguno de los mensajes de la figura siguiente. Es muy posible que 
salga el mensaje Server is too busy de servidor ocupado y deberemos 
intentarlo más tarde. El proceso tarda unos dos minutos por lo que si no sale 
el mensaje anterior  de ocupado, es buena señal. Cuando termina, aparece 
la trayectoria del globo en el visor y el mensaje Download completed de 
descarga completada que se ve en la segunda figura. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Por último vamos a exportar la trayectoria a Google Earth en formato KML 
para terminar el informe. Si tenemos Google Earth instalado podemos 
copiarlo directamente a través de la herramienta Copy to Google Earth

TM
 en 

el botón Path       de la barra de botones como se ve en la figura siguiente.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
En la trayectoria se incluyen los puntos de lanzamiento, altura de control de 
60.000 pies, la explosión del globo y el punto de predicción de impacto, tal y 
como se ve en la figura siguiente. Recomendamos poner el cursor sobre el 
punto de impacto antes de hacer la captura de pantalla para que queden 
registradas las coordenadas donde habrá que ir a buscar el globo. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Para guardar el fichero en formato KML basta con guardar la trayectoria 
seleccionando el tipo de fichero correspondiente. Para ello usamos la 
herramienta Save path en el botón Path      de la barra de botones como se 
ve en la figura siguiente. 
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O bien usando el menú contextual del panel Lugares de Google Earth. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
El informe debe enviarse a: 
 

AESA. Servicio de Trabajos Aéreos y Aviación Deportiva 
 

aviaciondeport.aesa@fomento.es 
 
Nuestro NOTAM tendrá un aspecto parecido al de la figura siguiente. En él 
podemos observar los datos característicos del lanzamiento. Esta 
información la leen todos los pilotos afectados antes de iniciar el vuelo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La normativa de uso de globos libres no tripulados se recoge en el 
Reglamento de circulación aérea del Real Decreto 57/2002. El apéndice S 
contiene toda la información sobre este tipo de actividades. Se recomienda 
su lectura antes de preparar una misión para saber qué se puede hacer y 
qué no. 
 
 
References: 
 

http://www.mtc.gob.pe/portal/transportes/aereo/regulaciones/docs/rap_rev15/
rap101/rap_101_subparte_d_rev15.PDF 
 

http://www.boe.es/boe/dias/2002/01/19/pdfs/C00001-00697.pdf 
 

http://www.boe.es/boe/dias/1968/05/09/pdfs/A06766-06767.pdf 
 

http://www.icao.int/Documents/annexes_booklet.pdf 
  

 REFERENCES Interesting links 

Simulator home page 
http://code.google.com/p/moon-20 
 

Adobe Reader 
http://www.adobe.com 
 

APRS tracking service 
http://aprs.fi 
 

Arduino community 
http://arduino.cc/en  
 

Astromechanics 
http://www.stargazing.net/kepler/mean.html 
 

Balloon trajectory forecasts - University of Wyoming 
http://weather.uwyo.edu/polar/balloon_traj.html 
 

Bing Maps 
http://www.bing.com/maps 
 

Caligari trueSpace 3D modeling software 
https://en.wikipedia.org/wiki/TrueSpace 
 

CelesTrak satellite tracking database 
http://celestrak.com/NORAD/elements/master.asp 
 

CPROPEP propellant simulator 
http://sourceforge.net/projects/rocketworkbench 
 

GFS atmospheric model 
http://www.emc.ncep.noaa.gov/index.php?branch=GFS 
 

Google Earth 
http://earth.google.com 
 

Google Maps 
http://maps.google.com/maps 
 

IEEE 754 floating point arithmetic standard 
http://en.wikipedia.org/wiki/IEEE_754 
 

IUPAC SI prefixes 
http://old.iupac.org/reports/1993/homann/index.html 
 

KML language used in Google Earth 
http://code.google.com/apis/kml/documentation/kml_tut.html#placemarks 
 

Lloyd Bailey 3D Airspace 
http://www.lloydbailey.net/airspace.html 
 

Lowell Observatory 
http://www.lowell.edu 
 

Material property data 
http://www.matweb.com 
 

MotorSim 2.0 rocket motor simulator 
http://content.billkuker.com/projects/rocketry/software/motorsim-2-0 
 

MSIS-E-90 atmosphere model 
http://ccmc.gsfc.nasa.gov/modelweb/models/msis_vitmo.php 
 

muParser math parser library 
http://muparser.sourceforge.net 
 

NACIS Natural Earth map data 
http://www.naturalearthdata.com 
 

NASA beginner’s guide to aeronautics 
http://www.grc.nasa.gov/www/k-12/airplane/guided.htm 
 

NASA elevation data 
http://pds-geosciences.wustl.edu/dataserv/holdings.html 
 

NASA orbital debris reentry 
http://orbitaldebris.jsc.nasa.gov/reentry/reentry.html 
 

NASA Solar System Dynamics 
http://ssd.jpl.nasa.gov 
 

National Marine Electronics Association 
http://www.nmea.org 
 

NGA EGM2008 Earth Gravitational Model 
http://earth-info.nga.mil/GandG/wgs84/gravitymod/egm2008 
 

NOAA World Magnetic Model 
http://www.ngdc.noaa.gov/geomag/WMM 
 

NORAD two-line element format 
http://celestrak.com/columns/v04n03 
 

PID controller design and tuning 
http://www.controlguru.com/pages/table.html 
 

OpenStreeMap project 
http://www.openstreetmap.org 
 

Propellants data base 
http://www.astronautix.com/props/index.htm 
 

RASP ENG file format 
http://www.thrustcurve.org/raspformat.shtml 
 

Richard Nakka’s experimental rocketry 
http://www.nakka-rocketry.net 
 

Rocket propulsion 
http://www.braeunig.us/space/propuls.htm 
 

Solar wind and Atlantic South Anomaly 
http://space.rice.edu/IMAGE/livefrom/sunearth.html 
 

USGS GTOPO30 terrain elevation data 
https://lta.cr.usgs.gov/GTOPO30 
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 VERSION UPDATES Source code 

2.0.091206.1320 
• OpenGL viewer fully functional 

 

2.0.091227.1042 
• Lift / drag ratio physics and lift force limit in Setup window 
• Statistics enable / disable in Simulation sub-menu 
• Time & path points time selection in Options sub-menu 
• Preset sub-menu 
• Custom font for panels and 3D viewer labels 
• Knots and Mach speed in Data panel 
• Vertical speed in Data panel 
• Compact Setup window mode 

 

2.0.100106.1234 
• Atmosphere and ionosphere transparency 
• Gravity field around Earth and Moon 
• Altimeter viewer tool 
• Multiple paths commands and Path sub-menu 
• Multiple display commands 
• Team Frednet logo on the 3D viewer 
• Sun texture 

 

2.0.100115.1051 
• Earth & Moon park orbit timer in Setup window 

 

2.0.100120.0931 
• Ground radio-station networks from “Stations.csv” 
• Custom engines from .ENG files 

 

2.0.100121.2012 
• Some bugs fixed 

 

2.0.100125.1627 
• All data files moved to subdirectories 
• Splash window at startup 
• Sun shadow option in Options sub-menu 

 

2.0.100202.2340 
• Loop mode instead of timer to use 100% of the CPU 
• Locations / propellants moved to subdirectories 
• Camera distance in Data panel 
• Second 3D viewer panel 
• Separated default preset and config file 
• Save path (not log) as KML 

 

2.0.100206.1127 
• Variables in config file 
• Custom braking distance in Setup window 
• 3D spaceship icon and size option 
• Compact Data panel mode 

 

2.0.100212.2033 
• Date and time system to calculate all planets position 
• All solar system planets 
• Ecliptic reference plane only 

 

2.0.100217.1539 
• Variables in preset files 
• Equatorial and orbital reference planes 

 

2.0.100222.1921 
• Elliptical planets orbits 

 

2.0.100228.1516 
• Sun gravity physics 
• Earth-Moon-Sun gravity options in Simulation sub-menu 
• All planets motion 
• Spaceship orbit plane viewer tool 
• Spaceship pitch angle in Data panel 

 

2.0.100306.0051 
• Resizable Setup panel and custom font 
• All planets gravity physics 
• All planets gravity option in Simulation sub-menu 

 

2.0.100308.0349 
• Textures for Earth, Moon and Sun in DDS format 
• Textures for all planets in DDS format 
• 3D models for all planets 
• Follow, LookAt and RelativeTo modes for all planets 

 

2.0.100314.1004 
• 3D Viewer presets in Options sub-menu 
• All planets collision detection 

 

2.0.100321.1212 
• Mars atmosphere and landing sequence 

 

2.0.100326.1244 
• Chemical calculator for the Propellant editor 

 

2.0.100401.1219 
• Separated Setup and Propellant editor 
• Color themes option in Options sub-menu 
• Thrust curve profiles 
• Spaceship lift off detection 

 

2.0.100402.1910 
• Hidden lines option in Tools sub-menu 
• Smooth lines option in Tools sub-menu 
• Starfield background 

 

2.0.100404.2029 
• Data information in Graph panel 

 

2.0.100411.1633 
• Drag coefficient profiles in Setup panel 
• Air pressure and temperature in Data panel 
• Sound speed detection 

 

2.0.100415.0032 
• Planet approach detection 
• Temperature and expansion ratio in Propellant editor 

 

2.0.100420.2350 
• Thermodynamics calculation 
• Spacecraft temperature in Data and Graph panels 
• Planet shadow option in Simulation sub-menu 
• Graph time option in Options sub-menu 
• Stars list and drag profiles moved to Data folder 
• Altitude curve for Earth and Mars atmosphere 

 

2.0.100428.1245 
• Separated Setup and Stages panel 
• Diameter, length and emissivity parameters in Stages panel 
• Electrical power parameter in Stages panel 
• Radio-stations visibility detection 
• Radio-stations visibility in Graph panel 
• Log events sub-menu in context menu 
• Auto save sub-menu in context menu 

 

2.0.100508.0003 
• Add and remove stage buttons in Stages panel 
• Angle of attack effect on lift force 
• Lift force vector in 3D viewer 
• Solar wind calculation 
• Solar wind option in Simulation sub-menu 

 

2.0.100511.2328 
• Spherical and ellipsoidal terrain options in Simulation sub-menu 

 

2.0.100518.2039 
• Matrix terrain option in Simulation sub-menu 
• Ground altitude in Data panel 
• Added Terrain folder for “Terrain.bin” file 
• Report file tool 

 

2.0.100528.1248 
• 3D model for Earth terrain 
• Ground level in Data panel 
• Terrain option in Tools sub-menu 
• Grid step option in Options sub-menu 
• Time and data scales in Graph panel 

 

2.0.100603.1044 
• English units in Data, Log and Graph panels 
• Units option in Options sub-menu 

 

2.0.100615.1308 
• 3D model for Moon and Mars terrain 
• Ground altitude for Moon and Mars 
• Terrain scale and quality options in Options sub-menu 
• Data relative to Target planet in Data panel 

 

2.0.100623.1217 
• Adaptive step option in Simulation sub-menu 
• Take screen snapshot with F12 key 

 

2.0.100712.1007 
• Link panel added for external link control 
• RS-232 and UDP-IP link protocols supported 
• Arduino IMU source example in Remote Control section 
• Arduino IMU source example in Source/Arduino folder 
• Launch trajectory control flag in Link panel 
• Landing maneuver control flag in Link panel 
• Log input, output and full data options in Link panel 
• Wait for device and test mode options in Link panel 
• Added Link error event to identify inconsistent simulation 
• Total impulse and specific orbital energy in Data panel 

 

2.0.100719.0937 
• Binary mode for link protocol 
• Binary and text mode options in Link panel 
• Double precision option in Link panel 

 

2.0.100903.2053 
• 3D models in .COB text format loaded from Models folder 
• Added Models folder for custom 3D models 
• Angular kinetics and trajectory correction for launch trajectory 
• Target pitch angle and deviation in Data panel 
• Propellant burn rate and burn time in Stages panel 
• Spacecraft position of all paths in 3D viewer 
• Default textures changed from DDS to BMP 

 

2.0.100914.1623 
• Import KML trajectories for Path sub-menu 

 

2.0.100916.2306 
• Presets in Preset sub-menu sorted by type of mission 
• Trajectory control option in Simulation sub-menu 
• Flat render mode and Flat view option in Options sub-menu 

• Flat view and Orthogonal options in View panel context menu. 
 

2.0.100920.2033 
• 3D model for spaceship in Flat view 
• Radio-stations visibility detection in Flat view 
• Import and export snapshots in KML files 

 

2.0.100924.2044 
• Vertical sync option in Options sub-menu 
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• Import and export multiple paths in KML files 
 

2.0.100930.1935 
• Earth atmosphere glow render tool 
• Separated options for Vectors and Ranges in Tools sub-menu 

 

2.0.101013.0053 
• Mars atmosphere glow render tool 
• Target planet orbit added to Ranges sub-menu 
• Clone view options in View panel context menu 
• FOV option in Options sub-menu 

 

2.0.101024.0009 
• Gravity field option in Options sub-menu 

 

2.0.101107.0056 
• Added Toolbar panel 
• Scale option for Gravity field render tool 
• Total simulation time and speed in Log panel 

 

2.0.101109.1648 
• Added more buttons to the Toolbar 
• Context menu and size option for the Toolbar 
• Activate or deactivate all buttons in Toolbar context menu 

 

2.0.101111.1420 
• Hidden all objects that are obscured by the planets 
• Customize option in Toolbar context menu 

 

2.0.101122.1804 
• Reference manual accessible in Help panel 
• Added Onboard follow mode 
• Added Sensors folder for onboard sensor list 
• Sensors option in Options sub-menu 
• Satellite control option in Simulation sub-menu 
• Planet apoapsis and periapsis events 

 

2.0.101129.1545 
• Sensor Crosshair, FOV and Labels options in Tools sub-menu 
• Video recording with Ctrl+Alt+PrtScr or Toolbar button 

• Video record options added to Options sub-menu 
 

2.0.101204.2233 
• Added Toolbar folder for the Toolbar icons 
• Added Videos folder to store recorded videos 
• Video FPS option in Options sub-menu 
• Added Google Earth link in Panels sub-menu 

 

2.0.101205.2310 
• Paths stored in memory are listed in Path sub-menu 
• Copy to GE option added to Path sub-menu 
• Help file accessible from Help panel in PDF format 

 

2.0.101224.0933 
• Tracking mode in Link panel for external GPS tracking 
• Added Port 2 option in Link panel for second GPS tracking 
• Added “Geoid.bin” file for Earth geoid elevation data 
• Geoid altitude option in Options→Units sub-menu 
• Save data option in Graph panel 

 

2.0.110112.2002 
• Rover link mode in Link panel for external rover tracking 
• Added Port 3 option in Link panel for Rover link mode 
• Waypoint list editor in Link panel for Rover link mode 
• Tracking path saved in KML format file in Presets folder 
• Tracking log option in Link panel 
• Tracking sync option in Link panel 
• Save log option in Link panel 
• Added icons for waypoint list editor in Images folder 
• Stage Delay used before the stage burn, not after it 

 

2.0.110207.1028 
• Balloon trajectory option in Path sub-menu 
• Added Web browser panel 
• Links menu to Panels sub-menu 
• “Links.lst” file in Data folder with web links 
• Target menu in RelativeTo sub-menu 
• Added Planet proximity event 

 

2.0.110210.2013 
• Trajectory prediction tool in Tools sub-menu 
• Antialiasing menu in Options sub-menu 
• Added Planet faraway event 

 

2.0.110219.1957 
• Added Notepad panel 
• Save log option moved to Log panel context menu 
• Relative time option in Options→Units sub-menu 

 

2.0.110303.1433 
• Notepad variables saved in “Variables.lst” in Data folder 
• Reference lines in 2D map of Link panel 

 

2.0.110312.2036 
• Added Preset editor panel 
• Extended parameters for every stage in Stages panel 
• Parachute, attitude control, electrical and thermal parameters 
• Initial angle and overview in Setup panel 
• Airways and RNAV routes in render tools 

 

2.0.110318.1648 
• PID controller parameters for the attitude control in Stages panel 
• Maximum attitude control thrust in Data panel 
• Add, Delete and Clear options in Locations sub-menu 
• Add, Delete and Clear options in Links sub-menu 

 

2.0.110411.1753 
• PID controller and deviation angle for satellite control 
• Moment of inertia parameters in Stages panel 
• Onboard sensor option in Panels sub-menu 
• Sensor Deviation and Trace tools in Tools sub-menu 
• Degrees only and Magnetic moment in Options→Units sub-menu 
• Look at→Star sub-menu for star tracking in Onboard sensor 
• Added Default FOV option in FOV sub-menu 
• Edit Model, Preset and Star tracker options in Notepad panel 
• File “StarTracker.lst” in Data folder with brightest stars 
• Labels option in Options→Stars sub-menu 
• Magnetic field tool in Options→Gravity field sub-menu 
• File “Wmm.cof” in Data folder for WMM 2010 model library 
• TLE file format in Save path dialog 

 

2.0.110419.1211 
• Edit Report and Lenses options in Notepad panel 
• Fixed font option in Notepad panel 
• Added “Report.txt” example file to Logs folder 
• File “Lenses.lst” in Sensors folder for sensor lenses list 
• Lenses option in Options→Sensors sub-menu 
• Magnetic lines and planes tool in Options→Gravity field sub-menu 
• Report font option in Options sub-menu 
• Star kinetics options in Simulation sub-menu 

 

2.0.110510.1516 
• Angle option in Options→Stations sub-menu 
• Rover control buttons in Link panel 
• Rover commands text box in Link panel 
• Commands option in Notepad panel 
• File “Rover.ini” in Models folder with rover commands list 
• Center of mass and 3D model parameters in Stages panel 
• Emissivity calculation from the 3D model materials 
• 3D model lighting from the Sun and the nearest planet 
• Multi-stage option for stage type in Stages panel 

 

2.0.110517.1542 
• Default 3D models in Models folder 
• Rover 3D model view for the Link panel 
• Stages and payload 3D model view in Stages panel 

 

2.0.110526.2023 
• Options in context menu moved to Options panel 
• Toolbar events buttons changed to Events control button 

 

2.0.110531.1205 
• 3D model view in Stages panel moved to a 3D model panel 
• Models list added to the Link panel commands menu 
• Refresh models option added to Models menus 

 

2.0.110614.1018 
• Folder option for 3D models and textures in Models folder 
• Support for BMP, JPG, PNG, TIF and GIF textures 
• Added Station and Tracking 3D models to Models folders 
• APRS tracking option for Tracking link mode 
• Settings text box for COM port configuration in Link panel 
• User and Password for server connection in Link panel 
• Save password option in Link panel 
• Save log option changed to Auto save log in Link panel 

 

2.0.110623.2348 
• Capture mode option changed in Options panel 
• Added 3D models for the empty stages to Models folders 
• Simulation of the balloon and the empty stages trajectories 
• Added Balloon trajectory option to Simulation options 
• Added Empty stages option to Simulation options 
• Removed Star kinetics option from Simulation options 

 

2.0.110717.2253 
• Calculate LEO orbit option in Path sub-menu 
• Screen and video options moved to Screen tab in Options panel 
• Panels font option in Options panel 

 

2.0.110727.1845 
• Added Video player panel 
• Added Real time speed option to Simulation options 

 

2.0.110907.2045 
• Calculate Moon mission option in Path sub-menu 
• Airways option moved to Options tab in Options panel 
• Magnetic field vector tool in Tools options 

 

2.0.110913.1556 
• Log to file options in Simulation options 
• Tool tips for the parameters in Data and Graph panels 
• View panel can be larger than desktop for high sensor resolutions 

 

2.0.111014.1531 
• 2D map detached from Link panel 
• Online maps available for Map panel 
• Map, link model and stage model options in Panels sub-menu 

 

2.0.111026.1308 
• Moon and Mars online maps for Map panel 
• Search engine for Map panel 
• Web links for the online maps added to Links menu 

 

2.0.111201.1850 
• Terminal link mode in Link panel 
• RS-232 and TCP-IP link modes changed to Control mode 
• Added global keys for all the panels 
• Added 360º player panel to play panoramic videos 
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2.0.120103.0311 
• Satellites group and distance options in Options panel 
• Satellite proximity added to Simulation tab in Options panel 
• Ground station visibility added to Simulation tab in Options panel 
• Added Satellite proximity event 
• Update satellites option in Path sub-menu 
• Added Satellites folder and “Satellites.csv” file for satellite data 
• Load and convert NMEA log to KML file in Path sub-menu 

 

2.0.120209.2025 
• New appearance for the buttons in the panels and the Toolbar 

 

2.0.120227.1852 
• Added Planets folder for planets, moons and asteroids data 
• Planets physical and orbital data in INI files at Planets folder 
• Data files of stars and planet atmospheres moved to Planets folder 
• Texture and 3D model for Saturn rings 
• Some render options moved from Tools tab to Options tab 
• Airways, star labels and magnetic field options moved to Tools tab 
• Added asteroids, comets and moons render tools in Tools tab 
• Added options to show or hide the labels in Tools tab 
• Asteroid detection options in Simulation and Events tabs 

 

2.0.120301.2046 
• Object selection with left click on the 3D viewer 
• Object information with double click on the 3D viewer 
• Information overlay for the selected object 

 

2.0.120306.1503 
• Web information icon in the Information overlay 
• Added Sync mode to the 3D viewer context menu 

 

2.0.120315.1739 
• Follow object mode in Follow sub-menu 
• Double click an object to activate the Follow mode on it 
• Textures and 3D models for the most important moons 
• Add extra view option in Panels sub-menu 
• Added Demos menu to Presets sub-menu 
• Added Default settings option in Presets sub-menu 

 

2.0.120330.1501 
• Cursor for the selected object in the 3D viewer 
• Added Hide selection cursor option to Options panel 
• Added Object visibility option to Options panel 
• Added Objects orbits option to Tools tab in Options panel 
• Units options moved from Options tab to Screen tab 
• Highlight orbit of the selected object in the 3D viewer 
• Look at object mode in Look at sub-menu 
• Auto-repeat function for the PrevSnap and NextSnap buttons 
• Added Search panel to search objects in the database 
• Icon for the Search panel in the Information overlay 

 

2.0.120417.1508 
• Target list for the satellite control in Setup panel 
• Search objects by group in Search panel 
• Sort list by name in Search panel 
• Multi-selection in target list and Search panel list 
• Object selection in all View panels 

 

2.0.120507.1750 
• Added Payload camera panel for video input and streaming 
• Video and audio device selection in Payload camera menu 
• Streaming video option in Payload camera menu 
• Open URL option in Video player menu to play a video stream 
• Video stream option in Panels sub-menu to play a video stream 
• Window size options in 3D viewers and Video panels 
• Added Compass tool to Tools tab in Options panel 
• Added Switch to menu to Panels sub-menu with all active panels 
• Minimize button in the message popup 

 

2.0.120525.1934 
• Added camera selector to Payload camera panel 
• Video stream and Refresh camera buttons in camera selector 
• Add View, Player and Camera options in Panels sub-menu 

 

2.0.120619.0222 
• Atmosphere tool added to Tools tab in Options panel 
• Atmosphere layers options in Options panel 
• Added Update atmosphere option to Path sub-menu 

 

2.0.120626.1856 
• Added Atmosphere folder for atmospheric model files 
• Calculate balloon trajectory option in Path sub-menu 
• Calculated balloon trajectory shown in Graph panel 

 

2.0.120719.0047 
• Added Simulation and Balloon menus to Graph panel 
• Added Data menu to Data panel context menu 
• Added atmosphere Temp and Speed rows to Data panel 
• Atmospheric model option in Simulation tab of Options panel 
• Wind speed option in Simulation tab of Options panel 
• Added initial splash image to Images folder 
• Option to create shortcuts in desktop and start menu at first run 
• Added Trajectory editor for the trajectory calculation parameters 
• Added button in Setup panel to show the Trajectory editor 
• Calculate trajectory options moved to Trajectory editor 
• Close all panels option in Panels→Switch to sub-menu 

 

2.0.120728.1237 
• Planets position tool using the mission time in Trajectory editor 
• Selection Ruler tool when selecting objects with Ctrl+click 
• Camera RelativeTo mode selection with Shift+click 
• Spacecraft can be selected as an object 

• Added Isp values in Stages panel to override propellant defaults 
• Added Apsis, Period, Angles and Camera rows to Data panel 
• Default panels option in Panels→Switch to sub-menu 

 

2.0.120829.1622 
• Audio tracking option for Tracking link mode 
• Added Distances render tool to Tools tab 
• Color table overlay for the Atmosphere render tool 
• Added Magnetic field row to Data panel 

 

2.0.120920.1530 
• Heading and elevation for selection Ruler tool in Tactic mode 
• Compass and Distances tools aligned with North in Tactic mode 
• Select and Fixed tracking options for Tracking link mode 
• Added Extended Log option to Log panel 
• Removed Data panel style option from Screen tab 
• Added Show 3D icons option to Options panel 
• Added Tracking follow and Path altitudes options to Link panel 
• Added Refresh time sub-menu to Link panel 
• Options in Link panel menu moved to a sub-menu 
• Added Update airspaces option to Path sub-menu 
• Added “Airspaces.bin” and “Airports.csv” files to Airways folder 
• Added Airspaces and Airports options to Options panel 
• Some options in Options tab moved to Screen tab 
• Added Object collision probability row to Data panel 

 

2.0.120928.1359 
• Enter and exit airspace events in Events tab of Options panel 
• Airspace detection option in Simulation tab of Options panel 
• Airspace detection data and background color in Graph panel 
• High definition detection option in Simulation tab of Options panel 
• Use font textures option in Screen tab of Options panel 
• Panels style option in Screen tab of Options panel 
• Color selection for the text in the panels and the 3D viewer 
• Added Reset all settings option to Preset sub-menu 
• Basic panels option in Panels→Switch to sub-menu 
• Moved “Moon.dll” file to Source folder 
• Added “DShow.dll” file to Source folder 

 

2.0.121005.1403 
• Color table overlay for the Gravity field render tool 
• Follow→None and LookAt→None options changed to Free 
• Free camera option in Follow→Tactic/Object camera modes 
• Added labels option for Locations render tool in Tools tab 
• Snap points check box moved to Path→Labels in Tools tab 
• Added Apply changes button to the Toolbar 
• Enhanced spacecraft model in GDI / 2D render 

 

2.0.121021.1823 
• System info option in 3D viewer context menu 
• Added Rover, Station and Tracking model options to Link panel 
• Added Relative angles option to Link panel 
• Added “StationAntenna.cob” file to Models folder 
• Ground station 3D icon points to the Tracking object 
• Landing maneuver option in Simulation tab of Options panel 
• Added Braking altitude event to Events tab of Options panel 
• Added orbit time option to Orbit text box of Trajectory Editor 
• Options in Events tab saved to the configuration file 
• Active tab in Options panel saved to the configuration file 
• Added images to some buttons in Setup, Stages and Link panels 

 

2.0.121211.1808 
• Real time speed for the balloon trajectory simulation 
• Added Medium Earth orbit option to the Trajectory editor 
• Added Minimize and Maximize buttons to the Toolbar 
• Removed Exit application button from the Toolbar 
• Added Inertial and Delta V G rows to Data panel 
• Added “Seaport.csv” and “City.csv” files to Airways folder 
• Added “Country.bin” and “Populated.bin” files to Airways folder 
• Added Area detection and Log airspaces options to Simulation tab 
• Added Seaports, Cities and Locations options to Options panel 
• Added Land and Water boundaries options to Options panel 
• Added Populated areas option to Options panel 
• Some options in Options tab moved to Screen tab 
• Added a button to calculate the propellant in Propellant editor 
• Added a button to generate a graph in Propellant editor 
• Precision options and configuration menu in Propellant editor 
• Added Graphs folder for graphs generated by Propellant editor 
• Added some CSV files with graph examples to Graphs folder 
• Added 3D Graph panel to show 3D propellant graphs 
• Context menu in 3D Graph panel with configuration options 
• Reverse camera axes options in Screen tab of Options panel 
• 3D model sub-menus in Link panel moved to the options menu 

 

2.0.130117.1816 
• Added View sub-menu to context menu in 3D Graph panel 
• Add and delete 3D graph options in 3D Graph context menu 
• Adjust Z scale option in 3D Graph panel moved to Z scale menu 
• Graph point selection with left click in 3D Graph panel 
• Option to add extra 3D Graph panels in Panels sub-menu 
• Added Data sub-menu to configuration menu in Propellant editor 
• Added Color selector to configure all the colors in the 3D viewer 
• Context menu in Color selector with color and font options 
• Font configuration buttons in Screen tab moved to Color selector 
• Video settings button in Screen tab converted to an image button 
• Added some items to Sun shadow option in Screen tab 
• Added Convert images to video option to Path sub-menu 
• Added Boundaries tool to Tools tab in Options panel 
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2.0.130319.1853 
• Added Burn editor to calculate the thrust curve of a solid propellant 
• Calc button in Burn editor to generate thrust curves and engines 
• Download map sub-menu in context menu of Map panel 

 

2.0.130425.1110 
• Removed Background option in Screen tab of Options panel 
• Changed Panels style options in Screen tab of Options panel 
• Atmospheric pressure option in Screen tab of Options panel 
• Added options in Color selector for the panels and the 3D viewer 
• Added options in Color selector for the Burn editor graph lines 
• Calc button and output option changed in Burn editor 
• Output format and Graph quality in Presets menu of Burn editor 
• Burst pressure option and graph background in Burn editor 
• Nozzle expansion calculation and graph background in Burn editor 
• Chamber thickness and Maximum stress options in Burn editor 
• Engine dry mass and End of thrust pressure options in Burn editor 
• Mass or volume options for the propellant sizes in Burn editor 
• Thrust, Pressure, Burn rate and Exp ratio in Burn editor graph 
• Cursor in Burn editor graph to show data at specific burn time 
• Engine specifications moved to a expanded panel in Burn editor 
• Default and custom presets in Burn editor saved to Engines folder 
• Burn rate curves loaded from BRN files in Engines folder 
• Added “Materials.lst” for Burn editor materials in Engines folder 
• Added context menu to graph in Burn editor 
• Copy data and Save data options in Burn editor context menu 
• Error detection of parameters in Setup and Stages panels 
• Simulation errors option in Screen tab of Options panel 
• Added High definition option in context menu of Log panel 
• Added Reload files sub-menu to the Presets menu 

 

2.0.130820.1053 
• Added a button to calculate nozzle parameters in Burn editor 
• Propellant burn progress at graph cursor position in Burn editor 
• Added Burn preview option for default burn progress in Burn editor 
• NMEA output and Align input axes options in Link panel menu 
• Added Input axes mapping sub-menu to Link panel menu 
• Mars distance event in Events tab changed to Planet distance 
• Relative to→Target option affects also to the planet events 
• Auxiliary panels moved to a sub-menu in Panels menu 
• Added Application folder option to Links menu 
• Added navigation buttons and address bar to Web browser 
• Added Reverse zoom option to Screen tab of Options panel 

 

2.0.130917.1123 
• Time stamp, visible area and pixel size in Onboard sensor view 
• Time stamp and FOV Area options in Tools tab of Options panel 
• Onboard video capture mode in Screen tab of Options panel 
• Satellite and asteroid faraway in Events tab of Options panel 
• Balloon trajectory saved with preset in KML and CSV file formats 
• Airspace and station detection in Balloon trajectory simulation 
• Option to deploy the satellite in Moon park text box of Setup panel 
• Added presets with Moon and Mars polar orbits for planet mapping 
• Added Selected option to Locations sub-menu of Setup panel 
• Added Tooltip delay option to Screen tab of Options panel 
• Added 3D models for the stars of the star tracker 
• Added nearest stars to the Follow→Object camera mode 
• Camera distance limit increased to view all the nearest stars 
• Added high zoom options to the camera FOV sub-menu 

 

2.0.140128.1150 
• Updated NOTAM tutorial in English version 
• Added Asymmetric option to the 3D viewer context menu 

 

2.0.140716.1905 
• Added Ship scale option to View panel context menu 
• Added Normalize axes option to Options sub-menu of Link panel 
• Current atmosphere layer option in Options panel 
• Added labels option for Wind speed vectors in Options panel 
• Color options for gravity field, air temperature and wind speed 
• Earth texture option in Screen tab of Options panel 
• Added Clouds, Day, Night and White textures for Earth 3D model 
• Planet textures converted from BMP to JPG format 
• Added Total impulse option to Extended log in Log panel 
• Error detection for the trajectory calculation in Trajectory editor 
• Corrected an error in a component of the "Propellant.dat" file 

 

2.0.141203.1252 
• Graph link mode in Link panel 
• Added a button to show the Input graph in Link panel 
• Added Input graph panel to show the data in Graph link mode 
• Context menu in Input graph with configuration options 
• Added a button to show the Remote control in Link panel 
• Added Remote control panel to configure the remote control 
• Moved control buttons from Link panel to Remote control panel 
• Moved Input axes option from Link panel to Remote control panel 
• Added independent configuration for every link type in Link panel 
• Path→Convert to KML option can also convert CSV files 
• Path→Update asteroids option updates also the comets file 
• Mission time used for fixed-volume balloons in Trajectory editor 
• Graphs for the nozzle throat and exit calculation in Burn editor 
• Added Copy image option to simulation, burn and input graphs 

 

Current version 
• Added Star Burner option to Burn editor 

 


